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Part I: Getting Started 

1 The Faicon030 

Introduction 
Congratu lations on the purchase of your Atari computer. The Falcon030 i s  a 
state-of-the-art personal computer, offering uncompromised performance and 
affordabil i ty .  Combin ing a fast m icroprocessor architecture with digital s ignal 
processing and true-color graphics  capabil i ties, the Falcon030 i s  an ideal p latform 
for today's appl ications, such as mult imedia, desktop publ i shing,  graphic arts, 
games, and educational software. 

Your Faicon030 is avai lable w i th the following standard features and options. 

Standard Featu res 

• 1 6MHz 68030 m icroprocessor 

• 32MHz Motorola 5600 1 Digital Signal Processor (DSP) 

• 1 MB ,  4MB,  or 1 4M B  of Random Access Memory (RAM) 

• Video color palette of 262,  1 44 (65,536 simultaneous) colors 

• l .44MB PC-compatible internal floppy diskette drive 

• An array of ports which include: SCSI, RS232, Parallel , RF, Video, MIDI, 
Cartridge, LAN, M icrophone, Headphone, Joystick (expanded) , and DSP 
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• The Atari Mul t iTOS pre-emptive mult i tasking operat ing environment 

• A control panel that allows you to customi ze the different features of your 
desktop 

• A sophisticated desktop that displays your favorite executable fi les as 
smart icons, wbich you can l ink to a directory, resource fi les,  and custom 
setups 

Options 

• 1 6MHz 6888 1 /2 Floating Point Unit ( FPU) 

• Internal hard disk drive 

Usi ng Th is Manual 
This  manual i s  d ivided into several parts, which explain in clear, nontechnical 
language how to use your computer and i ts  operating env ironment. After you 
become more fami l iar with your computer, this manual w i l l  continue to be a 
helpful guide for individual procedures and specific information. Below i s  
summary o f  the manual ' s  contents. 

Part I: Gett ing Started 

Chapter 1 ,  The Falcon030, provi des a l i st of your computer 's  standard features, 
and avai lable options. Th is  chapter also gives you s imple directions for setti ng up  
the  computer and connecting peripherals .  

Chapter 2,  Using Your Computer, explains a number of fundamental concepts, 
which hel p  you understand how a computer works.  Th is  chapter 
also i ntroduces you to the keyboard, mouse, and floppy disk drive .  
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Part I I : Usi  ng the Desktop 

Chapter 3, The GEM-Desktop, teaches you how to do basic tasks on the 
desktop, such as movi ng the cursor and working w i th windows. 

Chapter 4, A Guided Tour of the Desktop, i ntroduces you to all the desktop's 
menus, commands, and features .  This  chapter also explains how to customize 
your desktop envi ronment using the Control Panel and i ts  various CPX modules. 

Chapter 5, Desktop Management, teaches you how to work w ith directories, 
folders, and files. This chapter also tells you how to develop and maintain an 
efficient desktop environment. 

Chapter 6, Advanced Desktop Features, i ntroduces you to Mul t iTOS, your 
computer's advanced pre-emptive m u lt itasking environment. 

Part I I I: Appendixes , G lossary,  and I ndex 

Appendix A, Cursor Control Quick Reference, describes the cursor actions that 
you can control us ing the mouse or keyboard. 

Appendix B, Advanced Hard Disk Utilities, describes the features of the 
Advanced Hard D isk Ut i l i ties ( HOX) program. 

Appendix C, Troubleshooting and Maintenance, offers solutions to problems 
you may encounter wh i le setting up or operati ng your computer. This appendix 
also provides guidelines for proper maintenance of your system. 

Appendix D, �oecifications, summarizes your system's major features and 
requirements. 
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Appendix E, Connector Specifications, gives specifications for the various 
ports and connectors on the system. 

Appendix F, Customer Support, tel l s  you where to find more i nformation 
about your Atari computer and other Atari computer products. 

Glossary defines common technical terms used in this manual as they relate 
to your computer. 

Index helps you locate terms and procedures used or explained in the 
manual . 

Special Notat ions 

This manual uses speci al notations to communicate i nformation efficiently .  
Following are examples of the spec ial  notat ions as they appear throughout 
this manual. 

Characters enclosed in square brackets ( [  ]) represent keys on the keyboard. 
For example, when th is  gu ide instructs you to press [ Return ] ,  you should 
press the Return key on the keyboard. 

When a procedure requires you to use two or more keys at the same t ime, the 
keys are grouped together (e .g . ,  [ Control]  [ Xl) .  

Notes: These contain useful hints and other information relevant to the topic 

being discussed. 

Cautions: These alert you to potential problems and suggest ways to avoid 
those problems. 

Filenames are capital i zed. For example, the NEWDESK. INF and 
DES K ICN.RSC fi les are located on your computer 's  Language disk.  
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Part and chapter t i t les are enclosed in quotat ion marks and/or appear in bold
face type (e.g. ,  Chapter 1, The Falcon030, and Part I: Getting Started). 

Selectable i tems appear i n  a different font than standard text. For example, 
desktop commands, such as Open, Cancel, and OK. 

Setti ng Up Your System 
Setting up the Falcon030 i s  easy. Use the information in this section to set up 
your system and any peripheral dev ices. 

Prepari ng a Workspace 

Before going any further, take a moment to prepare a workspace for your 
computer. S tart by finding a flat, stable surface area near an electrical outlet. 
The surface area should be able to support the weight of the computer, and 
any dev ice that you want to connecting to i t .  Be sure to protect the system 
from dust, grease, extreme temperatures, prolonged exposure to d i rect 
sunl ight, and high humidity.  U se a surge protector to protect the computer 
against damage caused by abnormal flows of e lectricity.  

Connecting  the Mouse 

Note.: We recommend that you purchase a mouse pad to use with your Atari 

mouse. A mouse pad provides a clean, even sUiface that prevents dust and dirt 

ji'om collecting inside the mouse. 
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There is a 9-pin plug wi th two rows of holes on the end of the mouse cord. This  
plug fi ts i nto the joyst ick/mouse port in  one di

'
rection only,  so you don 't  need to 

worry about making a wrong connection. 

The mouse connects to the system through the joystick/mouse port, which i s  one 
of two ports located underneath the keyboard. (The other port underneath the 
keyboard is a dedicated joystick port . )  You can identify the mouse port by i ts  
icon located on the bottom of the keyboard. 

Con necti ng the Mon itor 

Since there are a variety of  moni tors available for use wi th the Fa\con030, you 
should consu l t  the setup instructions that come w i th your part icu lar monitor. 

The Monitor Adapter Block 

Before you can use a monitor w ith  the  Falcon030, you need to  purchase the 
correct monitor adapter block. The monitor adapter block a l lows you to use a 
variety of monitors w i th the Falcon030. The monitor block is easy to use. 
Connect one end of the block to the monitor's v ideo adapter cable and the other 
end to the Video port. For more information about the monitor adapter block, 
contact an Atari dealer. 

Connecting  the Power Cable 

After you connect the monitor and mouse, use the fol lowing instructions to 
connect the power cable. 

1 .  Connect t he power cable ' s  female end to the three-pronged socket on the back of the 

system. 

2. Pl ug the power cable's male end in to a power source, such as a surge protector 

plugged into a power outlet. 
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Start ing you r  System 
Now that you've connected the monitor, mouse, and power cord, you 're ready to 
start (or boot ) your system. The term boot comes from the word bootstrap. 

Bootstraps al low you to pul l  on a boot, just l ike booti ng a computer al lows you to 
start your computer's operating system (more on th is  later) .  

The ROM chips inside your computer contai n  the operat ing system, so you don ' t  
need a system disk t o  start your computer ( see Chapter 2,Using Your Computer 
for more information) .  Although, you can have the computer to read addit ional 
startup informat ion, such as the desktop fi les, from a disk.  

You can store startup information on a hard disk or a floppy disk,  such as the 
Language disk that comes with the computer. In e i ther case, i f  the startup fi les are 
available, the computer reads them during bootup. 

Note: If you want to learn more about your computer before going further, skip to 

Chapter 2, Using your Computer, then return to this section when you are ready 

to start the system. 

The fol lowing sections tel l  you how to boot up  your computer. If  you want to 
connect a printer, external drive, or another peripheral device to your computer 
now, read Connecting a Peripheral Device ( later in  th is  chapter), before going 
any further. I f  you are not connect ing any devices, use the following information 
to boot up  your computer. 

Start ing fro m  a Hard Disk 

Your hard d isk contains fi les wh ich al low i t  to boot u p  the operat ing system and 
display the desktop. 
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Use the fol lowing steps to boot up from the hard disk:  

1 .  Sw itch on any peripherals attached to the system. 

2. Switch on the computer and the monitor. 

While the computer is start ing the operating system and checking the system 
memory, you' l l  see the Atari logo on the upper left portion of the screen. You w i l l  
a lso see a bar displayed across the screen. When the system completes the 
memory test, the bar starts to shrink.  The startup process waits for the bar to 
shrink completely before going on. This provides a necessary t imeout for some 
external peripherals .  If there are no external peripherals attached to the computer, 
press any key to abort the t ime out. Afterwards,  the system displays the desktop. 

Note: If the computer cannot find the neededjlles on the hard disk during bootup, it 

loads the default desktop, which does not display any hard disk icons. If this occurs, 

shut off the computer, then switch it on. If the hard disk icons still fail to appear on 

the desktop , see Appendix C, Troubleshooting and Maintenance. 

Start i ng from a Floppy Disk 

I f  your system doesn ' t  contain a hard disk,  you'l l  want to boot the system with a 
copy of the Language disk in drive A. The Language disk contains fi les that the 
computer reads when it starts the operating system. For example, the Language 
disk contains DESK I CON.RSC, the icon resource file, and NEWDESK. INF, 
which al lows you to customize the layout of the desktop area. 

Note: As a precaution you should make a working copy of the Language disk. Use 

the working copy instead of the original disk. See Copying Files and Folders in 

Chapter S, Desktop Management,for information on copying disks. 

Use the fol lowing steps to boot up your system from a floppy startup disk:  
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1 .  With the computer turned off, i nsert the work ing copy of the Language disk into 

drive A. 

2. Switch on any peripherals attached to the system. 

3. Sw itch on the system. 

Note: If you are booting the computer from the Language disk and the desktop fails 

to appear, shut down the computer. Make sure the disk is correctly inserted in drive 
A ,  and all cables are properly and securely connected. Start the system again. If the 

desktop still fails to appear, see Appendix C, Troubleshooting and Maintenance. 

Connecting  Peripheral Devices 

Peripheral devices (e .g . ,  printers, external hard d isks,  etc . )  announce their 
presence to the computer by sending electron ic s ignals. In some cases, peripheral 
dev ices share memory with the computer. In general ,  you should connect and 
switch on all peripheral devices before booting up your computer. Using th is  
procedure ensures that a l l  the connected peripheral devices in i t ia l ize properly. 
See Precautions in  the fol lowing sect ion for more information on connecting 
peripheral devices. 

Con necting a SCSI Device 

The SCSI (pronounced scuzzy) data transfer protocol is popular among peripheral 
manufacturers and is employed by many different types of dev ices. 

Use the following steps to connect a SCSI device: 

1 .  Shut down the computer and al l  peripherals.  

2. Connect one end of the SCSI dev ice's interface cable to the port labeled SCSI  I I  on 

the back panel of the computer. 

3. Connect the other end of the interface cable to the port on the SCSI device. 

Note: The cable required may diff er from peripheral to peripheral. Make 
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sure you have the right cable. 

4. Connect the power cable to the power jack on the back of the device. 

5. Insert the three-pronged plug into a grounded wall  outlet or power strip. 

6. Set the SCSI !D Switch according to the fol lowing guidel ines: 

a) If the device is a hard disk, it M U ST be set to O. Other hard disks ( i f  present)  

M U ST be set  i n  sequence (e .g . ,  0, 1, 2, 3, etc . ) .  N o  two hard d isks can have the 
same sett ing. 

b) [f you are using other devices with a hard d isk, use the d irections above to set the 
hard disk, skip a number, then set the remaining dev ice(s) in sequence (e .g . ,  0, 1, 2, 
3, l ], 5, 6, 7) . 

c )  If there are no hard disks in the daisy-chain (more on this  later) ,  start at 0 ami set 

any addit ional dev ices in seq uence. 

Note: A lways read the documentation accompanying your SCS I device, or software, 

before you set the SCSI ID switch. 

Daisy-chaining 

Daisy-chaining is a way to connect more than one peripheral dev ice to a s ing le 
port. The first dev ice in the chain connects to the computer, and the rest of the 
devices in  the chain connect to each other. For example, dev ice A would connect 
to the computer, device B would connect to dev ice A. If you are daisy-chaining a 
device to the Falcon030, see the manual suppl ied with the dev ice for more 
detai led informat ion. 

Precautions 

Be sure to observe the fol lowing precautions when using any SCSI  dev ice w ith 
your computer. 

• Always switch on the SCSI  device before switching on the computer. 

• D isconnect the SCSI dev ice from the computer, before attempting any 
modifications to the dev ice. 
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System Orientation 
Thi s  gu ide makes frequent references to various system components and features. 
Taki ng a few m inutes to fam i l i arize yoursel f  with the layout of your system w i l l  
save you time when using your computer and t h i s  manual . 

Front Panel 

Fol lowing i s  an i l lustration and description o f  the features o n  the front panel of 

Figure /-1. The Front Panel 

-- Standard keyboard with function keys and numeric keypad 
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Mouse port, underneath the keyboard, connects Atari mouse. 
(The Mouse port i s  not v is ible in Figure I - I . ) 

Right Side Panel 

Fol lowing i s  a n  i l l ustration and descript ion o f  the features o n  the right side pane l .  

Figure 1-2. The Right Side Panel 

-- 1.44MB PC-compati ble h igh-density floppy disk drive 
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Rear Panel  

Fol lowing is an i l lustration and brief description of the features v isible on the rear 
pane l .  

DSP Microphone Video 

Headphone SCSI II TV 

Figure 1-3. The Rear Panel 

Printer Power Switch Power Jack 

Modem LAN Reset Button 

- Digital S ignal Processing (DSP) port provides an interface to the digital audio 
chips and the internal DSP for direct input/output of h igh-speed digital 
signals. 

-- Headphone: M ini-stereo output jack connects headphones or external speakers 
for sound output. 

M icrophone: M ini-stereo input accepts a signal from a microphone, or a stereo 
system .  

The Faicon030 1 -1 3  



Fa/con030 Owner's Manual 

�- SCSI II port w ith DMA connects SCSI dev ices to the system. 

-- TV (RF modulator) p lug allows you to connect the computer to a TV set .  

-- Video port connects a variety of monitor types. 

-- Printer ( paralle l )  port connects printers, scanners, or other paral lel  devices. 

� .  Modem ( RS232C) port connects a modem or another serial dev ice. 

-- LAN high-speed LocaITalk-ca1compatible port al lows you to network your 
Fa1con030 wi th other computers. 

Power swi tch turns on the power to the system. 

Power jack connects the power cord. 

Reset swi tch cold-boots the system when depressed. 

Left Side Panel 

. The fol lowing i s  an i l l ustration and descript ion o f  the features o n  the left s ide 
pane l .  
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MIDI Ports Cartridge Slot Joystick Ports 

MIDI In and MIDI Out{fhru ports connect other MIDI devices to the 
computer. (For more information on MIDI see the fol lowing Note . )  

Cartridge slot accepts program cards, hardware interfaces, etc. The system 
recognizes the cartridge slot as drive C. 

Joystick ports (2) connect a joystick to the computer. 

Note: Musical Instrument Digitallntelface or MIDI ports allow you to connect 
your system with other MIDI devices, such as electronic keyboards, sophisticated 

tape recorders and a host of other electronic devices that communicate using the 

MIDI standard. 
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2 Using Your Computer 

Learn ing The Fu ndamentals 
This section i s  designed t o  teach you about basic computer-related concepts and 
technologies. More avanced computer users may w ish to skip this section and go 
directly to Part II: Using the Desktop. 

How a Computer Works 

A computer processes instructions to perform a task. Two examples of 
instructions are the operating system instruct ions on your computer 's  Read Only 
Memory ( ROM) chip,  and the instructions in  an executable program contained on 
a disk.  Your computer rece ives these instruct ions as e lectronic signals which it  
then stores as data. The processing and storing of data ( sets of e lectronic s ignals 
grouped together) i s  handled by a system of e lectronic components and in tegrated 
c i rcuits .  

Memory 

A computer 's  memory capac ity is measured in bytes. Computer language is based 
on the binary number system; the smallest data uni t  is one B Inary digiT, or B IT. 
Groups of 8 bits are cal led bytes. A ki lobyte i s  1,024 bytes;  a megabyte is 1,024 

ki lobytes .  
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Your computer uses two types of memory, system memory and storage memory. 

System Memory 

System memory consists of microch ips inside your computer. The computer uses 
system memory as a temporary work area in which to load and run programs,  and 
a way of storing important information, so that i t  can be accessed quickly. 

There are two types of system memory, Read Only Memory( ROM) and Random 
Access Memory (RAM) .  

You cannot write i nformation into a ROM storage area. The i nformation in  ROM 
is  permanent,  and cannot be  erased. ROM chips inside your computer contain 
operating system i nformation. 

Random Access Memory (RAM), consists of memory chips i nside your computer 
that store data while the computer is running. When you-turn off the computer, a l l  
the  i nformation in  R A M  is erased. RAM is  the computer's  chalkboard. The 
computer can quickly and efficiently access programs and data fi les written into 
RAM. To permanently save information stored i n  RAM, you must transfer the 
i nformation from RAM i nto storage memory. 

Storage Memory 

S torage memory i s  located on storage dev ices.  These dev ices include floppy 
disks, standard hard disks, hard disks in removable cartridges, and C D-ROM 
discs. 

Hard Disks 

Because of the hard disk's  h igh storage capacity and fast access time, many 
programs prefer to run off a hard disk.  
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The Falcon030 is available with an optional internal hard disk, which is ready to 
work, as soon as you boot up the system. 

The hard disk is divided into partitions, which appear on the desktop as drive 
icons (See Desktop Elements in Part II: Using the Desktop, Chapter 3, The 
GEM-Desktop, for more information on drive icons.) Partitions store 
information independently although they are not physically separate devices. 

Floppy Disks 

Floppy disks store programs and the information you create (data). Floppy disks 
store different amounts of data depending on the type of floppy disk; single-sided 
floppy disks store 357,376 bytes, double-sided floppy disks store 726,0 1 6  bytes, 
and high-density floppy disks store 1 ,458, 1 76 bytes of data. Information on a 
floppy disk is read from the disk into RAM, modified if desired, and later saved 
back to the disk from RAM. 

Your computer's 3.5 inch l .44M B  drive uses 3 .5 inch high-density, double 
density, or single-sided diskettes. Each diskette consists of a 3.5 inch rectangular 
plastic casing holding a circular sheet (disk) of coated material .  This material is 
the magnetic media which holds the data read by the disk drive. Its accessible  
section is protected by a sliding metal s leeve. Most floppy disks also have a 
write-protect sliding tab. (For information on floppy disks, see The Floppy Disk 
Drive l ater in this chapter.) 

CD-ROM Discs 

CD-ROM discs store information that can be read into RAM for processing. 
Because C D-ROM disks use a read-onl y  format, you cannot write any additional 
data onto a CD-ROM disc. 
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Operat ing System 

Every computer needs an operating system to carry out even the most basic 
functions. For example, TOS (your computer 's  operating system) controls the 
way your computer handles tasks l ike reading from and wri t i ng to disks, 
translating mouse movement into on-screen cursor movement, and displaying 
i nformation on the screen .  

G raph ics E nvironment Manager 

The Graphics Env ironment Manager (GEM), i s  a n  important part o f  TOS . GEM 
provides a graph ic  interface for the computer. This a l lows a screen display of 
information as graphic i mages (e .g . ,  picture icons and windows) ,  as wel l  as  
letters , numbers, and symbols. For information on TOS,  see Part II: Using the 
Desktop. 

Getti ng Acquai nted with You r  
Computer 
After your computer i s  running and displaying the desktop, you ' l l  probably 
wonder what to do next. Use the information contained in  this section to get 
better acquainted w ith various parts of your computer system. 

The Screen D isplay-G E M  Desktop 

When you start your system, the computer reads the startup information from the 
hard d isk or the startup floppy d isk and loads that i nformation into RAM. 
Afterwards, the desktop appears on your screen .  
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The GEM Desktop i s  the starti ng point for almost everyth ing you do w ith the 
computer. The basic  desktop contains two floppy disk icons, four hard disk icons 
(if you have a hard disk) ,  and a trash can icon on the left edge of the screen, a 
menu bar at the top of the screen ,  and a pointer. ( The second floppy icon is for 
help in  copying operations. )  For more i nformation on the Desktop, see Part II: 
Using the Desktop. 

The Mouse 

The mouse allows you control the movement of the pointer. Usi ng the mouse, you 
can posit ion the pointer anywhere on the desktop. 

How the Mouse Works 

The mouse consi sts of several basic parts. The housing, which contains the mouse 
components, has two buttons on top. These buttons are referred to as the left and 

right mouse buttons. The mouse hall i ns ide the mouse rol l s  when you move the 
mouse. The movement of the mouse ball is translated into the movement of the 
cursor by motion sensors i n side the housing. For more information on the mouse, 
see Using the Mouse in Part II: Using the Desktop, Chapter 3, The GEM
Desktop. 

The Keyboard 

The computer 94-key keyboard i s  s imi lar to a conventional  typewri ter keyboard 
i n  its basic design and function. For example, [ Return ] acts l ike the carriage 
return lever (or key) on a typewriter. Pressing [ Return ] moves the cursor down 
the screen .  

Most keys automatical ly repeat when held down. ( For information o n  changing 
the rate of automatic  repeat, see Control Panel i n  Part II: Using the Desktop, 
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Chapter 4, A Guided Tour of the Desktop. 

LI _________ 1 

, 

-

Figure 2-1. The Keyboard 

The a lphanumeric keys (letters, n umbers, and symbols) have the same function as 
s imilar keys on a typewriter. For example, pressing [S] produces s and press ing 
[Shift ]  [S] produces S. Pressing [Caps Lock] toggles (switches back and forth) 
between upper and lower case letters. 

There are several keys on the computer's keyboard that perform special functions 
not found on a typewriter. 

For example, you can use [ Control], [Alt], and [Shift] in conjunction w ith some 
other key to produce a secondary function or code. To do so, you hold down one 
or more of these keys while pressing the other key (like using S HIff on a 
typewriter). 

Along the top of the keyboard are ten function keys labeled FI through F lO. 
Software applications often assign special functions to these keys. 
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The four arrow keys move the cursor i n  the direction indicated by the arrow.  The 
cursor is a movable graphic screen symbol (often an arrow, block, or vertical 
l ine) that marks where the next action takes place. 

Note: The presence of a text cursor indicates that the computer is ready for you to 
type something. 

The numeric keypad is an alternate method for entering numbers and math 
symbols,  producing the same effect as typing the number or symbol from the 
keyboard. [ Enter] acts as [ Return ] .  

The Floppy Disk Drive 

Your computer' s  h igh-density floppy d isk dri ve is format-compatible with MS
DOS version 3 .2  and later. This  section teaches you how to use the floppy disk 
drive. 

Formatting a Floppy Disk 

You must format a new floppy disk before you can store programs and data on 
the d isk .  Formatting prepares a floppy disk by completely erasing the d isk ' s  
contents, checking for damage t o  the magnetic media, and setting patterns in  
p lace to  ho ld  informat ion. 

Floppy d isks formatted by your computer are format compatible with MS-DOS 
computers. Th is  means information wri tten to a floppy d isk formatted on your 
computer can be read by MS-DOS computers and v ice versa. 

The Fa\con030' s  h igh-density floppy disk drive can use h igh-density, double
s ided, or s ing le-sided disks. However, a s ingle-sided disk should not be formatted 
as double-sided disk, and a double-sided disk should not be formatted as h igh-
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density disk. Disks used for dens it ies or storage beyond 
thei r  rating are not dependable. 

You can reformat previously used floppy disks. S ince formatting erases all  
information on a disk, i t  is  sometimes more effic ient to reformat a floppy disk 
than to delete all of a floppy disk's fi les. However, do not format a disk one way 
and then reformat it a different way l ater. 

Caution: Formatting a floppy disk permanently erases all information on the 

disk. Before you format any floppy disk, be sure to copy any data you want to 

save. 

Use the fol lowing steps to format a disk. 

1 .  Start the computer. After the screen displays the desktop, insert the floppy disk into 

the floppy disk drive. 

2. Select the F o r m a t  F lo ppy Dis k command from the File menu. The 

Copy/Format dialog box appears. 

Note: Both the Copy and Format operations are combined in one dialog box 

so you can format and then copy disks without returning to the desktop after 

formatting. If you select the Format option and decide to copy a disk 
instead, click on COPY. You can also click on FORMAT after initiating a 

disk copy operation if you must format a disk first. 

3. If you wish the disk to have a label, type in the label. Select a density setting, 

depending on how you want to format the disk. 

4. Select OK. The floppy disk drive begins formatting the disk. The indicator bar 

displays formatting progress. 

5. When the formatting is completed, an alert message displays the disks formatted 

capacity in bytes. 
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Caution: If the formatted disk does not have a reported capacity of 

1,458,176 bytes (high-density), 726,016 bytes (double-sided), or 357,376 

bytes (single-sided), the disk may be defective. If this is the case, try 

formatting the disk again. If the problem persists, discard the bad disk and 

use another disk. 

6. To return to the desktop, select  Cancel. Or repeat the  formatt ing process w i th 

another blank, unformatted floppy disk .  

Note : If you try to use a disk without  first formatting it, the computer 
displays an alert box.  The alert box tells you that the disk drive is not 

responding ,  and to p lease check the disk drive , or insert a correctly 

formatted disk into the drive. Then you must select Retry (with a formatted 

disk) or Cancel to tell the drive whether or not to attempt to read that disk. 

Write-Protecting a Floppy Disk 

Write-protecting a floppy disk prevents i nformation from stored on the magnetic 
media. 

Most floppy disks have a small write-protect tab in their plastic casing. You 
cannot write to, format, or erase a write-protected disk. It is a good idea to write
protect disks containing important i nformation so you do not i nadvertent ly  erase 
information from the disk,  especial ly when copying disks with a one-drive 
system. You can move the write-protect tab back to the u nprotected position at 
any time. 

Note : Some commercial program disks may not have write-protect tabs. These 

disks are permanently write-protected and do not have tabs. 
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3 The GEM Desktop 

Basic Desktop Ski l ls 
Using the Desktop i s  easy. The fol lowing i nformation and tutorials w i l l  help 
fami l i arize you with the elements of the desktop. Readers already fami l i ar with 
TOS ' s  basic desktop appl ications may w ish to skip directly to Chapter 4, A 
Guided Tour of the Desktop. 

Most of the basic desktop tasks, such as selecting an i tem, or open i ng a window, 
etc . ,  are easiest to accompl ish  when using the mouse. If you are not currently 
usi ng a mouse, see Controlling the Pointer Using Keystroke Combinations, 
l ater i n  this  chapter. Afterwards, return to thi s  section and substi tute the 
references to the mouse wi th  the appropriate keystroke combinations .  

Note: Before going any further place the Language disk, or  your working copy of 
the Language disk, in drive A .  

Usi ng the Mouse 

Using the mouse, you can move the pointer anywhere o n  the desktop. In addition 
to movi ng the poin ter, the mouse a l lows you to do basic desktop tasks, such as 
selecting, mov i ng, and copyi ng. 
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Holding the Mouse 

Place your hand over the mouse. Gently grasp the mouse between your thumb and 
outer fingers. If you ' re left-handed, you ' l l  probably  want to rest your m iddle 
finger on the left mouse button. If you are right handed, your i ndex finger should 
rest on the left mouse button . I f  neither of these posit ions 
feel s  right, then choose a posi t ion that i s  comfortable for you. 

There are several techniques involved in us ing the mouse. By mastering these few 
simple techn iques, you can eas i ly  do basic desktop tasks. 

Movi ng the Poi nter 

The first basic task you  need to  learn i s  how to  move the pointer. Moving the 
poin ter is easy . Just move the mouse and the pointer w i l l  fol low. You ' l l  find that 
you can move the pointer across the entire screen by rol l i ng the mouse over a 
smal l  surface area. 

Selecti ng 

Select ing an i tem te l l s  the computer you want to use the i t .  When an i tem i s  
selected i t  h ighl ights, which means i t  d isplays on the desktop i n  different colors 
from your normal  desktop colors. You can select one i tem or a group of i tems. 
Both procedures are di scussed in the sections that fol low. 
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Selecting an Icon 

There are two types of  icons: desktop icons and w indow icons. Desktop icons 
incl ude floppy and hard disk drive icons, printer and cartri dge icons, and the trash 
can icon.  Window icons include folder and fi le  icons (which can be displayed as 
e ither text or icons) .  

Take a moment to practice select ing an icon .  Move the pointer over the drive A 
icon. Then, cl ick the left mouse button once (thi s  is cal led s ingle-c l icking) .  If 
you ' ve done it  r ight,  the drive A icon i s  selected, and appears h ighlighted. Move 
the pointer away from the icon, and c l ick on an empty area on the desktop to 
deselect the icon. 

Single-clicking and Double-clicking 

S i ngle-c l ick ing selects and h ighlights. You have already used s ingle-cl icking to 
h ighlight the drive A icon. Double-cl ick ing combines two s ingle-click actions in  
quick succession to both select and start a process, such  as  opening a fi le  or 
directory. 

Note: Use the Control Panel to adjust the responsiveness of the left mouse button 

to your clicking speed. For more information , refer to Control Panel in Chapter 

4, A Guided Tour of the Desktop. 

Now practice double-cl i ck ing .  Move the pointer over the drive A icon. Double
c l ick on the icon and the drive A d irectory appears in a w indow on the screen . To 
close the directory, c l ick on the Close button in  the upper left corner of the 
w indow. For more i nformation on the C lose button , see Windows, l ater in  this 
chapter. 

Dragg i ng 

Draggi ng w ith the mouse i s  easy. A l l  you need to do is select an i tem and move 
the mouse whi le holding down the left mouse button . The selected object(s) 
fol low the movement of the mouse. 
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When you ' ve dragged the objects to the desi red location, release the left mouse 
button to end the process. You need to drag to perform copy, move, or delete 
operations. 

If you drag a fi le  icon or icons to a new destination and release the left mouse 
button, the associated fi le or fi les w i l l  be copied, moved, or deleted, depending 
on the operation performed. 

Dragging an Icon 

When you drag icons from one location to  another, a ghost outl ine of  a l l  selected 
icons follows the poi nter from the original location to the dest ination. The pointer 
shape also changes from a poi nter to an out I ine of a hand unt i l  you release the left 
mouse button. 

Practice draggi ng an icon now by movi ng the desktop icons in to different 
configurations. I f  you accidenta l ly  drag one icon on top of another icon, a special  
w indow called a dialog box wil l  d isplay. Select Cancel. The d ialog box 
disappears, and the moved icon returns to the position it occupied before you 
moved i t .  

Selecti ng M u lt ip le Icons 

Sometimes you want to select more than one icon a t  a t ime to perform delete, 
copy, move, or other operations. There are two ways to select mult iple icons .  

The first way is using the rubber-band box to select icons that are grouped 
together on the desktop or in a w indow. 

Use the poi nter to create a box on the screen around the icons you wish to select. 
The box is cal led a rubber-band box ,  because i t  expands or contracts when you 
drag the pointer. 
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You can use shift-cl icking to select multiple icons indiv iduall y  instead of hav i ng 
to select items that are physically grouped together. The selected icons do not 
have to be in sequence on a l ist, or near each other on the desktop. Both methods 
of selecting multiple icons can be used on desktop or window i cons. 

Using the Rubber-band Box 

Whenever you drag the pointer, a rubber-band box appears on the screen .  The 
first corner of the rubber-band box is created wherever the pointer is positioned 
on the screen. The box expands i n  the direction of poi nter movement. 

Fol low these steps to practice se lect ing multiple icons w ith the rubber band box :  

1 .  Position the pointer above and to the left of the drive A icon. Try not to touch the 

nearby menu heading. If the menu drops down, just retract the menu and try again. 

2. Now drag the pointer down and to the right.  The rubber-band box appears and expands 

with the pointer. 

3. Surround the drive A and icon with the rubber-band box. Release the pointer. The icon 

h ighl ights. 

4. Move the pointer to a clear area of the desktop and click the left mouse button to 

deselect the icons.  

Using Sh ift-cl icking 

Shift-cl ick ing lets you select m u ltiple items that are not next to  each other on the 
desktop, or in sequence in a window. 

To practice select ing by shift-c l ick ing, use the fol lowing steps to select the drive 
A and B icons :  

1 .  First, select the drive A icon. 
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2. Now hold down [Shift] and position the pointer over the drive B icon. Cl ick the left 

mouse button. Both the drive A and drive B icons are now highl ighted . 

Note: You must hold down [Shift] until all desired icons are selected. Once 

you release [Shift] , no further icons can be added to the selected group. If 

you attempt to select an icon after you release [Shift] , all previously 

selected icons will be deselected. 

3. Move the pointer to a clear area of the desktop and click the left mouse button to 

deselect the icons. 

Combining Rubber-banding and Shift-clicking 

You can combine rubber-banding and shift-c l ick ing to select a group of icons, 
then deselect any icons you don ' t  want in the group. 

Follow these steps to practice combin ing the two methods of select ing mult iple 
icons: 

1 .  First, use rubber-banding to select both drive icons. 

2. Now use shift-cl icking to deselect the drive A icon. Only the drive B icon i s  

h ighl ighted. 

3. Use shift-clicking to reselect the drive A icon. Both icons are again highl ighted. 

4. Move the pointer to a clear area of the desktop and cl ick the mouse button to deselect 

the icons. 

Contro l l i ng the Poi nter with Keystroke 
Combi nat ions 

You can control the pointer, move, select, copy, etc . ,  us ing keystroke 
combinations instead of the mouse. 
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To use keystroke combinations, hold down the first key l isted and press the 
second key (or if  three keys are l i sted, hold down the first two keys and press the 
third key) .  

Note: Refer to Appendix A, Pointer Control and Quick Reference,Jor a quick 
reference chart listing the keystrokes for controlling the pointer. 

Moving the Pointer with Keystrokes 

Your screen is d iv ided i nto t iny sections or p ixels .  When you use keystroke 
combi nations to move the pointer, the pointer moves e i ther one p ixel  at a t ime or 
in mult ip le  p i xel jumps.  [Alt]  [ S hift] combined wi th  any arrow key moves the 
pointer one pixel in the direct ion of the arrow. U se this combinat ion for 
fine posit ioning. 

Selecting with Keystrokes 

Using the keystroke combination [Alt] [ Insert] performs the same function as 
c l icking the left mouse button. To perform a keystroke double-cl ick, hold down 
[AIt] and quickly press [ Insert] twice. 

Follow these instructions to practice selecting and in i t iat ing a procedure using 
keystroke combinations: 

1 .  Position the pointer over the drive A icon. 

2. Press [Alt] [Insert ] .  The drive A icon h ighl ights. You have selected the drive A icon. 

Now move the pointer to an open area of the desktop and press [Alt]  [Insert] again to 

deselect the drive A icon. 

3. To practice keystroke double clicking (selecting and opening the drive A window i n  

one maneuver), reposition t h e  pointer over t h e  drive A icon. Hold down [A It] and 

quickly press [ Insert] twice. A window opens and d isplays the contents of the disk in 

drive A. 
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4. To close the open window, position the pointer over the small box in the upper left hand 

corner of the window and press [Alt] [Insert]. The window closes. 

Dragging with Keystrokes 

To drag with keystroke combinations, press [Alt]  [ Insert] combined with any 
arrow key to drag a selected icon or group of icons i n  the direction of the arrow. 
The poi n ter m ust be pos it ioned over the selected icon or group of icons for 
successful dragging.  

Wi ndows 

Most of the desktop activ i ty takes place i n  windows. Windows are smal l screens 
with in  the l arger screen display. There are two types of windows, general 
program windows and desktop w indows. The basic difference i s  that desktop 
w indows d isp lay more i n formation than general windows. Figure 3- \ ,  below, i s  
an example o f  a desktop window .  

Drive Identifier File Mask 

� ... 
i n  47 i teMs . Full  Button Close Button 

0 
{» 

ESPRIT 

Information Line 

Resize Button 
o o 

... ox GDOS . S V S  

¢ 

Scroll Bars 

Figure 3 - 1 .  Window Elements 
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The Drive Identifier appears in the center of a window ' s  move bar. rt shows the 
drive letter of the open dri ve, in this case hard d isk drive C. 

The File Mask tells you what type of fi les are displayed in the window. You can 
set the File Mask to d isplay all the files  in a directory, or you can set up 
restrictions on the types of fi les displayed. The window displays an icon for each 
folder in the directory , and for every fi le in  the directory that matches the fi le 
mask sett ing.  For more detai led i nformation on sett ing the File Mask, see Set File 
Mask in Chapter 4, A Guided Tour of the Desktop. 

The Information Line displays the B ytes Used ( total number of bytes of disk 
space used by the contents of the directory) ,  and I tems (the number of fi les and 
folders residing within the directory) .  If some i tems are selected, the numbers 
refer only to the selected items. The other elements of a window are explained in 
the fol lowing tutorial sect ions. 

On the right and bottom sides of the w indow there are scroll bars that a l low you 
to view portions of the w i ndows contents, when al l  of the contents are not v i s ible.  

There are several buttons for contro l l ing the window. The Close button closes the 
window when you cl ick on it. The Full button resizes the w indow so that i t  u ses 
the ful l  screen. The Resize button allows you to drag a window to size .  

Opening and Closing a Window 

D irectory w indows can be opened in several ways by using the pointer and left 
mouse button. You can practice opening a window now. First, make sure the 
Language disk is  in  drive A,  then double c l ick on the drive A icon. 

You have opened a window by double c l icking on a desktop icon. The contents of 
the Language disk now appear in the drive A directory window. 
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Note: !f the drive A icon highlights but the window does not open ,  the computer 

has not recognized your click as a double-click, but only as a single-click. Move 
the pointer to a clear area of the desktop and click once to deselect the icon . Try 

again, and remember that double clicking can be a bit tricky at first. Just keep 

practicing. 

Leave the drive A directory window open for now; you w i l l  use it in the next 
exercise . 

Scrol l ing a Window 

Sometimes a single d irectory contains too many i tems to display in a window at 
one t ime. When th is occurs, some directory i tems remain undisplayed , or h idden.  
You can view the hidden i tems by usi ng the scro l l  bars. 

The scro l l  bars along the bottom and right edges of the window let you scro l l  the 
window horizontal ly ( right and left) or vertical l y  (up and down) .  

I f  a directory contains more items than wi l l  fit in  the window, a portion of the 
scrol l  bar w i l l  be shaded. The scrol l  box shows the current posit ion and s ize of 
the window relative to the total directory display. If there is shaded area above or 
below the scroll box, more of the directory is avai lable by scrol l ing the w indow 
in the direction of the shaded area. 

Practice scroll ing a w indow. Use the drive A directory w indow that is sti l l  open.  
For th is exercise, use the scrol l  bars to find LINES. PRG, a program that you wi l l  
be using in  the next  exercise. 

Scroll by posit ioning the pointer over the scro l l  arrow that i ndicates the direction 
of the hidden contents .  Click once. Now cl ick once on the opposite arrow to 
return to the original window display. The contents of the window scroll by one 
space. 

Now scro l l ,  one w i ndow displ ay at a time, by posit ioning the poin ter over the 
shaded area of the scro l l  bar. C lick once. The previousl y  displayed item s  are now 
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h idden ,  and the screen displays previously h idden items. 

Note: You can also scroll using the up and down arrow keys to the right of the 

m.ain keyboard. 

Try scroll ing entries continuously by positioning the pointer over the scrol l  arrow 
that i ndicates hidden items. Hold down the left mouse button. 

Note: You can also skip over some o{ a directory ' s  contents by dragging the 
scroll box to a new position in the scroll bar. The window now displays the 
contents of that portion of the directory. 

When you have found LINES .PRG, leave the window open and go on to the next 
exercise.  

Sizing a Window 

Sizing a window is especially useful when you want to display more than one 
w indow on the desktop at a time. Practice sizing a w indow by first opening the 
program LINES.PRG using the techniques you have already learned. 

The Lines program displays a group of l ines moving across the screen. When you 
open LINES .PRG i t  uses the ful l  window. So you can practice resizing a window 
by reducing the size of the Lines window. 

First find the size box in  the lower right corner of the window. Move the pointer 
over the size box and use dragging to move the size box up and to the left. An 
outl ine of the window follows the pointer movement. Release the left mouse 
button w hen the w indow out l ine i s  about half of the original w indow size .  

Then locate and select the Ful l button i n  the  upper right corner of the  screen .  
Selecting t h e  ful l  box expands a window to fi l l  t h e  entire screen. 

Just for fun,  take a moment to explore the L ines program. Press [Clr Home] and 
you w i l l  see the group of l ines reduced to a s ingle object. The l ines are now 
erasing themselves as they go along. Pressing [Clf Home] toggles the erase mode 
on and off. 
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You can increase or decrease the l ine segments of the object by pressing a 
number key on the keypad. Try press ing the number keys unt i l  you find a shape 
that you l ike. 

There are other ways of contro l l ing  the L ines program, which you w i l l  l earn 
about l ater. 

If you select the Fu l l  box again .  The w indow returns to the most recent s ize and 
posit ion.  Cont inue to practice s iz ing the w indow. Drag the s ize box down towards 
the bottom of the screen to lengthen the window, up to shorten the w indow, right 
to w iden it, or left to narrow it. When you have fin i shed pract ic ing, leave the 
w indow open for the next exerc ise. 

Moving a Window 

You can use the move bar to move a w indow to any screen posi t ion below the 
menu bar. 

First, posit ion the pointer over the shaded move bar. Drag the w i ndow to a new 
posi t ion on the screen, then release the mouse button. The window displays i n  i ts  
new pos i tion.  

Let 's  work wi th  the Lines program some more. S tart w i th the shape you made in  
the  prev ious exercise.  Now add more shapes by  press ing [ * ]  on the  keypad. I f  you 
want fewer shapes press [ f ] .  Final ly,  press [+] to bring the shapes c loser together, 
or press [ - ]  to spl i t  the shapes further apart . Press [C l r  Home] if you want Lines 
to erase the l i nes as they move along. When you 're done , c lose the Lines w indow 
by cl icking on the Close box .  

The Top Wi ndow 

When you have more than one w indow open at a t ime, the w indow i n  front  is the 
top w indow. You can identify which w indow is the top w indow by l ooking at the 
move bar. Only the top w i ndow ' s  move bar is shaded. 
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Make any window the top window by position ing the pointer anywhere on the 
window and c l icking the left mouse button. 

Open windows may overlap. I f  they do, the top w indow is always completely 
displayed. Top a part ly hidden, bottom window by posi t ion i ng the poi nter 
anywhere on the w indow and cl icking the left mouse button . The bottom window 
moves to the front of the other windows.  

Menus and Pop- u ps 

Menus and pop-ups a l low you to select d ifferent options on the desktop or in the 
Control Pane l CPXs. Menus, which display a ful l  range of choices, usual ly drop 
down from the menu bar. If you select an item from a menu, a checkmark appears 
beside the i tem. Pop-ups are smal ler, more specific menus act ivated by buttons. 

Opening a Menu 

Each menu heading o n  the menu bar has i t s  own drop-down menu. I f  you move 
the pointer onto the menu bar near one of the headings that menu immediately 
drops down and displays i ts  command options. Moving the pointer away from the 
dropped menu to another menu heading causes the new menu to drop down, and 
the prev iously d i splayed menu to retract .  

Note: A drop-down menu may have both active and inactive options. Active 

options are in regular text and produce an action when selected. Inactive options 
appear as lightened text. Selecting an inactive option causes the menu to retract. 
Options with a check mark to the left of them are currently selected. 

To retract a menu without selecting a command option, move the pointer outside 

the menu and cl ick on the desktop. 
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Open ing a Pop-up 

Pop-ups appear as shadowed buttons when closed, and menus when open .  
To open a pop-up, c l ick o n  a shadowed ( pop-up) button with the mouse. A pop
up w i l l  appear with a l i st of selectable items. The currently selected item is 
indicated by a checkmark . Cl icking on any item se lects that item. Cl icking once 
more on the selected item closes the pop-up.  When you close a pop-up, the 
current selection appears on the shadowed button. 
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4 A Guided Tour of the Desktop 

The Menu Bar 
The top edge o f  the desktop contains  the menu bar. The menu headings are Desk, 
Fi le,  View, and Options.  To see the commands wi th in  any menu heading,  posit ion 
the pointer over the menu heading.  The heading h igh l ights and the menu d isplays 
under the selected heading.  

When the menu d isplays you can select an option.  Options i n  black text are active 
and avai lable for use. Options in light text are i nact ive .  I nactive options are not 
avai lable for use at the t ime you d isp lay the menu. ( See the specific option later 
in this chapter for more i nformat ion . )  

Most  of the commands l i sted under the menu headings can be selected by us ing a 
single keystroke. Each command ' s  keystroke is l i sted in brackets to the right of 
the command name. To i n i t iate the command, just press the key i ndicated. I t  
saves a lot of t ime i f  you memorize the keystrokes for the commands you use 
frequent ly .  You can change the assigned keystroke of a command, or assign a 
keystroke to a command that does not have one. ( Refer to Desktop 
Configuration in th is  chapter. ) 
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Desk Menu 

The Desk menu i s  divided i nto sections of selectable menu i tems. The upper 
section displays the name of the app l icat ion you are currently us ing .  Selecting 
this menu i tem displays i nformation about the appl ication. 

The lower section contains a l i st selectable menu i tems that al low you to access 
desk accessories, such as the Control Panel . 

Note: Desk accessories are automatically loaded each time you start up the 
system. Switching on the computer without active desk accessories ji·ees some 
RAM and displays the desktop faster. 

Fol lowing is a detai led description of the different sections of the Desk men u :  

Desktop I nfo 

When you display the Desk menu from the desktop, the top sect ion of the menu 
l i sts the Desktop Info option. If you select Desktop I nfo, a w indow l ist ing GEM 
and Mult iTOS copyright data displays.  

Control Panel 

The Control Panel accessory (XCONTROL.ACC) a l lows you to modify your 
system ' s  setup even whi le  your working ins ide another program. For detai led 
information on the Control Pane l ,  see Control Panel in Desk accessories, l ater 
in th is  chapter. 
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Fi le  Men u  

The Fi le menu contains  options for opening and c losing directory windows, 
selecti ng all displayed fi les  and folders for an operation, deleting a fi le  or fol der, 
creating a folder, formatting disks, and more. Thi s  section explains in  detai l  each 
Fi le  menu option.  

Open 

The Open command can be performed on a disk icon, cartridge icon, folder, fi le ,  
or printer icon.  

First  select the item you wish to open .  Then select Open from the Fi le  menu. The 
result  of the command depends upon w hich icon is h igh l ighted: 

Disk icon or folder The disk or folder d irectory window appears. 

Cartr idge icon (dr ive c) or executable fi l e .  The desktop d i sappears and the 
program runs. 

Printer icon An alert box ,  which informs you that the icon you attempted to 
open is a printing dev ice, appears. 

Data file If you have installed an application that is l i nked to the 
same document type as the data fi le  you are opening, the appl ication auto-
mati cal l y  opens and loads the data fi le .  If no such appl ication is i nsta l led, a 
dialog box displays, giving you the choices Show, Print, or Cancel. Show 
displays the contents of the file on the screen as ASCI I  characters. Prin t  outputs 
the contents of the fi le to a printer (if you have a printer connected 
to your system),  and Cancel cancel s  the command. 

Note: An alternative to using the Open menu command is to position the pointer 

over the icon you wish to open and double-click the left mouse button. 

A Guided Tour of the Desktop 4-3 



Faicon030 Owner 's Manual 

Show I nformation 

When you h ighl ight a floppy disk, logical drive, folder, o r  fi le icon and select the 
Show Info opt ion , the screen displays information about the h ighl ighted i tem. 

When you select Show Info for a floppy disk or logical drive icon,  the Disk 
Information dialog box displays the fol lowing information: 

Drive 1 0  The drive 's letter identifier. 

Disk Label The name you assigned to the drive. ( Th is field may be blank . )  

N u m ber o f  Folders The total number o f  fo lders o n  the d isk or logical drive,  
incl uding folders with in folders. 

N u m be r  of F i l e s  The to ta l  n u m be r  of fi les on the  d isk  or l og i c a l  d r i v e ,  
including fi les within folders. 

Bytes used The number  of bytes used by a l l  fi les and fo lders on the disk or 
logical drive. 

Bytes available The avai lable storage space ( measured i n  bytes) left on the 
disk. 

Note: In the Disk Information dialog box, the numher of bytes used plus the 

number of bytes availahle for a floppy disk or logical drive does not always equal 

the exact total storage capacity. This is because the computer allocates space for 

each file in fixed-size blocks, even if the file does not completely fill the last 

hlock. The Bytes A vailahle information is an accurate indicator of available 

unused storage space. 

When you select Show Info for a fi le or folder, the File I nformation d ialog box 
or Folder Information dialog box displays the fol lowing informat ion : 
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Path The top l ine l ists the complete path of the fi le or folder. I f  the path is too 
long to d isplay on the l i ne,  you can use the scrol l  arrows to reveal the hidden part 
of the pathname. 

Name The name of the fo lder or fi le .  The text i nsert ion cursor appears to the 
right of the name. 

To change the name of a fi le or folder, press [ Esc ) to c lear the name l ine. Type i n  
the n e w  name, using eight characters or less. Type a period, then the three 
character file extension ( usual ly not used in folder names) .  

Size S ize, i n  bytes of t h e  fi le o r  folder.  Folder s i ze i s  the total number o f  bytes 
used by al l  the fi les wi th in  the folder. 

Date The date the file or folder was last modified. 

Time The t ime the fi le or folder was last modified. 

Number of Folders The number of folders w ith in  the folder. This only applies 
to folders .  

Nu mber of F i les The tota l  number of fi les wi th in  the fo lder, inc lud ing  fi l es 
within other folders. 

Attribute The two choices are Read Only, and Read/Write. If you want 
to make sure a fi le remains intact and no changes are made to it, select Read 
Only. You wi l l  sti l l  be able to display and copy the fi le, but you cannot modify or 
delete i t .  Read/Write al lows you to read the fi le,  change i t ,  or delete i t .  The 
Attribute field does not apply to folders .  

Search 

The Search command performs a fi le search on a floppy disk, logical drive, or 
folder. When you select Search, the Search File di alog box appears. 
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You must set the parameters of the search by typing in the name of the fi le  for 
which you are searching.  You can also type i n  part of a fi lename, and Search 
matches the typed characters. For example, if you w ish to search for al l files w ith 
the extension .DOC, type a period, then type DOC. Search opens the window 
contain ing the first . DOC file i t  finds and asks you if it should continue the 
search. If you select OK, Search w i l l  use the same window to show the next 
.DOC fi le,  and so on . 

. W hen Search can find no more . DOC fi les, an alert box displays to let you know 
that no more files are to be found. 

Before select ing Search, you should h ighl ight the floppy disk, logical drive, or 
folder upon wh ich you wish the search performed. If no i tem i s  h ighl ighted, 
Search w i l l  perform the command upon the active window .  If there i s  no open 
window on the desktop and no highl ighted i tem, you cannot select Search from 
the menu .  

Note: The Search dialog hox may cover highlighted icons. Since the files found hy 

Search are highlighted, the window information line displays the number of 

matches. 

Delete 

The Delete command de letes al l  h igh l ighted files and folders. If you highl ight  a 
floppy disk or logical drive icon and select Delete, all  fi les and folders contained 
on the corresponding drive w i l l  be deleted. 

Create Folder 

The Create Folder command creates a new folder in  the  act ive w indow. When 
you select this command, the New Folder dialog box appears. Type in a name for 

the folder, then select OK (or press [ Return ] ) .  The name of the new folder 
appears in the directory window. 
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Note: Certain characters cannot be used within a folder name or extension. 

For a list of illegal characters, see Files and Filenames in Chapter 5, Desktop 

Management. 

Close Di rectory 

The Close Directory command closes the top level of the active window. For 
example, let ' s  say the top window i s  a folder w i ndow, and that folder res ides in  
the main  directory of drive C.  When you select Close Directory, the  folder's 
w indow closes, and the main directory w indow displays. 

Note: You can also close a directory by selecting the close box in the window's 

upper left corner. 

Close Top Window 

The Close Top Window command completely closes the top w indow, inc luding 
al l  levels of folder w indows and the main directory w indow. If w indows from 
other floppy disks or logical drives are open on the desktop, the most recently 
opened w indow becomes the act ive w indow. 

Bottom to Top 

The Bottom to Top command i s  usefu l when you have mult iple,  overlapping 
w indows displayed on the desktop. When you select th is  command, Bottom to 
Top brings the bottom w i ndow to the top of the stack and displays it  as the active 
w indow. The current top window is sent to the bottom of the stack. 

Select Al l Items 

The Select A l l  Items command selects a l l  fi les and folders in  the top window (see 
Note ) .  The fi les and folders that are h idden, but would be shown by scrol l ing,  are 
also selected. However, fi les that are in the directory but do not match the fi le 
mask parameters are not selected. ( See Set File Mask in th is  chapter. ) 
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Note: If the File Mask is * . *  (show all items), then all items , including allfolders , 

are selected. 

Set F i le  Mask 

The Set F i le Mask command al lows you to choose the fi le type t o  be di splayed i n  
the active w indow. When you select th is  command, the Set Fi le Mask d ialog box 
appears. You must fi l l  in the fi le type parameters, both file name and fi le 
extension. 

For example, i f  you want only those fi les beginn ing with the letters DESK to 
appear i n  the directory l ist, you would press escape to c lear the Name l ine. Then 
you would type DESK * .  * and select OK. The first asterisk after the word DESK 
means that any fi le wi th characters i n  the fi lename fol lowing the letters DESK 
should be d i splayed. The asterisk  i s  known as a w i ld  card character. (See File 
Specification in th is  chapter). The period is the separation between the fi l ename 
and the file extension. The second asterisk means any file w i th a filename that 
meets the parameters should be d isplayed no matter what extension the file has. 
Setting the fi le  mask as described here would d isplay files with different 
fi lenames and extensions,  such as DESKTOP.lNF and DESKACC. DOC, as long 
as the fi lename begins w i th the characters DESK .  

The default fi le mask parameter i s  a n  asterisk for the fi lename and a n  asterisk for 
the extension . Thi s  means a l l  fi les are displayed. 

Note: A lthough all folders are visible during a file mask, you can use a file mask 
to select folders with the same extension . 

The parameters selected for the open w indow remain i n  effect as long as the 
w indow remains open .  Once you c lose the w indow, the parameters you chose are 
cleared. 
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Format Floppy Disk 

Formatting prepares floppy d isks to accept data. You can format disks as ei ther 
single-sided , double-sided, or h igh-dens ity. Used disks can be reformatted. 

Al l  disks formatted w i th TOS are compatible with M S-DOS version 3 . 2  or l ater. 

To format a floppy di sk, insert the disk into a floppy disk drive. Select the floppy 
disk icon, then select Format. For complete information on formatting disks,  see 
Formatting a Floppy Disk in Chapter 2, Using Your Computer. 

View Menu 

The V iew menu lets you choose the way your computer displays files and folders. 

You can view fi les and folders as icons or text. You can display those fi lenames 
alphabetical ly by name (filename or extension) ,  or numerical ly by date or file 
size. To modify the display,  select the menu option you want. A check next to a 
option indicates that option is selected. 

Options selected from the View menu affect al l  directory windows. You cannot 
select one option for one w indow and a different  option for another window. 

Note: When you save your desktop , TOS saves all the View menu choices you 

made to the NEWDESK.INF file on your startup drive. (See Save Desktop in this 

chapter. ) 
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Show as Icons or Show as Text 

The same directory, with entries displayed both as icons and as text ,  is shown in 
the fol lowing example. 

III! C : \* . *  jrtl C : \*.* 
4 78202 bytes used in 4 7  i teMs . 16 bytes used in ., iteAs . 

0 0 0 � 
-

AUTO c.x ESPRIT 

WTn 10-0'-U 02 : 59 ill'! 
;PX 19-04-3.1 02 : 59 alii 
;SPRIT 1 9-04-3.1 8l : S 1  iII'I 

U U D 
0-GOOS .svs HOX MJNSTALL 

iDDS SVS 10-10-3.1 12 : 1 1  PI" 
iDX 95-31-'2 12 : 29 III'! 
i INSTALL 95-u-n 12 : 17 aM 

:� 

� 
r-

� OJ 1� r; I.:> r; 

Figure 4 - 1. Icons and Text 

When directory entries are shown as icons, different icons indicate different types 
of fi les or folders. The window displays icons in horizontal rows across the 
desktop. Y QU can choose the shape of desktop and window icons. See Install 
Icon in this chapter. 

When directory entries are shown as text, the window displays the filename, fi le 
size, and the date and t ime the fi le  was last modified. A square icon to the left of 
a filename indicates a folder. The window displays fi les and folders as vertical 
text. 

Note: A triangle symbol appearing next to a file name indicates a read-only file . 

Files and folders displayed as text may be opened, copied, and deleted using the 
same procedure used with icons. 

Sorting by Name/Date/SizelType 

It is sometimes necessary for you to have a list of your fi les and folders presented 
in a certain order. 
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Folders as a group are always l i sted first, fol lowed by fi les (Except w i th the No 
Sort Option) .  You can sort your fi les  and folders i n  the fol lowing ways :  

Sort by Name Displays files and folders alphabetical ly.  

Sort by Date D i sp l ays fi l e s  and fol ders chronolog i c a l l y .  The most recent ly  
created or  rev ised file  or  folder appears first. 

Sort by Type L ists fi les  alphabetical l y  accord i ng to thei r  extens ion type. F i les  
with common extensions are grouped together in  alphabetical order by fi lename. 

Sort by Size List fi les in descending order according to thei r  size. 

No sort L i st files and folders according to the order in which a program would 
recognize them. 

Size to Fit 

When you select Size To Fit, al l  i tems are di splayed i n  horizontal rows starti ng 
at the top of the w i ndow. Each row is only as w ide as the window and w i l l  
automatical ly rearrange whenever the w indow i s  res ized. ) 1  

Set Color and Style 

Set  color and style a l lows  you to create a unique desktop environment. You can 
use Set Color and Style to choose a color and/or fil l  pattern for both your desktop 
and for opened w i ndows. When you select Set Color and Style, the Set Color 
and Style dialog box appears. 

Note: To modify the window display, the Window box must first be highlighted. 
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To modify your desktop environment, fol low these steps: 

1 .  H ighl ight  the Desktop box . 

2. Position the pointer over the solid black Style square and cl ick once. 

3. To select a color, position your pointer over the desi red color on the color palette and 

c l ick once. The color d i splays in the Preview Box .  ( I f you are using a monochrome 

mon i tor, position your pointer anywhere on the black �ection of the color palette and 

cI ick once . )  

4. To select a fi l l  pattern, posi t ion your  pointer over  the desired fi l l  pattern and c l ick  

once. The fi l l  pattern displays over the  color in the Preview Box.  

5. Next  h ighl ight the  Wi ndow box and repeat Steps 2 through 4 to  modify your window 

display. 

6. Select OK to select the chosen options and exit Set Color and Style. 

Options Menu 

The Options menu includes commands that a l l ow you to save your desktop 
configurat ion, i nstal l icons, appl ications, and devices, and print what i s  displayed 
on your screen . You can use the Set Preferences option under the Options menu 
to switch confirmation dialog boxes on or off and set your screen resolution . 

Note: When you sal'e your desktop ,TOS saves all the Options menu choices you 

made to the NEWDESK.lNFfile on your startup disk. (See Save Desktop in this 

chapter. ) Use Save Desktop to save changes made with Options menu commands. 
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I nstal l  Icon 

I nstal l  Icon al lows you to choose the shape of your w indow and desktop icons .  
The DESK ICON.RSC fi le on your C drive or  floppy startup disk contains a 
collection of icon shapes.  You access this fi le through Instal l  Icon. Choose from a 
variety of icons to create an interesti ng and entertain ing desktop. 

You can a l so use Instal l  Icon to change a floppy d isk 's  or logical drive ' s  icon 
identi fier and icon labe l .  

When you select Insta l l  Icon from the Options menu, the select icon type dialog 
box d i splays. You can select either Desktop or Window. Desktop icons are : 
dev ice icons (printer, floppy disk drive, logical dri ve, and cartridge) ,  and the trash 
can icon. W indow icons are folder and file icons.  

Desktop Icon 

To instal l  a s ingle desktop icon, fol low these steps: 

1 .  I f  you are i nstal l ing a floppy disk or logical drive icon, type the drive identifier letter. 

Press [Tab ] .  

2. Type in the name of  the  floppy d isk  or  logical drive. You can use  up to  12  characters. 

Th is  step is optional; you do not have to assign labels (names ) to your desktop icons. 

3. Pos it ion your pointer over the type of icon you wish to instal l :  Drive. Trash Can. or 

Printer ( see Using an Instal led Printer Icon later in this  section ) .  Cl ick the left 

mouse button once. 

4. U se the scro l l  arrows to scro l l  th rough your icon choice s .  When the des ired icon 

displays, select OK to instal l .  The icon appears 011 your desktop. 
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Use the fol lowing steps to assign an icon shape to a group of desktop items:  

1 .  From the desktop, use  rubber-banding and/or sh ift-cl icking to  h ighl ight the  group of 

desktop items. 

2. Se lect I nstal l  Icon from the Options menu. The Instal l Desktop Icon d ialog box 

displays. The drive identifier, icon label,  and currently assigned icon shape of the first 

selected desktop item appears in the d ialog box. 

3. If  the Drive box is  not h ighl ighted, posi t ion your pointer over the Drive box and c l ick 

the left mouse button once. 

4. Use the scroll arrows to d isplay the desired icon shape. To assign that icon shape to 

the first of the selected group of i tems, select OK. The second i tem of the selected 

group displays in the dialog box. 

Note: If you do not wish to assign a new icon shape to an item in the selected 

group, select Skip when that item displays in the dialog hox. That item retains its 

current icon shape. 

When you finish selecting the final item in the group, the dialog box disappears. 
The new icons for all selected i tems appear on your desktop. 

Window Icon 

There are two ways in which a window displays items :  text and icons. You can 
assign icon shapes to window items that are currently displayed as text, but the 
assigned icon shapes w i l l  not disp lay unti l  Show as Icons ( under the View menu) 
i s  selected. 

You can assign icon shapes to: a s ingle window item ( fi le or folder), a group of 
window items, or a speci fic  fi le type. 

To assign an icon shape to a single window item ( fi le or folder), or a group of 
window items, fol low these steps : 
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1 .  Open the window containing the desired window i tems. H ighl ight a single d i splayed 

window item or use rubber-banding to highlight a group of displayed window items. 

2. Select Insta l l  Icon from the Options menu. 

The Instal l  Window Icons dialog box displays. The name of the first selected 
desktop item appears in the dialog box. Either the File or Folder box is 
h ighl ighted, designating the type of item displayed, and the icon currently 
assigned to the item is displayed. 

3. Use the scro l l  arrow s  to sc rol l through your icon choices.  When the des i red icon 

d isplays, select I nstal l  to assign the icon shape to the d isplayed item. The name of 

the selected group ' s  second item d isplays in  the d ia log box , along with that i tem ' s  

current icon. 

Note: If you do not wish to assign a new icon shape to an item in the selected 

group, select Skip when that item' s  name and current icon displays in the dialog 

box. That item retains its current icon shape. If you wish to remove the item ' s  

currently assigned icon shape, select Remove. The default icon shape for that 

item type is automatically assigned to that item. 

When you have completed the selection process for the final item in the selected 
group, the dialog box disappears. The new icons for all selected i tems appear in 
the w indow. 

You can also assign an icon shape to a fi le type. After setting the parameters to 
define the fi le type , al l  the fi les that match the selected parameters wi l l  be 
assigned the specified icon shape. Select the parameters the same way you would 
set a fi le mask, typing in the parameters on the Name l ine of the Install Window 
Icons dialog box. (See Set File Mask in this chapter.) 
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To assign an icon shape to a spec ific fi le extension, fol low these steps: 

1 .  With a window ope n ,  se lect  I n sta l l  Icon from the Opt ions  men u .  S e l ect  the 

Window box from the dialog box. The Instal l Window Icons dialog box displays. 

2. Type *. followed by the extension ( for example, * .FNT). 

3. U se the scro l l  arrows to d isplay the desired icon shape. To assign that icon shape to  

the  fi l e s  matc h i n g  t h e  spe c i fi e d  parameters ,  se lect  I nsta l l .  The d i a l o g  b o x  

di sappears. A l l  f i l e s  t h a t  match the selected parameters w i l l  be represented b y  t he 

selected icon . 

Changing the Icon Identifier and Label 

To enter a new icon identifier and label for an icon, fol low these steps: 

1 .  Highl ight the icon you wish to change. Select Insta l l  Icon from the Options menu. 

The Install Icon dialog box appears. 

2. Type the new Icon ident ifier letter and press [Tab ] .  If you wish to retain the current 

drive identifier, press [Tab] to move the text insertion cursor to the Icon Label l ine. 

Note: The letters A and B are reserved for floppy disks, and the lowercase 

letter c is reserved for the cartridge slot. Uppercase letters C through P 

represent logical drives. 

3. Press [Esc] to clear the Icon Label l i ne. Type in the new icon label .  You can use up to 

1 2  characters. Select OK. 

Using an Instal led Printer Icon 

An instal led printer icon helps you print files in  the same way as the Prin t  
command o f  the Show/Print dialog box ( see Opening a Data File i n  Chapter 5, 
Desktop Management. ) .  
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Drag and posi tion the desired fi les over the printer icon. I f  you have a printer 
properly connected to your system, the information from the fi le is sent to the 
printer. ( Some fi les may print only  coded or incomplete information . )  

After instal l ing a printer icon, use Save Desktop t o  save the installation. The 
next t ime you switch on your system, the printer icon appears on your desktop. 

I nstal l Appl icat ion 

Using Instal l Appl ication you can: 

• Link an application to data files with a specified extension. You can then 
process those data files directly from a window, instead of opening the 
application first. 

• Select an autoboot status for any application, so whenever you switch on your 
computer, the application opens automatically. 

• Assign a function key to open any application. 

• Specify what default directory to use for any application. The assigned 
default directory takes precedence over the defaults assigned by the Desktop 
Configurations. 

• Specify a full path or a filename for an application. The specification takes 
precedence over the defaults assigned by the Desktop Configuration. 

• Assign arguments to programs. 

Arguments 

When you open a program fi le,  you are tel l ing the computer to fol low the 
instructions in that fi le.  The instructions within the program file then take over 
and run the show unt i l  you exit from the program . 
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Sometimes you need to give the program additional information, such as what to 
do with a data fi le.  This addit ional information is cal led an argument. 

Most programs provide ways for the user to input arguments, such as an Open 
Fi le command in a word processing program. In fact, if you input the name of an 
exi sting data fi le  in the Arguments l ine, and you have your input parameters set in  
such a way that the program can find the fi le ,  the data fi le wi l l  open automatical ly 
when you open the word processing program. 
B ut unless you work on one data fi le almost exclusively,  other options such as 
l inking an application to a data fi le type make arguments of th is  kind c lumsy and 
unnecessary. 

Arguments are used most often with ut i l i ty programs. These programs often need 
complex addi tional i nstructions such as a code sequence to determine which part 
of RAM w i l l  be used to contain the program instructions. Detai led explanations 
of the arguments needed, and the correct syntax for those arguments, w i l l  be 
inc l uded in the program ' s  documentat ion . 

When you open the Insta l l  Application dialog box, the text insertion cursor i s  
already on the  Arguments l i ne. S i mply type in the  arguments and press [ Return] .  
Remember to use  Save Desktop to  save the argument, otherwise i t  w i l l  be  erased 
when you switch off the computer. 

Linking a Document Type to an Appl ication 

Normal ly ,  the on l y  way you can process a data fi le is to first open an appl ication 
that can work with the type of data contained in the fi le .  Then you can open the 
data fi le from with in  the appl ication. 

I f  you attempt to open a data file directly from a window, a d ialog box displays 
informi ng you that your options are to show or print the fi le ,  or cancel the 
request. You cannot edit the data i n  the file. 

But  you can use Instal l  App l ication to l ink a data fi le type (determined by the 
three character file extension) to an appl ication. 
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Choose the file type most common ly used by the appl ication. After l i nking the 
appl i cation with the document type, the l inked appl ication automatical ly  opens 
when you open the document. 

Note: You must pay particular attention to assigning correct default directories 
and parameters to an application when linking a document type to an 
application. This is especially true when you open the application ji'om its icon 

on the desktop . Refer to the application ' s  documentation for detailed information 
on correct default directories and parameters. 

To use Instal l  Appl ication to l ink an appl ication to a data fi le  type, fol low these 
steps: 

1 .  D i splay the window containing the application you wish to l i n k  to a document type. 

H ighl ight  the desired appl ication . Se lect I nsta l l  Appl ication from the Options 

menu. The name of the selected appl ication appears in the Instal l  Application d ialog 

box. 

Note: You can select more than one application at once for this operation . 
Highlight all the applications you wish to install, then open the Install 
Application dialog hox. Ajter completing the operation on the first selected 

application.  the name of the second selected appli
,
cation appears in the 

Install Application dialof{ hox. 

2. Press [Tab] to move the text  i n sertion cursor to the Document type l ine. Type in the 

t h ree ch aracter f i le  e x tens ion  of  the  f i l e  type y o u  wish  to  l i n k  to  the  d i sp layed 

appl ication. 

3. Select the appropriate Application type. 

4. Choose a Default Directory and Parameter. 

5. Select Instal l  to enter the selected settings. 
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Note: When installing multiple applications, selecting Skip causes Install 

Application to skip over the application identified on the Application name line. 
All the current settings are retained. 

Selecting a Default Directory 

Every program that works with support ing fi les (e .g . ,  resource fi les or help fi les)  
needs a way to look for those fi les .  Desktop Configurations tel l s  your computer 
which directory should be the default .  This i s  where the program accesses files if 
the program assumes that they are not installed. 

Using Instal l  Appl ication to ass ign a default d irectory to a specific  app l ication 
overrides the Desktop Configuration ' s  assignment for that application. 
You can set the default d irectory to Top Window, or Appl ication ( the directory 

in which the program res ides). 

Some programs do not look for fi les in any l ocation other than the default 
d irectory. For these programs, select Top Window, and make sure that the 
program fi le and a l l  support ing fi les are in the top window. 

Selecting Parameters 

B efore an open appl ication can use a data fi le ,  it must first find and open the fi le .  
Most programs enable you to search through a l l  ex ist ing directories to locate and 
open a desired fi le .  

These programs have no preconceived ideas about the location of fi les .  For these 
programs you would choose Full  Path, so the entire path name of the fi le  is used 
when a fi le is opened. 

Other programs already have pre-exist ing partial  paths .  Th is  means that the 
program contains a partial path name that it uses every time the program searches 
for a fi le .  A partia l  pathname consists of the drive identi fier, and all appl icable 
directories.  On ly the file name and extension i s  input for the search. All files 
must be in the specified directory, or they cannot be located. 
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Check your program ' s  documentation to determine the program ' s  default path, 
and make sure all of your data fi les reside in the correct directory. 
Al ways try Full Path first. Then if necessary, experiment with other combinations 
until you find one that works with your appl ication. 

Instal l ing an Appl ication to Open from a Function Keystroke 

You can instal l  any executable file ( program) to open from a function key ( L F 1 ] 
through [ F  I 0] at the top of the keyboard) .  

After you ass ign a function key to a program, you only have to press the assigned 
function key to open that program. The assigned key w i l l  only open the program 
from the desktop. Once you are wi th in  an appl icat ion, the function keys perform 
the tasks assigned to them by the appl ication. 

To assign a function key to open an application, fol low these steps: 

1 .  H ighlight the application. 

2. Select Instal l  Appl i cation from the Options menu. 

3. Press [Tab] twice to move the text insertion cursor to the Install as l ine. 

4. Type the number of the function key you wish to assign to the application. 

5. Select Instal l .  

Installing an Application to Autoboot or Normal Boot Status 

If you mainly use your computer for a single purpose using one specific 
app l ication ( such as a database, a word processor, or graphics program),  i t  w i l l  
save time i f  you instal l that appl ication t o  autoboot. A n  appl ication installed to 
autoboot status w i l l  open automatical ly whenever you switch on your computer. 
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Fol low these instructions to install  an application to autoboot or to return an 
application to normal status :  

1 .  Highl ight the  icon or  name of the  appl ication you wish  to  instal l to  autoboot. Select 

I n sta l l  A p p l i cat ion from the Options men u .  The Ins ta l l  Appl icat ion d i alog box 

displays. 

2. S e l e c t  the Boot Statu s :  A u t o  box .  ( To restore normal  boot s t a t u s  t o  an 

application installed to autoboot. selecrt he Boot Status : Normal box. )  

3 .  Select the appropriate Application type box. 

4. Select Instal l  or press [ Return ] .  

Remember t o  use Save Desktop t o  save the selected boot status,  otherwise i t  
w i l l  b e  erased when you switch off the computer. 

I nstal l Devices 

The I nstal l Devices command install s  desktop icons for al l  hard disk partitions on 
a l l  properly configured dev ices. It also installs a cartridge icon if  a cartridge is  i n  
the cartridge s lot during startup. 

Use the following steps to instal l devices:  

1 .  From the Options menu select I nstal l  Devices. Icons for a l l  configured dev ices 

appear on your desktop. Each icon has a unique drive identifier letter, and each device 

icon is labeled DEVICE. 

Note: You can change the shape of your desktop icons. See Install Icon in 

this chapter. 

2. Use the mouse to place the desktop icons where you want them to appear. 

Select  Save Desktop from the Options menu .  The Save Desktop Dia log box 

displays. Select OK. 
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The Save Desktop command saves your desktop configuration in  a fi le cal led 
NEWDESK .l N F. This file stores information about wh ich icons have been 
instal led and the location of each icon on the desktop. See Save Desktop in  th is  
chapter. 

Remove Desktop Icon 

If you w ish to remove an icon from the desktop, fol low these steps: 

1 .  H ighl ight the icon you wish to remove. 

2. Select Remove Desktop Icon from the Options menu. The icon disappears from 

the desktop. 

Note: If the highlighted icon represents a data or application file , a dialog box 

displays and asks you whether you want to delete the file or just remove the icon . 

Remember, the information stored on the logical drive represented by a removed 
hard disk icon is st i l l  on the hard d isk .  To regain access to that information, you 
can: rei nstal l a hard disk icon for that logical drive, or press [AIt ]  and the drive 
letter. 

Set Preferences 

The Set Preferences option lets you choose from a variety of different screen
color options.TOS automatical ly detects which modes are compatible with your 
moni tor, and displays the avai l able choices. TOS wi l l  not you select an 
incompatible screen-color mode. Set Preferences also lets you select mon itor 
resolutions, and whether or not you wish to have alert boxes d isplay during copy, 
move, delete, and fi le overwrite operations. 

When you select Set Preferences, the Set Preferences dialog box appears. 
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The Set Preferences dialog box offers a ful l  range of screen-color options for 
several types of monitors. Us ing the Set Preferences Dialog box al lows you to 
choose a mul t i tude of screen-colors and resolut ions.  Proper use of the sett ings 
described below w i l l  a l low you to get the best d i splay on your monitor. 

N u m ber of Colors Let s  you choose between severa l  d i ffere nt  screen -color 
options.  When choosing a sett ing remember that the screen takes longer to redraw 
when it  d i sp lays more screen-colors. 

Number of Columns Al lows you to set the w idth of the screen disp lay to 40 or 
80 characters. 

Double li nes/ Interlace Disp lays more l i nes  on some disp lays and prov ides 
interlace on others. 

Compatib i l ity Modes Al lows you to cal l up another d ia log box wh ich  a l lows  
you to  select from a l i st of several d i fferent screen resolutions and other options.  

Read . I N F  File 

You can have more than one desktop information file o n  your system, each 
contain ing d ifferent informat ion ( such as instal led desktop icons and their 
placement, and a l l  View and Options menu options) .  The Read . I NF Fi le 
command al lows you to change to a different desktop env ironment without 
having to transfer files or reboot .  

The default  NEWDESK . I N F  fi le  i s  i n  the root directory drive C.  You can name 
the alternate desktop information fi les  anyth ing you l ike, but the three character 
extension must be . IN F. 

With  the Read . INF Fi le command, you instruct your Atari computer to read 
information from a spec i fied al ternate desktop information fi le .  
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Foll ow these steps to use the Read . l N F  Fi le  command: 

1 .  Select Read . I N F  Fi le from the Option men u .  The Select an INF File d ial og box 

displays. 

2. Display and h ig h l i gh t  the a l ternate desktop i n formation fi l e .  Select OK, or press 

[Return ] .  The new information is read into your computer. 

Note : IlYou wish to save the current NEWDESK.lNF file hefore using the 

READ.INF command, simply change the name of the current file NEWDESK.lNF 

file . This allows you to save your desktop without losing your current setup. 

Desktop Configu ration 

With  the Desktop Configuration dialog box you can  set the default directory and 
i nput parameters for a l l  appl ications, scrol l through assigned function keys, and 
assign a s ingle keystroke to various menu commands. The Desktop Configuration 
dialog box also d isplays the amount of RAM currently avai lable.  

Most appl ications use the default directory and i nput parameters d isplayed i n  the 
Desktop Configuration dialog box. The exceptions are appl ications that have been 
assigned their own speci fic  default  d irectory and input parameters through the 
Instal l Appl ications dialog box. You can find detai led information regardi ng 
setti ng the default d irectory and i nput parameters under Install Applications in  
this chapter. 

You can use the Function-keys Assignment to display the ful l  pathname of each 
program that has an assigned function key. U se the right and left scrol l  arrows to 
disp lay h idden parts of the pathname, and the up and down arrow keys to scrol l  
through the assigned function keys. 

All menu commands can be assigned a keystroke. This enables you to bypass the 
menu bar and init iate the command by pressing a s ingle key. 
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Use the Define S ingle Keystroke up and down arrows to scrol l  through the menu 
commands and the i r  keystroke assignments. To change the keystroke of a 
displayed menu command, type in the desired keystroke . To clear a l l  menu 
command keystroke assignments, select Clear Al l .  

After making changes to the Desktop Configuration dialog box,  select OK to 
confirm your choices. Use Save Desktop to save your selections, or they wi l l  be 
erased the next t ime you switch off your computer. 

Save Desktop 

You can rearrange the desktop icons and windows to suit  your personal 
preferences and use the Save Desktop option to save the new arrangement. For 
example, you might want to move the trash can icon, l ine up the disk icons 
horizontal ly ,  or have the startup screen display several open directory w indows.  

Save Desktop also saves Opt ion and View menu selections. The computer stores 
saved configurations and menu selections in a N EWDESK . I N F  fi le and places 
this fi le  on your startup disk or hard disk drive root directory. 

Arrange disk and trash can icons by draggi ng them to new posit ions on the 
desktop. You may want to c lose all w indows first to start with a clean desktop. 

How you arrange your desktop w i l l  depend on your needs, but i t ' s  usual ly a good 
idea to place the trash can icon away from the disk drive icons to protect against 
uni ntentional ly dragging fi les to the trash can instead of to a disk or logical drive 
icon. 

Arrange directory windows on the desktop by opening,  moving, and s iz ing 
selected w indows.  You can have up to seven directory windows open at once on 
the desktop. Select opt ions from the View menu to determine how w indow items 
(folders and fi les) are shown ( as text or as icons) and sorted ( by name, date, s ize, 
or type ) .  
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I f  you show window items as text, you may want to narrow the windows to show 
only the i tem ' s  name and extension. 

If you leave the windows open when you save the desktop, those windows w i l l  
open t o  the same s ize and pos it ion the next t ime you switch  o n  the computer. The 
window which i s  in  the foreground when you save the desktop w i l l  be the 
foreground window the next time you switch on the computer. 

The s ize and posi t ion of c losed windows i s  also saved when you select Save 
Deskt o p .  The next  t i me you open the w i ndow,  it w i l l  open to the s i ze and 
posit ion i t  occupied on the desktop the last t ime it  was opened. 

Desk Accessories 
The Control Panel i s  a desk accessory that comes with your system. 
The fol lowing section describes the control panel and its uses. 

The Contro l  Panel 

The Control Panel coordinates many smaller programs called control pane l 
extensions (CPXs) .  The in it ial  Control Panel screen displays the names of a l l  
currently loaded CPXs. You can open a CPX by pos i t ioning the pointer over the 
desired CPX and double c l icking.  

The Control Panel also contains a drop-down Options menu. When no CPX i s  
h ighlighted, the Options menu d isp lays two menu choices: About and Setup. Two 
addit ional Options menu choices d isplay when a CPX name in the main Control 
Panel w indow is h ighl ighted. The three addit ional options are Open CPX, CPX 
Info, and U nload CPX. 
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To select an option, pos i t ion the pointer over the Options menu. Then cl ick the 
mouse button. The Options menu displays. Move the pointer unt i l  the desired 
option highl ights .  Cl ick the mouse button to select the h ighl ighted option .  

Whenever you open a Control Panel o r  CPX window ,  you are usual ly given the 
fol lowing options : Save, O K ,  or Cance l .  Cl ick ing on the close window box is the 
same as selecting OK and then c losi ng the Control Panel .  

Selecting Save places the currently d isplayed sett i ng i nformation in  a fi le o n  the 
startup disk. Your Atari computer reads this file during startup and load in the 
saved settings. Select OK if you j ust wish to change a sett ing for one session. The 
Control Panel window closes, and the changes remain in  effect only unt i l  you 
switch off your computer. The most recently saved set t ings w i l l  be in effect then 
next t ime you swi tch on the computer. 

Selecting Cancel al ways returns you to the mairi Control Panel w indow. 

About. . .  

When you select About, Control Panel information (such as version n umber and 
copyright date ) displays . 

Setup . . .  

You can use the Setup dialog box to change a CPX's status (act ive/inact ive ) ,  
reload CPXs w ithout restarti ng your computer, set the  amount of memory 
reserved for basic CPX information, and des ignate a CPX directory path. You can 
also use the calendar and c lock to set the computer's t ime and date. 
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General  Setup 

Acce l erator 

Sound Setup 

Figure 4-2 . The Control Panel 

Date and Time 

The computer uses the date and time to mark i ndiv idual fi les with the date and 
time they were created or rev i sed. This feature is usefu l  when you want to 
determine which fi le was most recently changed or created. 

You can use 1 2/24 Hour Time to set the Control Panel clock to 1 2  or 24 hour 
t ime. Thi s  does not affect the way fi les are dated, only the way the time i s  
displayed in the Control Panel w indow. To set the  clock or  calendar, fol low these 
steps:  

1 .  Open the Control Panel.  Select Date or Time by pos it ioning the pointer over the 

desired selection and c l icking the mouse button. 

2. Press [Left Arrow] to position the cursor in the window, or press [Backspace] or [Esc] 

to erase the window. [ Backspace] erases the characters in the window one character at 

a time. [Esc] erases the entire window. 

3.  Type in the desired t ime or date. 

4. Cl ick on the new t ime or date. 
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To change between 1 2  and 24 hour t ime,  posit ion the pointer over the selection 
box to the left of the word Time. Click the mouse button. B oth the 1 2  and 24 hour 
selection boxes display. Move the pointer until the desired box is highl ighted. 
C l ick the mouse button again .  

CPX Mover and Reload CPXs 

Only active CPXs are loaded during startup. Al l  active CPXs appear in the main 
Control Panel Window. If  you need to lise an i nactive CPX, YOll can use the CPX 
Mover to change the status of the CPX from inactive to active .  Then when YOll 
select Reload CPXs, the newly  act ive CPX displays i n  the main Control Panel 
w indow. 

You can also remove a CPX from the main Control Panel Window by changing 
the status of the CPX from active to inactive. 

To change the status of a CPX, fol low these steps: 

1 .  Open the Control Panel. Select Setup from the Options menu. 

2. Select the CPX Mover. The CPX Mover window appears. 

Figure 4-3. The CPX Mover Window 
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3.  Select the desired CPX by posit ioning your pointer over the name of the CPX and cl icking, 

The CPX highl ights, and the appropriate operation appears in  the Move box ,  

Note: You can select multiple CPXs for the move CPXs operation. Use shift
clicking or rubber banding to highlight more than one CPX. If you use rubber 

handing,  the ruhher band box lVill not actually appear, but it still works the 

same way. 

4. Select the operation by cl icking in the Move box. 

If you have transferred a CPX from i nactive to active status, you must reload before 
you can use the CPX. To Reload CPXs, fol low these steps :  

1 .  Open the Control Panel .  Select Setup from the Options menu. 

2. Select Reload CPX. When the confirmation dialog box appears, select OK. 

Advanced Setup Options 

Setting the  M inimum Number of S lots and the  CPX Directory Path are advanced 
features of the Setup dialog box. You w i l l  probably use these options infrequently.  

Minimum Number Of Slots 

CPXs are stored i n  an external memory device (hard disk or floppy disk) .  During 
startup or reloading,  only basic information about each act ive CPX ( such as the 
CPX ' s  name and icon) is  loaded into RAM , When you actual ly  open an active CPX, 
the bulk of the file is then loaded i nto RAM so you can use the CPX. When you c lose 
the CPX, the fi le  i s  erased from RAM unt i l  the next t ime you open it 

Note: CPXs with Resident status do not follow the above pattern , bllt are copied into 
RAM at startup time. 
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Your Atari computer has to know how much RAM to reserve for CPX basic 
information.  When you set the M i nimum Number of S lots, you are tel l ing the 
computer to reserve enough RAM to be able to store basic information for that 
number of CPXs. I f  the number of active CPXs at startup time exceeds the Min imum 
N umber of Slots,  your computer reserves enough RAM for that number of CPXs. You 
can select from 5 to 99 s lots. 

To change the M in imum Number of S lots, fol low these steps: 

1 .  Open the Control Panel . Select Setup from the Options menu.  

2. U se the scrol l  arrows to display the desired number of slots. Select OK or Save. 

CPX Directory Path 

The CPX Directory Path tel l s  the Control Panel where to look for CPX fi les. You 
probably want to store all of your CPX fi les in  one folder, and set the directory path to 
that fol der. 

But if  you store CPX fi les in  more than one p lace, the CPX Directory Path must be set 
to the directory that contains the CPX fi les you w ish to use. 

Note: If the CPX Directory Path is too long to display in the box, use the left and right 

scroll arrows to display the hidden sections of the path. 

To change the CPX Directory Path, fol low these steps :  

1 .  Open the Control Panel. Select Setup from the Options menu .  

2. Click anywhere o n  the C P X  Directory Path box. The F i l e  Selector displays. 

3. Use the File Selector to select a new path .  When you open a directory, the d irectory name 

is added to the File Selector' s  Directory l ine. When the desired directory path is  d isplayed, 

select OK. The new path appears in the CPX Directory Path box. 
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Open C PXs . . .  

You can open a CPX by first highl ighting the CPX on the Control Panel main 
window, and then selecting Open CPXs from the Control Panel Opt ions menu. You 
can also open a CPX by double cl icking on i ts  box in the Control Panel main  window. 

C PX I nfo . . .  

When you highl ight a CPX and then select CPX Info from the Control Panel Options 
menu, the CPX I n fo window displays.  The w i ndow conta ins  the selected CPX ' s  
fi lename, version number, I D  number, and Re�ident/Non Resident status.  

F i lename i s  the CPX ' s  actual fi lename as i t  appears on the disk .  Version and ID are 
assigned by the CPX ' s  programmer. Two versions of the same CPX can have the 
stlllle ID number. I n  this case, only the most recent version is loaded. 

If you have several versions of the same CPX, you can look at the version number to 
determine which i� the most recent vers ion. 

You can use Configure CPXs ( see Configure C PXs i n  this  chapter )  to change the 
res ident stat us of a CPX. You probably want most of your CPXs to have Resident :  No 
status.  This means the bulk of the program is stored in e x ternal mcmory ( hard or 
flopp)' d isk)  and only read into RAM when you open the CPX. 

But if you have a CPX that you use frequent ly , you Illay wal l t  t o  g i ve i t  Re� ident : Yes 
, tatus .  CPXs that have a Resident :  Ye� status on startup  arc read d in:et l y  in to RAM 
and remain there unt i l  you switch off the  computer. Rc�ident CPXs run  a bit  more 
qu ick ly .  but may lake up a great deal of R A M .  

Note : When you change a CPX ' s  status 10 Residenl : Y('s .  the .1 1e/IIIS chw/ge docs nol 

ICIk(' effecl I Inlif Ihc /lexl lime you slCln YOII{" s \'slem. The 01//1' limc a CPX cal/ he 

inslalled inlo RAM with Residenl status is during startlll}. /1/ Ihe sante wa r. c/tanging 

a CPX ' s status ro Residcnl:  No stalus does 1101 a( " / /wlll" {"flI I O \'e it /i'otl/ RA M IIlIlif rou 

switch off you,. 5 Vsll'm.  

A Guided Tour of the Desktop 4-33 



Falcon030 Owner's Manual 

U n load CPX . . .  

Unload CPX does not change the status of the CPX to i nact ive. I t  s imply removes a 
CPX from the CPX l i st on the Control Panel main window. You can use Reload CPX 
to place the CPX back on the l i st .  

Note: You cannot unload a resident CPX. 

C PXs 
This section provides a general description of the CPXs that come with your 
Atari computer. As CPXs are constantly bei ng improved for your benefi t ,  the 
descriptions contained in th is  section may not correspond exactly to the CPXs that 
ship wi th your system. 

General Setu p 

The General Setup CPX al lows you to set the keyboard response and repeat rate, the 
mouse double c l ick response rate, and the audio feedback. It also allows you to toggle 
on and off options, such as CPU Cache, Sound, and B LiTTER and display system 
statistics such as the TOS version number and amount of avai lable RAM.  Options are 
selectable through buttons, s l iders, and pop-ups. The General Setup CPX is s l ightly 
different for each system. Fol lowing is  a description of the General Setup CPX. 

Status 

Select the  Status box to di splay the TOS version number, version date , and total the 
number of avai lable bytes .  
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Audio Feedback 

The computer has two kinds of audio feedback, a c l ick signali ng each keystroke and a 
bel l  signal ing keyboard or mouse errors. To control audio feedback, select the key top 
button or the bell  button. A gray image means that the sound has been turned off. A 
clear i mage means that sound is turned on. 

C hip Select 

The Chip Select feature al lows you to choose among the B l i tter and/or Cache options .  
Cl ick on t he status box below Chip Select .  The current selection is indicated in the 
pop-up by a checkmark. To change the current  selection, move the pointer unt i l  the 
desired selection h ighl ights, and c l ick on that selection. That setting becomes the 
current selection and the pop-up c loses. The new setti ng is displayed inside the 
shadowed status  box .  

Sound 

If you want a l l  sound turned off, posit ion the pointer over the Sound button. Click the 
mouse button. Move the pointer until the word Off h igh l ights, and c l ick the mouse 
button again .  

Keyboard Response 

Every key on the computer keyboard responds when pressed, and every key (except 
[Shift ] ,  [Control ] ,  [Esc],  [Caps Lock] and [A l t ] )  repeats its character if held down .  
The keyboard repeat controls how much t ime i t  takes for the keys to repeat when they 
are pressed, and how quickly they repeat after the repeat process begins .  

The upper sl ider controls how soon a key starts to repeat. Moving the s l ider to the left 
makes the keys repeat sooner. Drag the s l ider to the desired position, then release the 
mouse button .  
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The lower s l ider controls the speed at which the keys repeat. Move the s l ider to the 
left to make the keys repeat faster. Drag the s l ider to the desired position, then re lease 
the mouse button. 

Test the new settings by turning the sound on, if  required, and press ing [ Space B ar] . 
You should hear a c l ick each time you press the space bar. Li sten to the c l icks to 
judge the repeti tion speed of the keyboard. 

Double-Cl ick Response 

You can  adjust your Atari computer ' s  response to  double cl icking. To s low the 
computer's  response to double-c l icking, al lowing you to double-cl ick more s lowly,  
select a numbered box nearer to the rest ing mouse icon . To qu icken the com- puter's  
response to double-c l icking ( for fast double-c l icks) ,  se lect  a numbered box nearer to 
the running mouse icon. 

After setting the double-cl ick response, you can test the sett ing by double-c l icking on 
the Double-Cl ick Response Test box . When you double-cl ick at the set rate or faster, 
the box w i l l  briefly highl ight. 

Modem Setup 

The serial port( s )  o n  the computer are type RS232 serial ports . B y  connecting a 
modem to a serial port, you can communicate with other computers. You can also 
connect a seria l  printer or any other RS232 device to the serial port( s ) .  

The Modem Setup CPX le ts  you  configure the  computer 's  serial port ( s )  to  work with 
your modem or other serial  device. Refer to the manual suppl ied with your peripheral 
for specific information on which paramerers to choose. The parameters needed by 
the computer w i th which you are communicating ( the remote device) i s  known as the 
communications protocol . 
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Serial Port Selector 

The Serial Port Selector al lows you to te l l  the computer which of the avai lable serial 
ports to recognize as active. Select the port you are us ing for the connected modem. 

Baud Rate 

B aud rate is the speed at which data is  transmitted. Baud, the standard un i t  measure of 
transmission speed, i s  the number of signal elements per second.  The fastest rate 
avai lable to you i s  1 9,200 baud; the slowest is 50 baud. Set the baud rate to 
accommodate both your modem and the remote computer's modem. (The baud rate 
for bul let in board systems is usual ly l i sted along with the phone number for the 
board . )  

To  set the  baud rate, posit ion the  pointer over the  Baud Rate box. C l i ck  once and a 
pop-up appears. Use the up and down arrows to scrol l  through the baud rate 
selections.  When the desired baud rate displays, move the poin ter to highl ight the 
desired rate. Cl ick the mouse button to select the highl ighted rate. 

Parity 

Whenever computers transmit data through telephone l i nes, there is a chance that 
some of the information w i l l  become garbled due to imperfections and noise within 
the l ines. Pari ty i s  a error checking procedure that  computers use to exam i ne 
i nformation and determine whether data was c leanly transmitted. 

The parity bit  is added to a group of bits to make the total number of bits transmitted 
odd or even . Transmission errors can be identified when the number of bits in a group 
does not match the parity chosen (odd or even) .  Depending on the modem and the 
remote dev ice, you w i l l  choose e ither None, Odd, or Even parity. ( Refer to the manual 
supplied with your modem for specific information .) 
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To set the parity, position the pointer over the shaded Par i ty box . Cl ick once and a 
pop-up appears. Use the pointer to highl ight the desired parity.  Click the mouse 
button to select the highl ighted option. 

Bits/Char 

Each character i s  stored in  memory as  one  byte. Usual ly a byte i s  made up  of  e ight 
bits.  Depending on bits per character used by the remote dev ice, you may need to 
change the number of bits per character when transmi tt ing through the RS232 port. 

To set the b its/char, posit ion the pointer over the shaded B its/Char box . Click once 
and a pop-up appears. Use the pointer to highlight the desired number of bits per 
character. Cl ick the mouse button to select the highlighted option. 

Stop Bits 

The stop bit  i ndicates the end of an asynchronous RS232 character. You normally use 
I stop bit ,  but you may need to use 1 .5 or 2 stop bits. To set the number of stop bits, 
position the pointer over the shaded Stop B i ts box. Click once. Use the pointer to 
high l ight the desired number of stop bits .  C lick the mouse button to select the 
highl ighted option. 

Flow Control 

You can choose between two flow-control protocols :  Xon/Xoff, and Rts/Cts. Flow 
control protocols are procedures that allow your computer and the remote dev ice to 
signal one another when to start or stop sending information. Choose the flow control 
supported by the remote modem. 

To select a Flow Control protocol, posit ion the pointer over the shaded Flow Control 
box. Click once. Use the pointer to h ighlight  the desired flow control protocol . Cl ick 
the mouse button to select the highl ighted option. 
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Printer Setup 

Any program may access the printer configurations set b y  the Printer Setup CPX. For 
example, the Print Screen option under the Options menu uses the printer setup 
information. Other ut i l it ies or applications may not. Check the manuals supplied with 
your programs to see i f  a program can use the printer setup information. 

Note: You cannot configure an A tari SLM laser printer with the Install Printer dialog 
box. Instead, refer to the Atari SLM Printer User' s  Manual (supplied with the SLM 
laser printer) for instructions on changing printer settings. 

If you have both an SLM and dot-matrix or daisy wheel printer connected to your 
computer you may be able to select the printer type within your application. I f  not , 
you must turn off one of the printer driver programs. 

To configure your printer, display the Printer Setup CPX window. Posit ion your 
pointer over the shaded box representing the sett ing you wish to change. Click the 
mouse button. Move the pointer over the desired setting. When the sett ing highl ights, 
click the mouse button to select the highl ighted setting. 

Printer Type 

The choices are Dot (dot matrix printers) and Daisy (daisy wheel printers) .  Select the 
appropriate box for your printer. 

Color 

The choices are B /W  (duochrome ) and Color. Select the appropriate box for your 
printer. 
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Pixels/Li ne 

Only dot matrix graphics printers use t h e  Pixel s/L ine option . Pixel means picture 
e lement. On dot matrix printers, a pixcl  is a dot. Dot matrix printers print a certain 
number of pixels per l ine when print ing in graph ics mode . If you have an Atari dot 
matrix graph ics printer, select 1 280. If you have an Epson , or Epson-compatible dot 
matrix graph ics printer, select 960. Both values assume an eight-inch printed l ine. 

Qual ity 

Only dot matrix printers use the Qual ity option. Select Draft for draft-qual i ty print ing.  
Se lect Final  for letter or near-letter qual i ty printing. 

In Draft mode, the printer may make only one pass of the print head when print ing.  
For darker print ing,  select Final .  Keep in  mind that in  Final  draft mode the printer 
genera l ly makes two passes of the print head, thus taking twice as long to print  the 
page. 

Note: Do not select Final if your printer does not support near·/etter quality printing. 

Paper 

If  your printer feeds" paper automat ically by means of a tractor or s ingle-sheet feeder, 
select Feed. If your pri nter accepts only a sheet at a t ime which you must insert 
manual ly ,  select Single. The S ingle option prevents the printer from printing beyond 
the end of a page on documents longer than a s ingle sheet. 

Port 

If you have a paral le l  printer, select Printer. Paral lel  printers connect to the port 
marked Printer on the back of the computer. If you use a serial printer, select 
Modem .  Seria l  prin ters connect to the port marked Modem ( the RS232  port) on the 
back of the computer. 
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Note: For most serial printers, XonlXoffflow control is set to On. This setting enables 

the printer to signal the computer to temporarily stop sending data so it can print 

data it has already received. (See RS232 Configuration earlier in this chapter. )  

Color Setup 

Depending on your moni tor type and the screen resolut ion you have selected, u p  to 
256 colors canbe used for drawing at one t ime on your screen. 

You can choose the colors you wish touse from a palette of avail able colors. 

Note: Not all A tari computers are capahle of displaying all the resolutions descrihed 
in this section. Check your system's hardware specifications to find out which 

resolutions it is capahle of displaying. 

Color Setup allows you to choose which colors from the color palette you wish to 
have available for use when you assign w indow colors. See W indow Colors i n  this 
chapter. 

Th ink of the color palette as a col lect ion of inks.  The Color Display Box can display 
up to 1 6  colors at a t ime ( th is  does not l imit  the number of colors your system i s  
capable of  d isplay ing) .  

Modi fy any pen color according to your personal taste by using the fol lowing steps: 

1 .  Select one of the available pens by moving the pointer over the desired pen and cl icking the 

mouse button. 

2. Use the RGB scroll bars to add or subtract a color from the pen .  Changing the ratio of Red, 

Green, and B l u e  w i l l  change the color of the h igh l ighted pen. Repeat Steps I and 2 for 

every pen you want to modify. 

3. After you modify the color palette, select Save to permanently save the palette, OK to 
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select and use the new palette unt i l  you switch off the system, Cancel to exi t  the Color 
Setup CPX and return to the Control Panel menu ( no changes are saved) ,  

or  Reload to  display the  most recently saved defaults. 

Note: If you are setting colors while in the True Color mode, you wil/ notice a 
blending effect as you move the R ,C ,  and B control hars. This is normal, hecause the 

True Color mode does not redraw every occurance of a particular shade, when that 

shade is altered. 

Note : You can restore the currently displayed color to the condition it was in before 
you opened it by pressing [ UNDO} , or selecting reload. 

True Color 

The True Color mode al lows your system to display thousands of colors, whether you 
are using an ST, VGA, or telev i s ion as a display.  

True color mode displays such a wide range of colors that some images displayed in  
True Color have a near photographic qual i ty .  

Sou nd Setup 

The Sound Setup al lows you to adjust the vol ume of the CD qual i ty sound output, and 
the microphone input .  U se the s l iders to adj ust the sound output to headphones or 
speakers. 

Window Colors 

Window Colors al lows you to assign colors and/or patterns to d ifferent e lements of 
desktop w indows, depending on which type of disp lay your system uses. 
You can assign colors a nd/or patterns to each e lemen t  i n  a l l  foreg ro und and 
background w indows. 
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Even though the color palette contains thousands of colors, the number of available 
colors depends on the selected resolution of the display (on certai n  mode l s )  and 
w hether the display ' s  output is color or duochrome. Refer to the hardware appendices 
for the exact resolut ion(s)  and color(s) your computer is capable of d isplaying. 

You can choose several options (e.g.,  border, text, and fi l l )  for each w indow e lement. 
B order allows you to choose the color of the narrow border that sur- rounds each 
w indow element .  Use Tex t  to choose the color of any text or icon ( as in the case of 
the Ful l  box) that appears with in the selected window element. Fill i s  the background 
color of the selected e lement, and you can also choose one of the eight fi l l  patterns 
appearing directly under the F i l l  scrol l bar. The fi l l  color appears in the selected 
pattern. 

The Mode box allows you to toggle between having text appear directl y  on the fil l  
pattern , and having text appear wi th in  a sol id background over the fi l l  pattern . When 
you assign element colors to the foreground window and select Save 
or OK, the new colors are displayed the next t ime you open a window. Any window 
that is already open does not reflect the new foreground w indow e lement colors. 

Before you assign window element colors, choose the color set you w ish to use. You 
can: use the factory assigned defaul t  color set, press a function key ( l  through 1 0) to 
use a Window Colors preassigned color set, or use Color Setup to create a custom 
color set. Use the fol lowing steps to assign foreground and background w indow 
element colors: 

1 .  Select a window element for color assignment. A box outlines the selected element. 

2.  Click and drag the appropriate scro l l  box to assign Border, Text, and F i l l  colors to the 

highlighted window element . C lick on the desired Fill Pattern. 

3.  Select the desired Mode. Repeat steps I through 4 u n t i l  al l the desired colors have been 

selected. 

4. Choose Save to permanently save the selected window element colors, OK to select and 

use the current colors and/or patterns unt i l  you switch off the computer ( the next t ime you 
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start the computer, the most recently Saved colors and/or patterns appear., Select Cancel 
to exit  Window Colors and return to the Control Panel menu (no changes are saved). 

Configu re C PXs 

Configure CPXs al lows you to change the name, choose the d i splayed text and icon 
color, and change the RAM resident status of CPXs. 

To configure a CPX, you must first d i splay the name of the desired CPX in the name 
l ine .  U se the left and right scroll arrows to scrol l  through the CPX l ist .  

When the Configure CPXs w indow d isplays, the text insertion cursor i s  already 
posit ioned at the end of the CPX Name l ine. 

To change the name of the displayed CPX, press [Esc ] to c lear the entire Name l ine, 
or press [ Backspace] to erase one character at a t ime. 
Then type in the new CPX name. 

To select text and icon colors, use the appropriate scroll arrows to display the 
avai lable colors and/or patterns. The name and icon shown on the Name l ine displays 
the color or pattern selection. 

You can also set the RAM res ident status of the selected CPX. Posit ion the pointer 
over the shaded RAM res ident box and c lick  the mouse button. A pop-up appears. 
M ove the pointer to highl ight the desired status. Cl ick the mouse button to save the 
highl ighted selection. 

When the desi red text/icon color selection displays, and the desired RAM res ident 
status is selected, c l ick on OK or Save. 

Note: RAM resident status takes effect only at start up time and when you change 

resolutions. 
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Accelerator 

The Accelerator CPX al lows you to adjust  the speed at which the on-screen pointer 
responds to the movement of your mouse. The Accelerator also contains a screen 
saver. 

There are three mouse Accelerator sett ings:  Off, Fast, and S uper Fast .  Choose Off i f  
you d o  not w i sh to increase the response speed o f  the pointer. Select Fast o r  select 

Super Fast to i ncrease the pointer response speed. 

To select a new pointer response speed, posi t ion the pointer over the desired setting 
and c l ick the mouse button. 

The Screen Saver automatical ly  darkens the screen after a set period of inactiv ity .  To 
activate the Screen Saver, select the Screen Saver box. When the Screen Saver is 
act ive,  the Screen Saver Delay s l ider and the Modem Recognit ion icon appear as sol id 
objects on the screen. When the Screen Saver i s  inactive ,  the Screen Saver Delay 
sl ider and the Modem Recognit ion icon appear as outl ines. 

When the Screen Saver is act ive,  i t  automatical l y  darkens the screen after a period of 
mouse and keyboard inactiv i ty .  You can set the number of m inutes of inactivity in 
two ways. You can use the c lock icons on e i ther s ide of the Screen Saver Delay s l ider 
as scro l l  arrows, or you can drag the scro l l  bar. Release the mouse button when the 
desired number di splays in the scro l l  bar. 

M odem Recognit ion a l lows you to choose whether or not you want the Screen Saver 
to recognize modem act iv ity. If  the Modem Recognit ion i s  on, the Screen Saver 
recognizes modem act iv i ty and w i l l  not activate . I f  the Modem Recognit ion is off, the 
Screen Saver ignores modem act iv i ty and act ivates after the set delay period of 
keyboard and mouse act iv ity has passed. 
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5 Desktop Management 

Worki ng with D i rectories ,  Folders ,  
and Fi les 
Directories and folders provide a way t o  group files together for organization and 
storage. Maintain ing an organized folder and directory structure helps you locate 
files and creates an efficient working environment, both for you and for your 
computer. 

A collection of information grouped together is  cal led a fi le. A program or 
application fi le  contains instructions for the computer. A data fi le contains 
infonnation to be used or edited by the program or appl ication. 

Identifyi ng a D i rectory ,  Folder,  or F i le  

The root directory i s  the first directory displayed when you open a disk icon. When 
you open a root directory, only the Disk Identifier and file mask appear in  the 
window ' s  move bar. For example, the move bar of the root directory of drive A 
would display the fol lowing: 

A:\* . *  

Desktop Management 5-1 



Fa/con030 Owner's Manual 

When you open a folder, the folder 's  name is added to the move bar. If you opened 
a fol der cal led LETTERS that resided in the root directory of drive A, the move bar 
would display the fol lowing: 

A:\LETTE RS\* . *  

Displaying a D i rectory or Folder 

You can view the contents of a directory o r  folder by opening the icon, displaying 
i ts contents. 

To open a directory or folder, position the pointer over the desired icon, then 
double-cl ick the left mouse button or h ighlight the desired icon and select the 
Open command from the Fi le menu .  Once the w i ndow displays ,  you can select 
other fi les and folders from the list .  

Directories and folders contain data fi les, program fi les, and other folders. If you 
have a number of related fi les, you can place them inside one folder to keep them 
together. You can also put folders and fi les within other folders. You can create a 
folder using the Create Folder command. ( See File Menu, in 
Chapter 4, A Guided Tour of the Desktop.)  

Fi les and F i lenames 

There are two types of fi les. Executable fi les (also cal led programs or applications) 
contain instructions for the computer to carry out. Most of the time the instructions 
contained in executable fi les are used to work with information in data fi les.  A data 
fi le is a collection of information that contains no instructions fot the computer. 
You can place fi les in root directories and folders. If  you choose to display your 
folders and files as icons ( see View Menu, in  Chapter 4, A Guided Tour of the 
Desktop. ) ,  you wi l l  have as many icons in  a directory as you have folders and fi les 
in  that directory. The name of the fi le or folder wi l l  display under its icon. 
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Fi lenames and Extensions 

Files are identified by filenames. You can (must )  name the files you create, and you 
can change the names of ex isting fi les. 

The filename is  made up of two parts: the name and an optional three-character 
extension. In the following example, the name is SAMPLE and the extension i s  
.PRG. 

SAM PLE.PRG 
1 1 
1 extension (optional ; a period ( . )  and up to three characters) 
1 
name (mandatory ; up to eight characters) 

The fol lowing characters cannot be used within a file name or extension: 

Period ( . )  
Quotation Marks 
Forward slash (/) 
Back slash (\) 
Brackets ([ or ] )  
Vertical Break Bar ( I  ) 
Less-than Symbol « )  
Greater-than symbol (» 
Plus Sign (+) 
Colon ( : ) 
Semicolon ( ; )  
Comma ( , ) 
A�terisk (* ) 
Question Mark (?) 

Filenames usually refer to the i nformation contained i n  the file,  such as TAXES for 
tax information, or T AXES90, T AXES9 1 ,  and T AXES92 for a series of tax 
information files .  
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Some files must have specific extensions. For example, the .PRG extension tel l s  
your computer that the file i s  an  executable GEM application. If you remove the 
extension .PRG from the filename, the computer w i l l  not recognize the fi le as an 
application. 

Appl ications often use a specific fi le extension. This extension is  automatically 
assigned to any file the appl ication creates. For example, word processors often use 
. DOC or .TXT as an extension for documents. See the documentation suppl ied 
with the appl ication for more information. 

Each of the fol lowing executable file  types has a unique fi le extension by which it 
can be recognized. These extensions should be used only for executable files:  
.PRG, .TTP, .TOS, .GTP, .ACe, and .APP. Files with any of those extensions 
cannot be opened i f  the extension i s  deleted or changed. 

These six extensions and their defin i t ions are l i sted below: 

.ACC A GEM Desktop accessory. The system accesses .ACC fi les which appear 
under the Desk menu. Use accessories by selecting them from the Desk menu. You 
can have up to six active accessories on the system at a t ime . 

. APP A GEM application. An .APP fi le is a GEM application and wi l l  usual ly 
take advantage of the GEM environment by us ing windows, icons, and drop-down 
menus . 

. GTP A GEM-Takes-Parameters appl ication ( see .TTP) 

.PRG GEM appl ication. ( See .APP. ) 

.TOS A TOS application. A .TOS fi le  i s  a non-GEM appl ication. I t  does not use 
the GEM environment and may not even use the mouse . 

. TTP A .TTP (TOS-Takes-Parameters) application. A .TTP file i s  a .TOS fi le that 
expects some typed parameters (data that wi l l  control the program 's operation) .  
When you open a .TIP fi le, an Open Appl ication dialog box appears requesting you 
to enter some parameters. Consult the .TTP program ' s  documentation for more 
information. 
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Note: When you sort files by type, they are arranged alphabetically by their 
extensions. 

Pathnames 

A path name tell s  the computer where to find a fi le or folder. Path names begin with 
the appropriate drive identifier, and then l i st each appl icable folder, starting with 
the folder residing in the root directory (e .g . ,  A:\ or B :\ etc . )  and ending w ith the 
folder that contains the fi le  or folder. 

The final element of a path name is the name and extension of the fi le or folder. The 
move bar displays the complete pathname of the displayed fi le or folder. 

Let 's  bui ld an example. You have a fi le in  drive A which contains all 1 992 sales 
and marketing reports for all sales regions. But you are interested in finding the 
July 6th sales report from the western sales region. 

First you open the disk icon for floppy drive A.  A window opens, di splaying drive 
A's  root directory. The move bar displays only the drive identifier and fi le mask. 
The fi Ie mask i s  the * .  * fol lowing the backslash: 

A:\* . *  

Note: For a full explanation offile masks, please refer to Set File Mask. The 

asterisks in the file mask above are known as wild card characters. Wild card 

characters are explained in the section on File Specification in this chapter. 

One of the items in the displayed root directory is a folder cal led SALES. When 
that folder is opened, the name of the folder is added to the pathname. The 
path name then consi sts of the Disk Identifier and the folder name l ike the example 
be low: 

A:\SALES\' .* 
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The window now displays the contents of the SALES folder. One of the i tems in the 
di splayed directory is a folder called WESTERN. When that folder is opened, the 
name of the folder is added to the path name. Now the pathname looks l ike this :  

A:\SALES\WESTERN\ * .  * 

In the displayed directory of the WESTERN folder you find the fi le you are looking 
for, cal led JULY _6. DOC. 

If  you opened that fi l e  from within an application, the fol lowing entire path name 
may display in  the move bar: 

A:\SALES\WESTERN\JU LY _6. DOC. 

The fi le  mask i s  replaced by the actual fi le name and extension. 

Note: An underline character separates JULY from 6. Since the space character is 
an illegal character in file orfolder names, the underline character is sometimes 

used to simulate a space. 

Ope n i ng a F i le  

When you open a program fi le, the computer carries out the i nstructions contained 
in  the fi le .  This  is also cal led starting or running the program. 

There are many ways to open a program file from the desktop. You can posit ion 
your pointer over the file ' s  name or icon ( located e ither in a window or on the 
desktop) and double-cl ick the left mouse button. You can highl ight the fi le, then :  
select the Open option under the File menu, o r  press the assigned command key ' 
(the default command key for opening a fi le is (0)). You can also use an assigned 
function key to open the program. ( See Open under File Menu in the previous 
chapter. ) 
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(Other methods of opening a program fi le are explained in the Instal l Application 
section under Options menu in the previous chapter. ) 

Fi le Selector 

The File Selector is a spec ial dialog box that can only be accessed from within 
a program. You wil l  use the File Selector for loading and savi ng fi les. Many 

appl ications programs use the File Selector dialog box ( see Figure 5 - 1 ). 

FILE SELECTOR 
Dirottory: 

f :  \EASYDRRW\lI . 6E1L _________ 

Selec t i Dn : � _____ . __ 

Ii 
., * . �E" 

M RUTO ___ , ___ 
() 

[( 6E11SYS_, ___ r--
---_ ._-
---- , --
__ - 1 ---
--_ . _-
___ 1 -- DI:=J --_ . _-- r------ _ . _-- () � 

Figure 5-1 . The File Selector Dialog Box 

When you display the File Selector dialog box , the Directory field di splays the 
current directory 's  pathname. The pathname consi sts of a disk identifier, folder 
name(s) ,  and a file specifier. 

The Selection field shows the currently selected fi le ( i f  one has been selected) and 
can be edited l ike the Directory field. 

The directory window shows the current directory ' s  folders and fi les that can be 
accessed by the application. The folders are l i sted fi rst in  the directory w indow, and 
then all fi les are l i sted. ( For further information on sorting see Sorting Files and 

Folders i n  this chapter. ) 
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If the directory contains more fi les than it  can display in the window at one time, 
scroll the window to view the hidden fi les.  ( See Scrolling a Window, in Chapter 
3, The GEM-Desktop.)  

The drive selector shows the currently selected drive. 

Note: When you make a change within the File Selector dialog hox, related fields 
automatically show that change. For instance, If you change the drive with the 

drive selector, the drive letter in the Directory field also changes. 

Selecting A File 

Place the pointer on  the filename you wish to select. Select a file by  one of  these 
methods: 

• Cl ick the left mouse button and select O.K. 

• Double-cl ick the left mouse button. 

• Enter the filename on the selection field, then select O.K. 

Selecting A Directory 

From the directory window, open a folder directory by selecting the folder name. 
The current directory w indow 's fol der appears at the top of the directory, marked 
with a folder symbol .  To close a folder directory, select the close box button. The 
current directory 's  pathname appears in the Directory Field. 

From the directory field, you can select a directory by typing that folder' s  
pathname. T o  d o  this, erase the Directory Field, type the new pathname,and press 
[ Return ] .  The pathname contains a disk identifier, and may also contain folder 
names and fi le specifications. 
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Selecting a Drive 

You can select a drive from the drive selector or the Directory l ine.  
To select a drive with the drive selector, posit ion the pointer over the target drive ' s  
letter. Cl ick the left mouse button t o  view the drive ' s  directory. 

NOTe: The drive lerrer is parr of The disk drive idenTifier, which includes a lerrer 
specifying a drive, a colon ( : ) ,  and a backslash (\). 

The File Specification 

The fi le specification in the Directory field is a search criterion that may include 
letters, numbers, and special characters cal led wi ldcards (* and ?). The file 
specification determines which files appear in  the directory window. By editing the 
file specification, you can choose which fi les or types of fi les to display. 

The file specification is s imilar to a filename. It  contains a mandatory name of up to 
eight characters and an optional extension of up to three characters. A fi le 
specification uses the asterisk (*) and the question mark characters as wi ldcards. 

An asterisk in a fi le specification stands for all characters and combinations of 
characters, and can replace an entire name or extension. For example, the fi le 
specification *.  * calls for the display of al l  filenames with a l l  extensions. 

Often, a fi le specification has an asterisk for the name, but specifies an extension. 
For example, the fi le specification * .DOC shows al l  filenames with the .DOC 
extension in the directory window. This  file specification would not show: 

FINANCE .TXT 

The asterisk must be the l ast character in the name or extension of a fi le 
specification. For example, the file specification TAX*.DOC is val id, but the fi le 
specification T*X.DOC is  not valid. 
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A question mark in a fi le specification replaces a s ingle character. For example, the 
file specification M EMO? LET specifies a l l  fi les which begi n  wi th MEMO, have 
any character in the fifth position of the fil e ' s  name, and which have the extension 
.LET. This fi le specification would not display the files :  

BID .LET 
M EM033.LET 
MEM01 . DOC 

The file  specification ???????? ??? i s  equivalent to * * 

You can combine wi ldcards and characters. For example, ?IL* .T?T and F*.T* are 
both valid file specifications which would display FILE. TXT. 

To change a file specification, edit the specification in the Directory field, then 
update the directory w indow by pressing [ Return].  

Open ing a Data Fi le 

You can open the appl ication file  first ( see Opening a Program File i n  thi s  
section) and then open the data file using the File Selector. O r  you can save a step 
by using Install Application to l in k  the data file  type ( identified by the three
character extension) to an application. I f  the data fi le type i s  l inked to an 
appl ication, you can use one of the four methods for opening a fi le (see Opening a 
Program File i n  this chapter) as i f  you are opening the data file  from the desktop. 
The computer wi l l  open the selected file .  

Note: You can also open a file by dragging a data file over the icon for the program 

file. 

If you attempt to open a data file  whose file type is not l inked to an application, the 
S how/print dialog box displays. 
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Select Show to di splay the data fi le on screen. I f  the fi le contains readable text, the 
text displays. If the fi le is longer than one screen, the message -More- appears at the 
bottom of each screen of text. You can scroll through the file  in the fol lowing ways: 

One screen at a time by pressing [Spacebar] or the left mouse button.  

One half-screen at  a time by pressing [D] or [Control] [D].  

One line at a time by pressing [Return]. 

Note: You can only scroll forward. You cannot scroll back through text that you 

have previously viewed. 

If you press the left mouse button or [Space B ar] while scrol l ing text by the screen 
or half·screen, the screen continues to scrol l until it displays a ful l or half-screen, 
beginning from where you last pressed the left mouse button. The End-of-File 
message appears when the screen has di splayed the entire contents of the fi le. To 
return to the desktop anytime before the End-of-Fi le message appears, press the 
right mouse button, [Q] ,  [Contro l ]  [C ] ,  or [ Undo] .  

Fi le and Folder Management 
Copying, moving, deleting, and other fi le and folder operations a l low you to better 
organize your disk space. If you maintain good file and folder organization, you 
conserve disk space and create an effic ient working environment. 
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Copyi ng Fi les and Folders 

You can copy window i tems (fi les and folders) onto a floppy disk, logical drive or 
folder. 

When you copy a folder, the subdirectory information and all the folder' s  contents 
(files and other folders) are copied to the new location. 

To copy a window item, select the item and drag i t  to i ts  new posit ion on the 
desktop. You can drag a window item to another window, disk icon, or folder icon. 
The i tem's  destination icon wi l l  highl ight when the i tem i s  positioned on top of the 
destination icon. 

Note: If you drag a datafile on top of an application, the application will run . The 

data file will be used as a parameter and will open automatically. 

When you begin a copy operation on a s ingle or on multiple w indow items, the 
Copy Fi le(s)  dialog box appears. You must select OK to continue the copy 
procedure. Working with a s ingle floppy drive, you wi l l  need to switch disks 
occasionally to complete the procedure. The computer provides alert dialog boxes 
to tell you when to switch disks. The Copy File(s) d ialog box shows the name of the 
destination folder, and d isplays each item 's name as that item is copied. 

Note: The Copy File(s) dialog box will not appear if the File Copies confirmation 

option has been turned off. See Set Preferences for more information on the File 

Copies confirmation option. 

You can halt the copy operation by pressing [Undo] while the bee icon displays.  On 
a s ingle disk drive system, press [Undo] whi le the source disk i s  in the drive. When 
the Abort Operation dialog box appears, select Yes to halt the operation, or No if 
you w ish to continue copying. 

To copy an entire disk, drag the disk icon to the copy destination (floppy disk, 
logical drive, or folder). Copying a disk icon to a folder adds the contents of the 
disk to the folder wi thout d isturbing the contents of the folder. 
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If the destination folder' s  w indow i s  open, copying a file  or folder updates the 
displayed directory. 

Name Confl ict D u ri ng Copy ing 

A name conflict occurs when you attempt to copy a w indow item to a floppy disk, 
logical drive, or folder that already contains an i tem of the same name. Depending 
on the Fi le Overwrites confirmation setting (see Set Preferences in Chapter 4, A 
Guided Tour of the Desktop.),  the Name Conflict  alert dialog box appears, 
warning you that a name conflict occurred. I f  you wish to replace the existing item 
with the item of the same name, select Copy. 

You could also choose to change the name of the window i tem you are copyi ng so a 
name conflict  does not occur when you continue the copy operation. 
You can change the i tem' s  name from w ithin the Name Conflict alert dialog box. 
The text insertion cursor i s  already posit ioned at the end of the Copy's  Name l ine. 
Press [Backspace] to clear the Copy's  Name l ine one character at a t ime, or press 
[Esc] to clear the entire field. Now type in the new file or folder name and select 
Copy or press [ Return] to continue the copy operation. The original i tem remains 
intact, and the copied i tem appears in i ts  destination under the new name. When 
copyi ng multiple w indow i tems, select Skip if a name conflict occurs and you wish 
to skip over that particular i tem, but you w ish to continue the copy operation on the 
other selected items. 

Movi ng F i les and Folders 

Moving a window item allows you to transfer that item to a new location, deleting 
the item from i ts i ni t ial  location. 

To move w indow items, highl ight one or more items. Then hold down [Control] as 
you cl ick on and drag the i tems to a new location.  The Move File(s) dialog box 
appears, showing you the number of items involved in the Move operation. 
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Select OK to complete the move.  To cancel the move operation, select Cancel . 
When you select OK, the Move Fi le(s)  dialog box shows the destination folder ( i f  
there i s  one) and the name of  the i tem moved. 

You call halt a move operation in progress by pressing [ Undo] while the bee icon 
displays. When the Abort Operation dialog box appears, select Yes to stop the 
operation. 

Renam i ng Fi les and Folders 

You can rename files and folders with the File Information dialog box .  The Show 
Information command displays the File Information Dialog Box.  
For more complete instructions, ( see Show Information, i n  Chapter 4, A Guided 
our of the Desktop). Filenames can have from one to eight characters. Optional ly,  
filenames are fol lowed by a period and a three-character extension. Folders can 
have from one to eight characters, and usually do not have an extension. 

Note: As  a general rule, you should avoid mod(fying the three-character extension. 
A change in the extension may prevent the system or an application from using 

program, resource , dota, and other files correctly. 

Deleti ng Fi les and Folders 

You can delete unwanted window i tems to free up room on a disk or i n  a folder. 
There are two ways to delete window i tems. You can h ighlight the desired item and 
drag it i nto the trash can icon on the desktop. The trash can icon highlights and the 
Delete File( s )  dialog box d isplays. You can also highl ight the desired item and 
choose Delete Item from the Fi le menu or use an assigned keystroke for Delete. 
When the Delete Folders/Items dialog box appears, you can confirm or cancel the 
delete operation. To continue the operation and delete the i tem, select OK. 

Note: If the Delete File(s) dialog box does not appear, the File Deletes 

confirmation option has heen turned off. See Set Preferences for more information 
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on the File Deletes confirmation option. 

You can halt a delete operation in progress by pressing [ Undo] wh i le the bee icon 
displays. Deleting files is a fast operation, so you must act qu ickly to halt the 
process. When the Abort Operation dialog box appears, select Yes to stop the 
delete operation. This wi l l  not retrieve those files already deleted. 

Note: You cannot delete a file if its read/write status is set at Read Only. Also, you 

cannot delete a folder containing a Read Onlyflle. To change the read/write status 

ofa file, select the file. select Show Info ji'om the File menu .  and then select 

Read/Write or Read Only. 

U pdati ng a D i rectory 

Being able to update a displayed directory is useful when you are working with 
floppy disks. I f  you insert a disk into drive A and disp lay that disk ' s  director-y, and 
then remove that disk and insert a new disk into drive A, the window does not 
automatically display the new disk's directory. You can update the directory 
di splayed in the window by pressing [ Esc ] .  Your computer wi l l  read the directory 
of the disk that is currently in the drive, and display that directory in the window. 

Displayed directories update automat ically after you copy, move, or delete a fi le or 
folder, or copy or format a disk .  
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6 MuitiTOS 

MultiTOS is  Atari ' s  exclusive multitasking environment. A multitasking 
environment can run a number of programs simultaneously, which makes i t  more 
powerful and exciting to use than a conventional operating environment (more on 
this l ater) . Incorporating a l ist of features unparal leled by any other operating 
system, Mul tiTOS i s  a completely new and innovative way of interfacing with your 
Atari computer. 

The Advantages of M u ltiTOS 
Using MultiTOS, you can use  your computer and programs more efficiently. For 
example, if you init iate a time-consuming process, such as a file  compression 
routine, you can run a word processor and type a letter, while the fi le compression 
routine carries on in the background. 

MultiTOS has an inherent set of advantages over other multitasking operating 
environments. For example, MultiTOS accompl ishes true pre-emptive multitasking, 
dynamic prioritization, and memory protection. 

MultiTOS ' s  pre-emptive mult itasking al lows your computer to simultaneously run 
programs that were not origina ll y  designed to multitask. Where other multitaski ng 
environments force the user to manually al locate and reallocate system resources, 
MultiTOS dynamical ly prioritizes system resources for each appl i cation. 
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MultiTOS ' s  memory protection defines the memory boundaries of each active 
program, which keeps one active program from interfering w ith another active 
program ' s  memory. 

Using MultiTOS you can easi ly :  

• Run mult iple programs and desk accessories simultaneously 

• Cut and paste information between applications 

• Move, resize, and scrol l  background windows without leaving the current 
( foreground) application 

• Monitor the use of system resources by any acti ve program, anytime 

• Keep track of all the active programs 

New Featu res 
MultiTOS offers a host of new features. However, users already fami l iar wi th TOS 
wi l l  find MultiTOS just as easy to use. This  section describes the new features 
offered by Mult iTOS. 

M u ltitaski ng 

The foremost feature o f  Mult iTOS i s  its abil i ty t o  run multiple programs 
simultaneously .  Through memory allocation and memory protection, each program 
running under Mult iTOS can work concurrently, w ithout using memory designated 
for another appl ication. 

To provide the most effic ient use of system resources, MultiTOS ' s  dynamic 
prioritization constantly adjusts the amount of processing t ime al located to a 
program. For example, i f  there are many appl ications running on the desktop, 
MultiTOS al locates processing time to al low for al l tasks to run. 
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MultiTOS use Inter-Process Communications ( IPCs), such as messages, pipes, etc . ,  
to  pass i nformation. Appl icatons that use the same I PCs can share information with 
M ul t iTOS .  

Expanded Desk Menu 

One of the first things you ' l l  notice about MultiTOS i s  i ts  expanded desk menu. 
The expanded desk menu not only l i sts the usual selectable items, but also l ists the 
desktop and every active program as selectable i tems. The foreground application i s  
i ndicated by a checkmark. 

Adoptive Menu Bars 

MultiTOS adopts the menu bar of whatever application i s  running in the 
foreground. When the foreground application doesn ' t  have its own menu,  
Mul tiTOS uses the desktop's  menu. 

Foreg rou nd and Backg round Appl icat ions 

MultiTOS allows you to have a foreground application and a number of 
background applications runni ng simultaneously. The exact number of open 
applications depends on the amount avai lable memory. The foreground application 
runs in the top window and a background applications run in the bottOm windows. 

Note: Whichever application is in the Joreground receives inputJrom the keyboard. 

MultiTOS allows you to choose the top window by selecting or topping i t . For 
more information on topping see Choosing the Foreground Application later in this 
chapter. When you top a window, MultiTOS displays the menu associated w ith the 
foreground appl ication, if that application has its own menu. 
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Bottom windows are act ive,  but cannot receive input from the keyboard unless they 
are topped. Background processes can run independently, unti l they need input 
from user ( see Running an Application in the Background, later in this chapter) .  

Mu ltiTOS allows you to move, res ize, and scro l l  bottom windows without topping 
them. 

More Desktop Control 

MultiTOS gives you more control over the appearance o f  the desktop. I t  a l lows you 
to manipulate windows in the background, as well  as the foreground. You can 
move, resize, and scrol l  any window, without changing the foreground appl ication. 

Ease of Use 

Although Mul tiTOS i s  a versati le and powerful multitasking environment, i t  
maintains the easy-to-use functions establ i shed by its predecessor TOS . In  case you 
need help, Mult iTOS contains on-l i ne help menus that contain a wide variety of 
information. To access the on-line help, just press [ He lp  J .  

Lau nch ing Appl ications 
To launch a program i n  Mul tiTOS double-cl ick on an executable program fi le i n  a 
directory folder, or on the desktop. (You can use variations of this  method by 
instal l i ng the application on the desktop. See Install Application in Chapter 4, A 
Guided Tour of the Desktop.) Once you l aunch a program, you can leave the 
program whi le i t  i s  running, and open another program. 

M u lt iTOS al lows you to open as many programs as the amount of avai lable RAM 
wi l l  a l low. 
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R u n n i ng an Appl icat ion i n  the Foreg ro u nd 

Mult iTOS is a versati le operating system which offers several ways to easi ly 
choose which appl ication runs in  the foreground. 

The Desk menu displays a l i st, which includes the foreground application 
( designated by a checkmark) and every application running in the background. Any 
application you select from the Desk menu becomes the new foreground 
appl ication. 

Selecting an appl ication from the Desk menu is  just one way to choose the 
foreground appl ication. 

Note: You can always access the desktop from any application by selecting Desktop

in the Desk menu. 

Toppi ng a bottom window i s  another way of changing the foreground appl ication . 
When you have multiple windows open on the desktop, topping a bottom window 
makes it the new top window , and causes the application responsible for the 
window to become the foreground appl ication. 

R u n n i ng an Appl ication i n  the Backg rou nd 

You w i l l  want to run some tasks, such as fi le compression or any other time
consuming appl ication, in the background. Tasks that you run in the background 
should not require frequent keyboard input, because only the foreground 
application can receive i nput from the keyboard. Many applications after 
implementing an init ial  set of commands run independently of user input, unti l  
they require more user input or finish the task at hand. 

To run an application in  the background, just launch the appl ication in the 
foreground using one of the techniques described earlier. If  necessary, enter any 
required commands or arguments. Start the process, then choose another 
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foreground application. The background process continues until it requires input 
from you, or unt i l  it i s  completed. 
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A Pointer Control & Quick Reference 

The fol lowing table l i sts mouse functions and keystroke combinations. You may 
copy this page and post i t  near your computer for quick reference. 

Action 

Move pointer. 

Select item.  

Select and open item.  

Drag item.  

Right button functions. 

Mouse Function Keystrokes 

Roll  mouse in desi red [Alt] any arrow key 
d irection.  moves pointer eight 

pixels in the di rection 
of the arrow. 

Position pointer on 
item.  Click left mouse 
button .  

Position pointer on 
item.  Double-click 
left mouse button .  

Select item.  Hold 
down left mouse 
button .  Rol l  mouse in 
desired direct ion.  

Cl ick r ight mouse 
button .  

[Alt] [Sh ift] any arrow 
key moves pOinter 
one pixel in the 
d i rection of the arrow. 

Position pointer on 
an item.  Press [Alt] 
[ I nsert] . 

Position pointer over 
item and press [Alt] 
[ Insert] twice . 

Position pointer on 
an item.  Hold down 
the [Alt] [ I nsert] keys 
and use arrow keys 
to move the item.  

Press [A It] 
[Clr Home] . 
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Advanced Hard Disk Utilities 

This appendix contains information about the Atari Advanced Hard Disk Uti l i ties 
disk. It applies to both the internal SCSI and external SCSI or ACSI hard disk 
drives. The formatting information in Appendix B does not apply to IDE drives, 
which are preformatted by the manufacturer. 

This disk contains programs and fi les that al low you to: 

• Park and Unpark the read write heads 
• Install or remove the hard disk driver file 
• Format and partition the hard disk 
• Erase the contents of a logical drive 
• Extend the system-wide folder l imit 
• Mark bad sectors on the hard disk 
• Create an extended partition scheme 

Parki ng and Unparki ng the 
ReadIWrite Heads 
Whenever you move your computer, you shou ld park the hard drive heads to 
prevent damage to the hard disk and the data it contains. Parking the hard disk drive 
heads moves the read/write heads of the drive away from the disk media. 

Parked heads cannot damage the disk media during moving or shipping. The Atari 
Advanced Hard Disk Ut i l i ties include two types of head parking programs. 
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One type parks the disk heads of all hard drives connected to your system. The 
other parks the disk heads of individual  un i ts. 

Caution:  If you fail to close all hard disk windows before parking the drive 

heads you may damage data on your hard disk. 

Parki ng Drive Heads on Al l Un its 
To park the hard disk drive heads on al l  hard disks connected to your system, run 
SHIP.PRG from a floppy disk i n  drive A. 

Note: SHIP.PRG will not park the heads of a Megafde 44 Removable Hard Disk 

Drive. 

With a directory of the Atari Advanced Hard Disk Util i t ies disk di splaying, follow 
these instructions to run SHIP.PRG. 

1 .  Open the HDX folder. 

2. Close all  other open w i ndows. 

3. R u n  SHIP.PRG. 

4. Switch off your hard disk units as soon as the desktop appears. 

Parking Drive Heads on Selected Units  

To park a specific hard drive, you must select a physical unit to be parked. With 
your hard disk uti l i ties disk in drive A or B, fol low these instructions to park the 
heads on individual physical units:  

1 .  Run the HDX program. 

2. Close all other open windows. 

3. Select the Ship option on the Disk menu. 
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4. A dialog box displays, asking you if the hard disk drive to be parked is an ACSI drive 

or a SCSI drive. Select the appropriate drive type. Click on OK to continue. 

5. When the Select physical uni tes)  dialog box appears, select the physical units that are 

to have their heads parked. Select OK. 

Note: You can select any physical unit connected to your system (formatted 

or not). The unit number boxes of connected devices appear shadowed. 

6. An alert box message appears on screen offering you a last chance to cancel the head 

parking procedure. Select OK to park the heads. 

7. A final alert box appears, i nstructing you to turn off your hard disk .  Select OK and 

switch off the power to your disk drive(s). 

Note: If you are preparing to move your entire system, switch off your computer at 

this time. 

U n parki ng the Drive Heads 

The next t ime you start your system the drive heads are automatically unparked. 

I nstal l i ng and Removi ng the Hard 
D isk Driver Fi le 
The HINSTALL.PRG program install s  or removes the hard disk driver fi le .  The 
hard disk driver al lows you to start your system from your hard drive . 
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I nstal l i ng the Hard Disk Driver 

Display the directory o f  the HINST A L L  folder. Fol low these steps t o  install the 
hard disk driver: 

1 .  Run H INSTALL.PRG. 

2. Select Instal l  from the File menu. 

3. Select a logical drive for the operation. You can only select logical drives that are 

highl ighted in shadowed boxes. Select OK. 

4. From the displayed dialog box, select OK to install  the driver, or Cancel to abort the 

operation. 

Removi ng the Hard Disk Driver 

Display the directory of  the HINST ALL folder. Follow these steps to  remove the 
hard disk driver: 

1 .  Run HTNSTALL.PRG. 

2. Select Remove from the File menu. 

3. Select  a l ogical drive for the operat ion.  You can only select l og ical drives that are 

highl ighted in shadowed boxes. Select OK. 

4. From the displayed dialog box, select OK to install the driver, or Cancel to abort the 

operation. 
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Bypassing the Hard Disk Driver 

As an  alternative to  removing the hard disk driver, you can simply bypass the 
driver. 

To do so, perform a keyboard warm-boot or press the reset button. When the Atari 
logo ( Fuj i )  appears, hold down [Alternate ] for a few seconds and the system 
bypasses the hard disk driver. 

Formatti ng and Partition ing the 
Hard Disk 
Caution: The HDX Format and Partition options described in this chapter 

completely erase all data on your hard disk. Back up all of your valuable files 

before proceeding. 

Formatt ing 

You wi l l  probably never have t o  reformat your hard disk. The hard disk has already 
been formatted at the factory. Formatti ng the hard disk creates magnetic patterns 
called tracks and sectors. The process also marks and logs bad sectors, areas on the 
disk with surface damage or other imperfections. Data stored in these areas could 
be corrupted or lost. During hard disk operations, the computer avoids sectors 
marked and logged as bad. 

The formatting process also automat ical ly divides the hard disk into storage areas 
called partitions or logical drives. 
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If your system contains an i nternal hard disk, it w i l l  be preformatted by Atari . 
Formatting erases al l information from a disk and prepares the disk to accept data. 
You may need to format the hard disk if the factory format becomes erased due to 
mishandling or if the hard disk develops bad sectors. 

Display the directory of the HDX folder. Fol low these i nstructions to format a hard 
di sk : 

1 .  Select HDX.PRG. Then select the Format option from the Disk menu. 

2.  Read the alert message that appears on screen.  If necessary, back up all your data 

before proceeding. Select OK to cont inue. 

3. A d ialog box displays, asking you if  the hard d isk  drive to be formatted i s  an ACSI 

drive or a SCSI drive. Select the appropriate drive type. Select OK to continue. 

4. Select a physical unit ( h ard disk drive) for formatting. If  you are formatting only the 

i nternal hard disk,  select U N I T  O.  If  you are formatt ing an addit ional h ard d i sk ,  

select a uni t  that corresponds to the h ard disk ' s  DIP switch  settings. (See your hard 

d i s k  dr ive  owner ' s  manual  for i n formation about D I P  sw itch set t ings . )  U n i t s  i n  

shadowed boxes are the units that are connected t o  your system. 

II, S e l ect The Phys i c a l  Un i t  I" 

I UNIT 0 I I  UNIT 1 I I  UNIT 2 I I  UNIT Z I 
I UNIT 4 I I  UNIT 5 I I  UNIT 6 I I  UNIT 7 I 

I OK I I CANCEL I 

Figure B . l :  The Select Physical Unit Window 
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Select OK to continue. A dialog box may appear, displaying a l ist of hard disk unit 
types. 

5. Select the hard disk type showing your drive 's  model name. 

6. Select OK to continue. 

7. Read the alert message that appears on screen. 

Select OK to format the unit .  A message appears informing you that formatti ng i s  
in progress. 

Note: When the partitioning message disappears, the formatting operation is 

complete. 

When the formatting is complete, the Format option automatically in it iates the 
Markbad and Part i tioning options. To find out more about these functions, refer to 
the sections on Marking Bad Sectors and Parti t ion ing. 

The default parti t ion quanti ty and s ize i s  determined by the hard disk drive model. 

Partit io n i ng 

I f  your computer contains an internal hard disk drive, i t  w i l l  a lready be partitioned. 
Partit ioning a hard disk i s  a process that divides the disk into sections. Setting a 
parti t ion s ize tel l s  the hard drive how much storage capacity to assign to each 
part it ion. You can use the factory-set parti t ion capaci t ies or change the storage 
capacity of each partit ion to suit  your fiie organization needs. 

Part it ioning divides your physical hard disk into data storage areas called logical 
drives. Each l ogical drive i s  pre-installed and w i l l  automatically appear on your 
desktop unless you repart i t ion the disk. 

Advanced Hard Disk Utilities 8-7 



Fa/con030 Owner's Manual 

Partitioning al lows you to store and access your data efficiently by a llowing you to 
group files and folders in different logical drives. 

Use the Partit ion option to create partitions in sizes best suited to your disk storage 
needs. The Partition option lets you u se an editing menu to set the s ize of each 
partition or select a suggested partitioning scheme wi thout having to reformat your 
disk. 

Note: When you repartition your hard disk, you must use the Install Devices 

command to install desktop icons/or the logical drives. 

Select ing a U n it to Partit ion 

Display the  HDX fol der. Fol low these instructions to  partition a hard disk: 

1 .  Select H DX .PRG from the HDX folder. Then select the Partit ion option from the 

Disk menu .  

2. A d ialog box displays, ask ing you if  the  hard d isk  drive  to be formatted i s  an ACSI 

drive  or  a SCSI  drive. Select the  appropriate drive type. Select OK to cont inue. The 

Select a physical unit dialog box displays. 

3. Select  a physical  u n i t  for part i t ioning.  To part i tion your hard d isk ,  select  the un i t  

n umber of the dev ice  you  want  to parti t ion.  Only  u ni ts i n  shadowed boxes can be 

selected. Select OK to continue. 

4. Select a partitioning scheme. 

There are two ways to select a partitioning scheme. You can use the Choose a 
Partition Scheme dialog box to choose from preset partitioning schemes. Or you 
can use the Edit Partition Scheme dialog box to create a customized partitioning 
scheme. The fol lowing sections ful l y  describe each method. 
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Selecting a Partition ing Scheme 

After you select a physical un i t  for part i tioning, the Edit Part ition Scheme dialog 
box displays. 

Use the Edit Partition Scheme dialog box to create a customized partit ioning 
scheme. If you wish to select a preset partitioning scheme, click on Menu to display 
the Choose a Partit ion Scheme d ialog box. 

From the Choose a Part ition Scheme dialog box you can click on the Edit box to 
return to the Edi t  Part i tion Scheme dialog box . 

Creating a Customized Partit ion ing Scheme 

The Edit Partition Scheme dialog box displays information about the selected unit 's  
current partition scheme. 

�I, Edit  par t i t i on sthel"le of the unit  �II, 

Total � of Par t i t i on (s) : 4 
Mel"lory Left : 9Mb 

�1 I 11 . 5Mb 

�2 I 11 . 5Mb 

�3 I 11 . 5Mb 

�4 I 11 . 5Mb 

I ¢ MENU ImIDl OK 

� � f-

[]IT] 
� 
� ro 
II CANCEL IIEXPER T � 

Figure B .2 :  The Edit Part ition Scheme Dialog Box 
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Infonnation l ines appear at the top of the dialog box. The Total l ine d isplays the 
current total number of part i t ions.  The Left l ine displays the number of megabytes 
on your disk that have not yet been assigned to any partition. 

Each partit ion ' s  s ize is d isplayed to the right of the partition number in the edit box . 
Min imum part i t ion s ize i s  I megabyte. Maximum part i tion s ize i s  detenn ined by 
the capacity of your hard disk. You can allocate a l l  of the memory on your hard 
disk to one part it ion. For example, a 40 megabyte hard disk can have a s ingle 
part i tion containing al l  40 megabytes of memory. 

Use the scroll bar to scroll through partit ion boxes. To v iew the 28 parti t ions you 
can cl ick on the shaded area of the scroll bar to scroll through four partit ions at a 
t ime. 

Click on the part i t ion box you wish to create or edit .  Then cl ick on the up and down 
arrows to the right of the partit ion s ize box to i ncrease or decrease part it ion s ize. 
Clicking on an unused box creates a new partition. 

Note: There must be available bytes listed on the left line before you can increase 
the size of any partition. 1 megabyte or more must appear in the left box before an 

unused partition can be activated. 

You can select Menu to display the Choose a Part i tion Scheme dialog box. This 
dialog box al lows you to choose preselected partit ioning schemes. 

To return to the most recent part i tion scheme, select Undo. Select ing OK i n it iates 
the partit ioning process. 

I f  you want to return to the HDX.PRG main menu,  select Undo. 

The Expert option is shaded and cannot be selected unless you have more than four 
part i t ions. You need to use the Expert option only if you plan to use more than one 
operati ng system. I f  you are planning to use more than one operating system w ith 
the same hard disk, see Extended Parti t ion Schemes. 
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Selecti ng a Preset Partition ing Scheme 

The Choose a Part i tion Scheme dialog box appears when you select Menu from the 
Edit Part i tion Scheme dialog box .  

Choose a part i t i on sthene : 

11-11-11-11 

15-15-7-7 17-17-5-5 

OK I CANCEL I I Ed i t o) I 

Figure B . 3 :  The Choose Parti t ion Scheme Dialog B ox 

The Choose a Part it ion Scheme dialog box provides a l is t  of suggested partit ioning 
schemes. Select the scheme you want from the l i st .  Select Edit to return to the Edit 
Part i tion Scheme box. 

After you select a partitioning scheme, select OK to part ition the disk. 

Erasi ng the Contents of a Logical 
Drive 
You can erase al l  data from a selected logical drive wi th the Zero option of the 
HDX program. Erasing (or zeroing) a logical drive is useful if you want to clear the 
drive to make room for new data or if you want to erase damaged data from a 
logical drive wi thout reformatting (and thus erasing) the ent ire hard disk. 
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Display a directory of the HDX folder. Follow these steps to erase the contents of a 
logical drive. 

1 .  Select HDX.PRG. Then select the Zero option from the Disk menu.  

2. Read the alert box that  appears on screen. Select OK to continue. 

3. Select a drive for zeroing from the Select the Logical Drive dialog box . Select OK to 

continue. 

4. An alert box appears giving you a final chance to quit the program before proceeding. 

Select OK to continue. 

Extend ing the System-wide 
Folder Li m it 
You can run FOLDER I OO.PRG to extend the number of folders your system 
recogni zes. Though most users wi l l  be able to create as many folders as they wish 
without problems, you can stil l  use FOLDR l OO.PRG to extend the folder l imit even 
further. 

To use thi s  program, display the AUTO folder directory on drive C contain ing the 
FOLDR I OO.PRG file. Then change the 1 00 i n  the filename to any value between 
00 1 and 999 using the Show I nfo option from the Fi le menu. The value you enter i s  
the number of  folders beyond 40 you can now access. For example, to  extend the 
l imit  to 240 folders, you would change the filename to FOLDR240.PRG. 

The FOLDR program must be stored in the AUTO folder of the startup disk 
(part ition C on the hard disk if physical unit  0 is the startup disk). 
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The new folder l imit  takes effect when you reboot your system. During the boot 
procedure, a message appears that shows how many extra folders you have 
designated and how many bytes of RAM are allocated to the extra folders. Each 
folder uses 1 32 bytes of RAM. 

Marki ng Bad Sectors 
Error messages stating that the data on your disk may be damaged might indicate 
the presence of bad sectors on your disk. If such error messages frequently appear, 
you should check your hard disk for bad sectors. This process identifies and flags 
defective areas on the hard disk. Hard disks may develop defective spots after the 
drive has been in use. Once these spots have been logged with Markbad, they wi l l  
not be  used for your hard disk operations. 

The Atari Advanced Hard Disk Uti l i t ies disk includes two versions of Markbad. 
One version is run automatically during the H DX Format option. This version 
operates on the ent ire selected physical unit  and erases all data on the disk during 
formatting .  

The other version operates on the selected logical drive when you run the HDX 
Markbad option. This version helps you preserve data by lett ing you decide 
whether or not to erase data containing bad sectors. Both versions of Markbad 
display a log of any bad sectors found. The cumulative tally of bad sectors in the 
log appears during subsequent Markbad operations. 

Note: You can use the HDX Markbad option on hard disks formatted with a 

previous version of HDX. 

Display the directory of the HDX folder. Fol low these steps to mark bad sectors on 
selected logical drives: 

1 .  Select HDX.PRG. Then select the Markbad option from the Disk menu.  

2. Select a logical drive from the Select the Logical Drive dialog box. 
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Se lect the log ica l  d r ive 
C :  I D :  I E :  I I  F :  I 
5 :  I H :  I I :  I I  J :  I 
�< � I L :  I M :  I I  N :  I 
n :  I P :  

I OK I I CANCEL I 

Figure B .4 :  The Select Logical Drive Dialog Box 

Select OK to continue. 

3.  While Markbad scans the logical drive for bad sectors, a message appears tel l i ng you 

that the program is  mark i ng bad sectors. I f  bad sectors are found in  a fi le ,  select  a 

course of action for the fi le from the Logical Drive M arkbad d ialog box. This  box 

displays the name of the file ,  the address location of the bad sector and c luster in the 

logical drive, and your choices for a course of action. 

Note: The Logical Drive Markbad dialog appears only when Markbadflags had 
sectors in allocated clusters. An allocated cluster is a cluster that has heen 

assigned to afile. 

Select Delete File to erase the fi le or Skip Over Bad Sector to preserve the 
undamaged portions of the file. Select Ignore Bad Sector to leave the fi le 
unchanged. ( Select Ignore Bad Sector if  you want to examine the file before 
taking action. )  

I f  bad sectors are found in a subdirectory file, select a course o f  action for the 
subdirectory from the Logical Drive Markbad box. This box displays the name of 
the subdirectory, its address location, and your choices for a course of action. 
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4 .  Select Delete D i rectory O n l y  to de lete the d i rectory structure and save the 

deleted directory files to the root directory. All fi les saved to the root directory will  be 

named TM Pnnnn where nnnn stands for the starting hexadecimal cl uster address of 

the file .  Select Delete Directory And Fi les to delete the directory structure and 

a l l  of its fi les. Select Ignore Bad Sector if you don ' t  want to take any action at 

all .  

Note: If a bad sector is found in a lost cluster, an alert box appears giving 

you the option of marking the cluster. A lost cluster is a segment of data that 

is unaccounted for and inaccessible to the system. 

5. When Markbad finishes scanning the disk, a Logical Drive Markbad tally box with the 

total count of newly fou n d  bad sectors and the count of a l l  previous ly  found bad 

sectors appears. 

Organ izi ng and Mai ntain ing you r  
Hard Disk 
The larger storage capacity of a hard d isk means that careful folder and fi le 
organization is more i mportant than ever. When planning and using your folder 
structure, keep the fol lowing tips in mind. 

• U se folder names that describe the types of files in  the folders 
• Limit the number of files i n  the root directory 
• Delete unwanted files to free up disk space for new files 
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Backi ng U p  the H ard Disk 

I t  i s  i mportant to frequently back up your hard disk data. Otherwise, accidental ly 
deleted or damaged fi les w i l l  be lost forever. As a general rule ,  i t  is good practice to 
back up new or modified fi les after each session at your computer. 

To back up your data, regularly copy i mportant fi les or folders onto floppy d isks 
and store them in a safe place. In addit ion to the copy option, you can use one of the 
many hard disk backup programs avail able through your Atari dealer or Atari user 
groups ( see Customer Support.) 

Opti m izer P rog rams 

A n  opt imizer program checks the structure of your hard disk and rearranges fi le8 
and free space on the disk.  The mult iple sectors of each fi le are grouped together. 
Contiguous free space is placed e ither at the top of the disk (to increase the speed of 
writing new fi les to the disk) or at the bottom of the disk (to i ncrease the speed of 
accessing exist ing fi les) .  Back up your data, then use a fi le optimizer program 
regul arly to i ncrease the speed and effic iency of your hard disk drive and to reduce 
the possibi li ty of data corruption and loss. 

Use one of the many hard disk optimizer programs avai lable through your Atari 
dealer or Atari user groups ( see Customer Support). 

Extended Partition Schemes 
Creati ng an extended partition scheme is  an option for advanced users. You wi l l  
probably never need to  use this option in  the normal operation of  your computer. 
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There are four slots on your hard disk that keep track of partition information. You 
can fil l  each slot with a standard partition, and have each partition represented on 
your desktop by a logical drive. Or you can fill one of the four slots w ith an 
extended partition to obtain more than four logical drives. 

An extended partition is  subdiv ided into more than one partition. This allows you to 
have more than one logical drive representing that slot. 

Note: To store system startup data the first partition must be a standard partition. 

This partition is always assigned to the first slot. You cannot select the first slot to 

contain the extended partition . You must use one of the three remaining slots to 
contain your extended partition. 

Supporting MultiTOS as your primary operating system, HDX.PRG will  
automaticall y  choose slot number two to contain your extended partition. 
However, if you plan to use more than one operating system, i t  may be useful to 
choose the specifics of the partition assignments. Some operating systems wil l  not 
recognize an extended partition scheme. The partitions you use with these operating 
systems must be standard partitions. 

The Expert option of the Edit Partition Scheme dialog box allows you to choose 
which slot wi l l  contain the extended partition, and which of four slots wil l  contain 
standard partitions. 

The Select the extended partition scheme dialog box displays the current extended 
partition scheme. The Partition section on the left side of the dialog box shows the 
partition number, size, and range of each partition. 

The Extended Partition Range dialog box on the right side of the dialog box allows 
you to choose which slot w i l l  contain the extended partition scheme. The Extended 
Partition Range dialog box displays each slot ' s  range of partitions. 
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All four slots of the Extended Partition Range box contain partit ion information. 
The first slot contains partition one. The second slot contains the extended partition, 
which i s  subdivided as parti tions two through eight. The partitions included in  the 
extended partition are always highl ighted. The third slot includes partition nine, and 
the fourth slot contains part i t ion ten. Slots one, three and four contain standard 
partitions. 

Oth e r  Advanced H a rd D i s k  U t i l i t i e s  D i s k  
F i les 

• HDX.RSC is a GEM resource file used by HDX.PRG. 
• WINCAP is a text file the includes information used by HDX.PRG. 
• HINSTALL.RSC is a GEM resource fi le used by H INSTALL.PRG. 
• SHDRIVER.RA W is  used with HINST ALL.PRG to create 

SHDRIVER.SYS, the hard disk driver file that directs your system to start 
from a hard disk. 
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Troubleshooting and Maintenance 

Troubleshooti ng 
I f  you run into problems while operating your computer, don 't panic .  You can 
probably fix i t  yourself. This section describes some common problems and 
suggests solutions. 

Note: The most common and easily fixed problem is failure to switch on the power 
to the computer. A lways check this first before exploring other possihilities. 

The Computer  Wi l l  Not Start U p  

I f  the power l ight will  not come on or the screen stays dark, fol low these steps: 

1 .  Shut down the computer and a l l  attached peripherals  (e .g . ,  external drives, printer 
etc . ) .  

2. Make sure the  the  power cable is securely fastened. 

3. Check your wall socket or power strip by pl ugging in a desk lamp or appliance. 

4. Switch on all  peripherals,  then start up the Falcon030. 

5. Check t h e  con trast adj ustments  on the moni tor.  Turn up the adj ustment  knob i f  

necessary. 
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No Desktop 

I f  the Power LED comes on, the screen brightens, but the desktop does not display, 
you may have a bad desk accessory fi le in  your startup disk or folder. 

To bypass the desk accessory, warm boot the system ( i .e . ,  press [ Control] [ Al t ]  
[ Delete ) )  then hold down [Control ]  for a few seconds after the Atari logo appears 
on the screen. 

The system warm boots, but bypasses the software (e .g . ,  Auto folder, desk 
accessories etc . )  Disable the fi les that are suspect, then try starting up the system 
agam. 

Software Problems 

I f  you have problems with an app lication, i t  may be that the software contains 
imperfections ( bugs).  Try clearing the memory by cold booting your system 
( pressing [ Control ] ,  [ Alt] ,  [ Right Shift ] ,  [Delete D. Reopen the appl ication. If this 
helps, i t  may mean the application experienced a momentary fai lure. 

If you st i l l  experience problems, make a new working copy of the appl ication from 
the original appl ication disk onto a newly  formatted floppy disk. Try running the 
appl ication from the new copy. 

If you are running the application from a hard disk, remove the questionable fi le 
from the hard disk and copy i t  again from the original application disk back onto 
the hard disk. If this works, the problem is probably with the original working copy 
of the appl ication fi le. If none of your disks work properly, you may need to replace 
your original appl ication disk. 
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You may find that some older programs (especial ly games) do not run properly 
with the Cache option turned on. If you think this may be the problem, make sure 
the Cache option is off before running the program. 

Bombs 

Sometimes applications develop errors that are potentially damaging to the 
computer's operating system. When such an error occurs, MultiTOS detects the 
error and terminates the program. In most cases, Mult iTOS wi l l  also clean up the 
memory affected by the terminated program, and return to the desktop. However, 
during extreme program fai lures, as a signal to you, M ultiTOS displays one or more 
bombs across the screen and attempts to recover from the error. 

To protect the computer' s  operating system, immediately perform a keyboard cold
boot when you see bombs displayed. If the problem recurs, discontinue using the 
program. 

The Hard Disk Drive 

Some symptoms identify the hard disk drive as the source of the problem. If you 
have an external hard disk many problems can be easily remedied using the 
Advanced Hard Disk Drive ut i l it ies.  
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Optional I nternal I DE Hard Disk 

I f  your system contains a n  I D E  hard disk, the hard disk wil l  require a different 
formatting and partitioning procedure. The internal hard disk i s  already prepared 
for you and should be accessible immediately after starting the system. If the 
system cannot recognize the hard disk for some reason, such as a corruption of data, 
take the following steps to correct the problem: 

Com mon P roblems 

Use the fol lowing table to identify and correct common hard disk drive problems. 

Problem 

Hard disk drive icon C does not 
appear when you switch on your 
system .  

C-4 Troubleshooting and Maintenance 

Suggested Solution 

If you are starting your system 
from a floppy disk drive, make 
sure the startup disk contains 
AHD I . PRG in  the AUTO folder .  If  
you are starting your system from 
the hard disk, AHD I . PRG must be 
copied to the AUTO folder on 
drive C. If you have AHDI . P RG in  
the  proper folder and the  system 
sti l l  does not display disk icon C,  
you may need to reformat the 
drive. (See Formatting in 
Appendix B. )  



Problem 

The system wil l not start from 
the hard d isk. 

An application program will not 
start from the hard disk. 

Suggested Solution 

Run the hard disk driver 
instal lation program 
(H I NSTALL.PRG.)  If the 
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problem continues, the hard d isk 
should be backed up and 
reformatted . (See Internal I D E  
Hard Disk in  this Chapter . )  

The program contains garbled 
data or was not designed to start 
from a hard disk. 

Try starting your system from the 
floppy disk drive with a working 
copy of the program. Attempt to 
run the program from the program 
disk. If  it sti l l  wi l l  not run,  contact 
the program's man ufacturer for 
more information .  

Ident ify ing and Replacing or Eras ing 
Corru pted Data 

If you st i l l  have problems, your hard disk may have developed unusable data. 
Unusable data appears altered or is unusable. Try erasing individual bad fi les and 
replacing them with val id backups. If replacement is not possible, fol low these 
steps to try and recover data: 

Troubleshooting and Maintenance C-5 



Falcon030 Owner's Manual 

1 .  R u n  the M arkbad option of the H D X  program on the A tari Advanced Hard Disk  
Uti l i t ies  d i sk  (as  described in Marking Bad Sectors ) in each logical drive containing 
unreadable data. Recover as much data as possible. 

2. Back up the data recovered from the logical drive onto floppy disks. 

3 .  Erase all  data i n  the problem l ogica l  dr ive ( s )  w i th the  Zero option of the  HDX 
program and run Markbad on the logical drive again. 

4. Copy the data you backed up on to the logical drive. 

If the main drive (drive C)  contains unreadable data, you may not be able to start 
your system from the hard disk. Use a working copy of the Atari Advanced Hard 
Disk Uti l i t ies as a floppy startup disk to start the system. Fol low the steps above, 
then i nstal l  the hard disk driver as described in this appendix .  

Error Messages 
If  a n  error message appears while you run one o f  the Atari programs from the Atari 
Advanced Hard Disk Uti l it ies disk,  the problem is  usual ly something easi ly  
remedied. I f  you aren 't  sure what to do when an error message appears, read the 
message careful ly for a suggested solution. If there is no suggested solution, find 
the message in the alphabetical l i st below and try the solution suggested. 

Error Message 

Bad Sector List is 
corrupted ! 
[OK] 

Program/ 
Option 

HDX 
Format 
Partition 
Zero 
Markbad 
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Suggested Solution 

See message. 



Error Message 

Cannot create driver 
destination ! 
[OK] 

Cannot find format 
parameters for disk type 
<disk type name> 
[OK] 

Cannot find partition 
scheme <selected partition 
scheme> 
[OK] 

Cannot format <selected 
un it> !  Try checking al l  
connections and 
reformatt ing.  
[OK] 

Programl 
Option 

H INSTALL 

HDX 

H DX 

H DX 
Format 
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Suggested Solution 

Your root d i rectory 
may be fi le at fu l l .  
You need to delete 
data to make room for 
the driver f i le .Or, your 
root d i rectory 
may be corrupted . 
If so, back up as much 
data as you can and 
reformat the d rive. 

Make sure the orig inal 
WI NCAP fi le is on the 
disk with HDX. 

Jhis partition scheme 
is not a Partit ion 
recognized by H DX.  
Make sure you are 
using your orig inal 
WI NCAP fi le.  

Warn ing :  Do not 
modify the WINCAP 
fi le .  Doing so may 
destroy the disk. Make 
sure your  hard disk is 
securely connected. 
Then reformat the 
drive. 
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Error Message 

Can not open drive 
source f i le !  
OK] 

Cannot partition <selected 
unit>! Try reformatti ng.  
[OK] 

Cannot read Bad Sector 
List from the disk! Try 
backing up the disk and 
reformatt ing .  
[OK] 

Can not read Boot Sector 
from the logical drive. Try 
backing up the disk and 
reformatt ing. 
[OK] 

Cannot read Fi le Al location 
Table from the logical drive ! 
Try backing up the disk and 
reformatt ing. 
[OK] 

Can not read from di rectory ! 
Try rerunn ing Markbad on 
this log ical drive when the 
current Markbad is 
completed . 
[OK] 
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Program/ 
Option 

H INSTALL 
Instal l  

HDX 
Partition 

HDX 
Format 
Partition 
Zero 
Markbad 

HDX 
Zero 
Markbad 
H I NSTALL 
Install 

H DX 
Partition 
Zero 
Markbad 

HDX 
Markbad 

Suggested Solution 

Make sure the 
SHDRIVER. RAW file 
is on the disk with 
H I NSTALL. PRG. 

See message. 

See message. 

See message. 

See message. 

See message. 
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Error Message Program/ Suggested Solution 
Option 

Cannot read Root HDX See message. 
D irectory entries from the Markbad 
logical drive ! Try backing 
up the disk and 
reformatt ing. 
[OK] 

Cannot read Root Sector HDX See message. 
from the disk ! Try backing Partition 
up the disk and H INSTALL 
reformatting . I nsta l l  
[OK] Remove 

Cannot save any more HDX When the Markbad 
files in the root d i rectory ! Markbad opti<?n found a bad 
Deleting the remaining lost sector in a sub-
clusters of the subdirectory directory, you di rected 
wi l l  free up disk space. the program to save 
[OK] [CANCEL] the deleted di rectory's 

f i les to the root 
d irectory. There is 
no more room in  the 
root d i rectory for the 
fi les . E ither select OK 
to delete the rest of the 
directory's fi les or 
select CANCEL to use 
a disk uti l ity that can 
recover the di rectory's 
fi les. 

Cannot write Bad Sector H DX See message. 
List to the disk! Try Format 
backing up the disk and Partition 
reformatti ng.  Zero 
[OK] Markbad 
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Error Message Program/ Suggested Solution 
Option 

Cannot write Boot Sector H DX See message. 
to the logical drive ! Try Zero 
backing up the disk and Instal l  
reformatting 
[OK] 

Cannot write driver file to H I NSTALL H I NSTALL cannot 
dest ination !  I nstal l  write to the root 

d i rectory of the d rive. 
Try backing up the 
hard disk and 
reformatting it. 

Cannot write Header to the HDX See Message. 
logical drive ! Try backing Zero 
up the disk and 
reformatt ing. 
[OK] 

Cannot write Root HDX See message. 
Di rectory entries to the Markbad 
logical drive ! Try backi ng 
up the disk and 
reformatt ing. 
[OK] 

Cannot write to Di rectory ! HDX See message. 
Try reru nning Markbad on Markbad 
this logical drive when the 
current Markbad is 
completed . 
[OK] 

Driver file does not exist! H I NSTALL The driver f i le 
[OK] Remove SHDRIVER .SYS has 

not been i nstal led or 
is missing.  
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Error Message 

File Allocation Table is 
corrupted ! Try backing up 
the logical d rive and 
zeroing.  
[OK] 

Format parameters in the 
root sector are corrupted ! 
Please reformat the disk. 
[OK] 

H DX . RSC 
[OK] 

No menu items avai lable 
for this disk's capacity 
[OK] 

Not enough system 
memory. Cannot conti nue.  
[OK] 

Reserved sectors are bad ! 
Try backing up the d isk and 
reformatting it. 
[OK] 

Program/ 
Option 

HDX 
Markbad 

HDX 
Partition 

HDX 

HDX 
Partition 

HDX 
H I NSTALL 

HDX 
Format 
Partition 

Appendixes 

Suggested Solution 

Back up the logical 
drive, erase its data 
with the H DX Zero 
option , run Markbad , 
and restore your data. 

See message. 

The HDX. RSC f i le is 
either missing or  
damaged. Copy 
the HDX. RSC f i le 
from the original Atari 
Advanced Hard Disk 
Uti l ities disk onto your 
working copy of the 
disk. 

Use the Edit Partition 
Scheme dialog box to 
set partition sizes. 

Your computer's 
memory capacity is 
too low to run these 
programs. You need a 
min imum of 5 1 2 
ki lobytes of system 
memory. 

See message. 
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Error Message 

Selected partition scheme 
is for a bigger capacity 
un it .  Please select another 
one. 
[OK] 

Too many bad sectors to 
record . Try backing up 
the d isk and reformatt ing. 
[OK] 

Too many logical d rives ! 
You cannot have more 
than 1 4  logical drives . 
[OK] 

Unrecognized boot sector !  
Either this logical d rive's 
boot sector is corrupted , or 
another uti l ity was used to 
partition this disk. 
[OK] 

WINCAP f i le not fou nd ! 
Cannot conti nue.  
[OK] 

Program/ 
Option 

HDX 
Partition 

HDX 
Markbad 

HDX 
Format 
Partition 

HDX 
Zero 
Markbad 

HDX 

You r system wi l l  have to HDX 
reboot when you qu it HDX,  Format 
for new disk information to Markbad 
take effect. 

, .  
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Suggested Solution 

See message. 

See message. 

You cannot have more 
than 1 4  log ical drives 
on your system .  
Repartition d isks as 
necessary. 

Before you can use 
Zero or Markbad, you 
must back up your 
hard disk (if necessary) 
and reformat with HDX 
format. 

Copy the WI NCAP file 
on the Advanced Hard 
Disk Util it ies disk to the 
disk from which you are 
running H DX. 

No action requ i red. 
Your system wi l l  reboot 
when you qu it HDX,  so 
the disk parameters 

f you changed can take 
effect. Any data in RAM 
wi l l  be lost. 
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Preventive Mai ntenance 
To ensure top performance from your Falcon030 computer system, follow the 
guide l ines i n  this section. 

Cari ng for the Com puter 

• A void dusty or greasy work areas. 
• Keep all components out of direct sunlight. 
• A void smoking near the computer system. 
• Always switch off the system before cleaning it. Clean the outside of 

components with a soft, s lightly damp, l int-free cloth only. Do not use 
cleansers, abrasives, or solvents. 

• To ship or store the system, repack it  in  the original factory packing 
materials. 

Cari ng for F loppy D isks 
• Do not insert or remove disks while the floppy drive ' s  busy l ight is l it . 
• Keep disks away from sources of magnetism ( such as monitors, televisions, 

electric motors, and telephones) .  
• Never touch or clean a disk's magnetic recording surface i nside the plastic 

casing. 

Cari ng for the Mouse 

Your Atari mouse i s  designed to l ast through years of use as long as i t ' s  handled 
properly. Follow these guide l ines for mouse care: 

• Don' t  drop the mouse. 
• Don 't  let the mouse hang by its tail .  
• Keep the surface on which you move the mouse smooth and clean. 
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Clean i ng the Mouse 

You ' l l  need to clean the mouse periodical ly to ensure its proper operation. Fol low 
the steps below: 

I .  Turn the mouse upside down i n  your hand with its tail pointing toward you. 

2 .  Place two fingers on the arrows on e ither s ide of the rol ler opening on the 
bottom of the mouse . Push down and away from you unti l  the rol ler pane l pops 
loose. Remove the panel .  

3 .  Holding one hand over the mouse, turn the mouse over s o  the roller drops into 
your hand. 

4. U se a soft, clean, dry c loth to w ipe the rol ler clean. DO NOT USE cleaning 
fluid or a l int-creating tissue. 

5. Gently  blow into the roller housing to get rid of dust. 

6.  Replace the rol ler in  its housing. Reinsert the rol ler pane l ,  then push i t  down 
and backwards until i t  locks in  place. 

A Fi nal Note 
Your Falcon030 system is designed for low maintenance and high rel iabil i ty .  But 
l ike anything electronic and mechanical , the equipment can break down. 
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I f  you experience problems that appear serious, take the computer (or any other 
component) to an authorized Atari service center. For the location of the nearest Atari 
service center, contact your Atari dealer or Atari Customer Support. ( See Appendix F: 

Customer Support), 
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Falcon030 Specifications 

System Architecture • CPU: Motorola 68030 operating at 1 6  MHz 
• 3 .84 MIPS performance at 1 6  MHz 
• On-chip demand-paged memory management 
• Separate on-chip 256-byte instruction and data 

caches 
• Independent address and data buses for increased 

performance. 
• Pipeli ned architecture 
• BUS:  32-bit data; 32-bit address 
• FPU: Optional Motorola 6888 1 /2 operating at 1 6  

MHz 
• RAM: 1 - , 4-, or 1 4-MB configurations 
• ROM: 5 1 2 K Byte internal; 1 28 KByte external 

cartridge 

Digital Signal Processor • Motorola 5600 I DSP operating at 32 MHz 

Expansion Bus 

• 1 6  MIPS performance at 32 MHz 
• 32 KWords of zero wait-state RAM 
• DSP connector al lows easy connection of low-cost 

1 9.2K baud fax/data modems, voice-mail systems, 
direct-to-disk digital audio recorders, JPEG/MPEG 
image compression, etc. 

• Internal direct processor slot for 386SX PC 
emulation, DMA coprocessors, etc . 

• Optional processor socket for other coprocessors 

Faicon030 Specifications 0-1 
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Sound 

Graphics 

Standard Ports 

0-2 Faicon030 Specifications 

• Eight 1 6-bit digital audio DMA record and 
playback channels with up to 50-kHz sampling 
rate. 

• Stereo 1 6-bit digital DMA audio output 
• Stereo 1 6-bit digital DMA audio input 
• SDMA soundlDMA coprocessor 

• S uper VGA: 640 x 480 256 colors 
• True color 1 6-bit mode: allows display of up to 

65,536 colors. 
• Accepts external video sync signal to allow high

quality genlocking 
• Overlay mode for easy video titl ing and special 

effects 
• Optional overscan 
• 262, 1 44 possible colors ,; 
• Hardware-assisted horizontal fine scrol ling 
• B LiTTER graphics coprocessor 

• SCSI I I  port with Direct Memory Access ( DMA) 
• H igh-speed LocalTalk-compatible LAN port 
• Connector for analog RGB color (VGA or ST) or 

composite video 
• RS232C serial port 
• B i-directional parallel printer port (also suitable for 

image scanners) 
• Cartridge port ( 1 28 K Byte capacity) 
• M I DI IN / MIDI OUT 
• Stereo microphone input: miniature stereo plug 
• Stereo audio out: miniature stereo plug 
• Two 9-pin joystick connectors 
• Two I S-pin enhanced digital/analog controller and 

l ight pen connectors 



Data Storage 

User Interface 

System Software 

Appendixes 

• 1 .44-MB floppy disk drive 
• MS-DOS format compatible 
• Optional internal IDE hard drive 

• Standard QWERTY keyboard layout; low-profi le, 
sculptured ergonomic design 

• 94/5 keys; ten function keys; separate numeric and 
cursor keypads 

• Keyboard processor to reduce CPU overhead 
• Two-button mouse supplied as standard 

• Pre-emptive multitasking with adaptive 
prioritization ( Mult iTOS) 

• I nter-process communication through MultiTOS 
messages and pipes 

• Hierarchical file system with subdirectories and 
pathnames 

• Icon-based graphical user interface with self-
explanatory command functions 

• On-l ine help 
• TOS operating system in ROM 
• Multiple window user interface with icons and 

drop-down menus 
• New Desk desktop and eXtensible Control panel 

allows customization by llser 
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E Connector Specifications 

DSP Connector 

0826 Female 

SCS I Con nector 

9 • • • • • • • • •  1 
1 8  • • • • • • • • •  1 0  

26 • • • • • • • •  1 9  

SCSI I I  Female 

2;
0\ � __________ �_�_� __ �_�_'_�_�_-__ -

_
-_-_-_-__ �

} 2� 
Pin Signal 

1 - 1 0  G N D  
1 1  +5V 
1 2- 1 4  Not Connected 
1 5-25 G N D  
26 SCSI 0 
27 SCSI 1 
28 SCSI 2 
29 SCSI 3 
30 SCSI 4 
3 1  SCSI 5 
32 SCSI 6 
33 SCSI 7 
34 Parity 
35-36 G N D  

Pin Signal 

37 Not Connected 
38 +5V 
39 Not Connected 
40 G N D  
41  ATN 
42 G N D  
43 BSY 
44 ACK 
45 RST 
46 MSG 
47 SEL 
48 C/O 
49 REQ 
50 I/O 
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Serial Port 

DB9 Male 

Pin Signal 

1 Carrier Detect 
2 Receive 
3 Transmit 
4 Data Termi nal Ready 
5 G N D  
6 Data set ready 
7 Request to Send 
8 Clear to Send 
9 Ring Indicator 

E-2 Connector Specifications 

1 \ • • • • •  ; 5 

6 • • • •  9 



Paral lel  Port 

0825 Female 

Pin Signal 

1 Strobe 
2 Data 0 
3 Data 1 
4 Data 2 
5 Data 3 
6 Data 4 
7 Data 5 
8 Data 6 
9 Data 7 
1 0  Acknowledge 
1 1  Busy 
1 2- 1 6  Not Connected 
1 7  Select 
1 8-25 GN D 

Appendixes 

1 3 • • • • • • • • • • • • •  1 
25 • • • • • • • • • • • •  1 4  
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Monitor Connector 

081 9 Male 

Pin Signal 

1 Red 
2 Green 
3 Blue 

4 Mono/Overlay 
5 G N D  
6 Red G N D  
7 Green G N D  
8 Blue G N D  
9 Audio out 
1 0  G N D  

E-4 Connector Specifications 

1 0 \. • • • • • • • • .7 1 1 1 • • • • • • • • •  1 9  

Pin Signal 

1 1  G N D  
1 2  Composite SynclVideo 

1 3  Horizontal Sync 

1 4  Vertical Sync 

1 5  External Clock Input 

1 6  External SYNC Enable 
1 7  + 1 2V 
1 8  M 1  
1 9  MO 



SCC Connector 

a-pin Mini  DIN Female RS - 422 

Pin Signal 

1 Handshake Output (DTR RS 423) 
2 Handshake I nput or External Clock 
3 - Transmit Data 
4 G N D  
5 - Received Data 
6 + Transmitted Data 
7 General-pu rpose Input 

8 + Receive 

Appendixes 
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Enhanced Joystick 

081 5 Male 

Port A 

Pin Signal 

1 UP 0 
2 DOWN 0 
3 LT 0 

4 RT O 
5 PADOY 
6 F I R E  0 /  LIGHT GUN 
7 VCC (+5 VDC) 

8 Not Connected 
9 G N D  

1 0  F I R E  2 
1 1  U P  2 
1 2  DOWN 2 
1 3  LT 2 
1 4  RT 2 
1 5  PADOX 

E-G Connector Specifications 

�o •••••••••• 
1 5 • • • • •  

'----------' 

Port 8 

Pin Signal 

1 UP 1 
2 DOWN 1 
3 LT 1 
4 RT 1 
5 PAD 1 Y 
6 F I R E  1 
7 VCC 
8 Not Connected 
9 G N D  

1 0  F I R E  3 
1 1  U P  3 
1 2  DOWN 3 
1 3  LT 3 
1 4  RT 3 
1 5  PAD 1 X  

1 
G 

1 1  



M I D I  Port 

DIN 5 Female 

M I D I  OUT 
Pin Signal 

1 Thru Transmit 
2 G N D  

3 Thru Loop Return 
4 Out Transmit 
5 Out Loop Return 

Appendixes 

3(') 1 
5�4 

2 

M I D I  I N  
Pin Signal 

1 Not Connected 
2 Not Con nected 
3 Not Con nected 
4 In Receive 
5 In Loop Return 
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If __ c_"_s_t_om __ 
e_r _S_"_pp_o_r_t 

__________ __ 

Atari Corporation welcomes inquiries about your Atari computer products. We also 
provide technical assistance. Write to Customer Relations at an address l isted 
below. 

Atari user groups also provide outstanding assistance. To receive a l i st of Atari user 
groups in your area, send a sel f-addressed, stamped envelope to an address below. 

In the United States, write to: 

Atari Corporation 
Customer Relations 
P. O. Box 6 1 657 
Sunnyvale, CA 94088 

In Canada, write to : 

Atari ( Canada) Corp. 
90 Gough Road 
Markham, Ontario 
Canada L3R 5Y5 

In  the U nited Kingdom, write to :  

Atari Corp. ( U K) Ltd. 
P .  O. Box 555 
S lough 
Berkshire SL2 5BZ 

Please indicate User Group List, Technical Assistance, or the subject of your letter 
on the outside of the envelope. 
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Glossary 

.ACC The desk accessory extension . 

ACSI Atari Computer System In terface.  ACSI is a hardware and software control 
procedure used to connect dev ices to the computer's Hard Disk port ( DMA 
channel) .  

active wi ndow The w indow on GEM Desktop that i s  current ly  avai l ab le  for 
desktop operations such as selecting, copyi ng, moving, and deleting i tems. The 
act ive window is the only window that you can scrol l ,  update, move, or resize. 

alert box A dialog box designed to bring something to your attention. Alert d ialog 
boxes are punctuated with stop signs, question marks, or exclamation points . 

. APP An execu�able GEM program fi le  extension. 

appl ication A program written to solve a specific problem or produce a spec ific 
result,  and can be executed by a computer. That i s ,  the computer i s  applied to the 
task. ( See program. )  

back u p  T o  make a n  archive copy o f  a disk o r  fi le.  B acking u p  disks ensures that 
i nformation i s  not lost if the disk is accidentally damaged or erased. 

baud The standard unit  of transmission speed of data through a modem, calculated 
in signaling elements per second. 

baud rate The speed at which data are transmitted from one source to another, 
usual ly  from one computer through a modem to another computer. 
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bee icon The icon d i s p l ayed on screen whenever the computer , transfers or 
retrieves information from the disk drive. You cannot proceed to another action 
while the bee icon is  on screen. 

bit The smal lest unit  of computer data (a binary digi t ) .  Eight bi ts  equal one byte. 
( See byte . )  

boot I n it ial system load procedure. I f  the procedure for loading your system is  in  
ROM,  booting is accomplished by  switching on  your system. ( See coldstart and 
warmstart . )  

boot disk A disk containing the system fi les needed t o  boot a computer. 

busy l ight  The l ight on a disk drive i ndicating that the drive is reading from or 
writing to a disk. 

byte A un i t  of computer data. Each byte consists  of e ight b i t s ,  prov iding 256 
possible values. For example, the letter )\''Is stored in memory as one byte. ( See bit  
and ki lobyte . )  

cache A special  coprocessing c ircu i t  found in  mos t  Atari TOS computers that 
greatly improves the speed operations. 

CD-ROM drive A computer-contro l led dev ice that reads h igh-capac i ty optical  
discs and sends the output to the computer. 

c l ick  To q u ickly press  and release a mouse button .  A c l i c k  on the left mouse 
button selects items on the desktop. ( See double-click and shift-cl ick . )  

clock/calendar The fi le-dating feature bui l t  in to the computer and set from the 
Control Panel .  

close box The sma l l  box in  the u pper left corner o f  an act ive w indow, used to 
close the current window. 
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coldstart Booting the computer by sw itch i ng the power off and on or press ing 
[Control ] [ Al t ]  [ Right Shift ]  [ Delete ] .  A coldstart can be init iated while the 
computer is runni ng by switching off the power for 10 seconds, then switching it 
back on. A coldstart complete ly in i t ial izes the system. (Compare to warmstart . )  

config u re T o  customize the computer system t o  your preferences b y  set t ing 
colors, baud rate, confirmation, and so on. 

control  panel A desk accessory used to a l ter  and set many of the system ' s  
features and options, such as the color palette, mouse and keyboard response, and 
the cIock/calendar. 

copy A command used to dupl icate the information in a fi le, folder, or disk. 

current directory The directory currently displayed in a window, as specified by 
the pathname in the move bar. 

cursor A marker that appears on the screen to indicate the pos i t ion of the next 
action. Text cursors are usually e ither a bl inking block or a solid vertical l ine. The 
mouse pointer is sometimes called a cursor. 

dai sywheel pr inter A type of pr in ter that  uses  a rotat i n g  whee l to i m pact 
characters against a ribbon and onto the paper. 

data fi le A col lection of i nformation used by an appl ication. Data fi le icons look 
l ike sheets of paper with one folded corner. 

defau lt A value, opt ion,  or setting that the computer automatical ly selects unt i l  
you direct it otherwise. For example, items on the desktop are shown as  icons, by 
default ,  unless you change the option in the View menu. 

desk accessory An application loaded i nto memory from the startup d isk when 
you switch on your computer. Desk accessories can be accessed either directly from 
the desktop or from an appl ication that uses the menu bar format. Desk accessory 
files are ident ified by the . ACC extension. 
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desktop The main screen for the computer. It includes (but is not l imi ted to) the 
menu bar, two disk icons, and the trash icon. 

destination disk The disk that information i s  written to during a copy procedure. 

dialog box An interact ive message box that the computer uses to communicate 
with you. To exit a dialog box, you must acknowledge the message or choose an 
option. 

directory A l i st of fi les. ( See current directory, root directory, and subdirectory . )  

disk drive The most common data storage dev ice.  The computer uses the d isk 
drive to read information from or write information to a disk. 

disk identifier The letter i n  a pathname indicating which disk is in  use. The letter 
is always fol lowed by a colon ( : )  and a backslash (\) . A disk identifier appears by 
itself in  the move bar of a directory window when the root directory displays. 

diskcopy A procedure that duplicates data from one disk to another disk. 

DMA port A high-speed peripheral port for attaching a hard disk drive, CD ROM 
drive, or other DMA dev ice to the computer. DMA is  an acronym for Direct 
Memory Access. (See- ACSJ. ) 

document A co l lec t ion  of data you c reate or modify u s i n g  an a p p l i c a t i o n .  
Documents can contain text, graphics, o r  both. Also cal led a fi le. (See fi le . )  

document type See extension. 

dot matr ix pr i nter A type of  pr inter  that forms characters and graph ics  by 
printing small dots. 

dou ble-c l ick Two q u ick c l icks on a mouse button.  A double-c l ick  on the left 
mouse button opens a fi le, disk, or folder. 
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double-sided Allowing use of both s ides of a disk.  A double-sided disk has both 
sides of i ts magnetic media certified as safe for storing data. A double-sided ( high
density) disk can store up to 1 ,458 , 1 76 bytes of data. A double-sided disk drive can 
read, write to, and format both s ingle- and double-sided disks. ( Compare to s ingle
sided . )  

drag T o  move a n  i tem o n  the desktop. T o  drag, point the mouse pointer a t  a n  i tem, 
press and hold down the left mouse button, and move the mouse. While the i tem i s  
being dragged, a ghost outline o f  the item appears on the desktop. 

drop-down menu A l ist  of options that appears below a menu heading when you 
touch the menu bar heading with the mouse pointer. 

editable text field A dashed line in  a dialog box where you can type characters. 

expansion con necto r An i n ternal  connector that  perm i t s  i n sta l l a t ion  of  
additional special ized hardware wi th  your computer. The signals provided i nclude a 
direct extension of the microprocessor bus. 

extension The characters to the right of the period in a filename. Extensions that 
represent the file type are mandatory. An extension can have up to three characters 
( letters and numbers) .  Some common extensions are .ACC, .APP, .PRG, .TOS, 
.GTP, and .TTP. 

fi le A collection of information that can be stored on a d isk or in the computer ' s  
memory. 

file selector A dialog box ,  opened from an application, that l ists fi les and folders. 
The File Selector d ialog box can be accessed from the application. 

file specification The search criteria used in a fi le selector. 

fi lename The name of a fi le ,  made up of a mandatory name and an extension,  
separated by a period. ( See extension and filename. )  
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f loppy d i s k  A magnet ic  m e d i u m  u sed to store i n format ion generated on a 
computer. The disk is made of material simi lar to audio tape. 

folder A subdirectory for storing fi les and other fol ders . A folder appears as a 
folder icon ( mani la  folder) on the desktop, or with a folder symbol ( small box) next 
to its name when shown as text. 

format To set the c i rc u l ar patterns on a f loppy d i sk that  enable  it to store 
information. Formatting erases a l l  information previously stored on the disk. 

fu l l  box The smal l box in the upper right corner of a window, used to change the 
size of a window alternately between a smaller screen and a ful l-screen. 

function keys The keys [ F  I ]  through [ F  I 0]  along the top edge of the computer 
keyboard. Many appl ications use these keys to perform special actions.  

GEM The portion of TOS that creates and manages al l  the w indows, icons, menus, 
and graphics features of the computer. GEM is  an acronym for Graphics 
Environment Manager. 

hard disk A dev ice used to store data on a magnetic surface . A hard d isk drive 
can store far more data than a floppy disk drive, and can read and write information 
many t imes faster. 

ha rdware The actual physical apparatus of your computer system. (Compare to 
software . )  

icon A picture on the desktop that represents a disk, fi le, folder, or procedure. The 
disk icon looks l ike a fi l i ng cabinet; the data file icon looks l ike sheets of paper 
with one corner folded; the program fi le icon looks l ike a small desktop; the folder 
icon l ooks like a manila folder; the trash icon looks l ike a trash can; and the bee 
icon looks l ike a bee. 
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information l ine The l ine at the top of a d i rectory window i mmediately be low 
the move bar, tel l ing how many bytes are used by the items l isted in  the directory, 
and how many items there are. 

in itial ize To set the computer to its starting configuration. 

in put/output ( 1 /0) The commun icat ion process  that takes p lace between the 
computer and a peripheral device such as a disk drive or printer. Input is 
information the computer rece ives ( that is, it is sent in ) ;  output is information the 
computer transmits ( that is, i t  i s  sent out). 

interface An e lectron ic  connect ion that a l lows communicat ion between the 
computer and a peripheral. 

kilobyte 1 ,024 bytes of data. ( See Byte . )  

laser pri nter A high-speed, high-resol ution printer that electrophotograph ical ly  
produces an image on paper. The Atari SLM804 i s  a laser printer. 

megabyte 1 ,024 k i lobytes of data. The abbrev iat ion for megabyte i s  M B .  ( See 
ki lobyte . )  

memory The i nternal o r  external media  that the computer uses t o  store data and 
programs. There are two kinds of computer memory: RAM (Random Access 
Memory) and ROM ( Read-Only Memory) .  RAM loses i ts data if  the power is 
turned off; ROM retains its i nformation whether the computer has power or not. 

menu bar A bar at the top of the desktop. When you first start up your system, the 
headings on the menu bar are Desk, File, View, and Options. Other appl ication 
programs may have different headings in the menu bar. 

M I D I  A standard i n te rface d e s i g n ed to connect  a computer  to a n u mber  of 
electronic musical dev ices. MIDI  is an acronym for M usical Instrument Digital 
Interface. 
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modem A device that enables you to connect your computer directly to telephone 
lines in order to establish a communication l ink with other computers and on- l ine 
information networks. Also, the port on the computer for connecting a modem or 
other serial device. Modem is a contraction of MOdulatorlDEModulator. 

monitor See video display. 

mouse A smal l ,  hand-man i p u lated device  connected to your computer that 
controls the movement of a pointer on the desktop. As you slide the mouse, a small 
rol ler on the bottom tracks the movements. The mouse has two buttons. The left 
button is used for most desktop operations .  The right button is used with some 
appl ications. 

move To move files or folders from their original l ocations to a different folder 
and/or disk.  

move bar The bar at the top of an act i ve w indow. Use the move bar to drag a 
window to a new location on the desktop. 

MS-DOS M icrosoft Disk Operating System. An operating system used with I B M  
PCs and compatibles. Floppy disks formatted o n  your Atari computer are 
compatible with PC systems using MS-DOS and 3--inch floppy drives. 

MultiTOS Atari 's  multitasking operating system. 

name The ident ify ing name of a fi le .  A name i s  mandatory and can have up  to 
eight characters ( letters and numbers) .  

N E W D E S K . I N F  The f i l e  t h a t  h o l d s  y o u r  c u s t o m i z e d  d e s k t o p  d a t a .  
NEWDESK.INF must be i n  the root directory of the boot disk i n  order for the 
computer to read it during booting. 

option An i tem in  a drop-down menu that enables you to manipulate the desktop 
and the elements on it. 
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paral lel  port An interface which accepts the s imul taneous transmission of more 
than one bit .  ( See serial  port . )  

parameter Data given to  a program that controls i ts operation. 

path name The l i st of i tems that specifies the path through the subdirectories on 
the disk to the current directory. A pathname consists of a disk identifier and a 
string of folders separated by backslashes ( for example A:\document\text\). It may 
also contain a fi le specification. 

peripheral Any external device, such as a disk drive, monitor, or printer, that you 
connect to your computer. 

pixel A dot on the computer's v ideo display. Pixels are arranged in a grid, and set 
to 640 x 400 dots per grid. Pixel is short for picture e lement. 

pOinter The small image on the screen that moves when you move the mouse. The 
mouse pointer is usually an arrow, but it may change to other shapes such as a bee 
icon during certain procedures . 

. PRG A GEM appl ication fi le extension. 

program A detai led and e x p l i c i t  set of i nstruct ions  for accom p l i sh i ng some 
purpose, expressed in a language that can be read by a computer. ( See also 
Application. ) 

program fi le A fi l e  that contains an appl ications program. The program fi le icon 
looks l ike a small desktop. Double-click the left mouse button on a program file to 
execute the program. 

prompt Any symbol or message on screen indicating that the computer is await ing 
input from the u ser. 

RAM The part of the computer' s  memory used to write data to and read data from 
a disk. When you work with your computer, the information displayed on the 
monitor screen is i n  RAM. RAM is an acronym for Random Access Memory. 
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R G B  The co lor s igna l s  that  the computer produces to c reate i t s  spec ia l  co lor  
display. The combi nations of different intensities each of  red, green, and blue 
enable you to create thousands of colors w ith most Atari TOS computers. 

ROM The part of the computer ' s  memory contain i ng the operating system. ROM 
never changes, and retains its information with or without power to the computer. 
ROM is an acronym for Read-Only Memory. 

root d i rectory The first d i rectory d i sp layed w hen you open a d i sk .  The root 
directory is specified by the disk identifier alone (such as A :\). 

RS232 An industry-standard connection for serial peripherals .  The RS232 port on 
the back of the computer i s  labeled Modem.'This port is sometimes referred to as 
the serial port. 

scrol l  Scroll ing allows different areas of a w indow to be displayed. You can scro l l  
left, right, up ,  or  down. 

scrol l  bar One of two bars that border an act ive w indow on the bottom and right 
edges. The scroll bars contai n  the scroll arrows and are shaded if part of the 
w indow ' s  contents cannot be seen. The l arger the shaded portion, the greater the 
percentage of the window' s  contents that is h idden from view. 

sector A section of a track on a hard or floppy disk. Sectors are usually 1 28,  256, 
5 1 2, or 1 024 bytes long. On a floppy disk, the sectors are 5 1 2 bytes long. ( See 
track. )  

select ing  C l i c k i n g  t h e  l eft mouse b utton on an  i c o n ,  fi l e ,  or  m e n u  opt ion .  
Selected icons and files h ighlight to  indicate the selection. 

serial port An i nterface w hich accepts the transmission of data one bit at a t ime .  
( See paral lel  port . )  

shift-cl ick Clicking with t h e  mouse button whil e  holding down t h e  [Shift] key. 
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single-sided Allowing use of one s ide only of a floppy disk.  A s ingle-sided disk 
has only one side of its magnetic media certified as safe for storing data. A single
s ided disk can store up to 357,376 bytes of data. A single-sided disk drive can read, 
write to, and format only single-sided disks, or double-sided disks that have been 
formatted as single-sided. ( Compare to double-sided.) 

size box A smal l box at the lower right corner of a window, used to change the 
window ' s  s ize or shape. 

sizing The process of changing the s ize or shape of a window. 

software The i nstructions used by your computer to process data. ( Compare to 
hardware . )  

sou rce d isk The d i sk from w h i c h  i n format i on i s  copied dur ing  a D i s kcopy 
procedure. 

startup disk A disk that usual ly  contains desk accessories, appl icat ions,  and a 
desktop configuration ( DESKTOP.I N F) fi le. Insert a startup disk in the floppy drive 
before the computer is switched on. 

subdi rectory A d i rectory i n s ide a d i rectory; often ca l led a fol der.  ( See root 
directory . )  

.TOS The TOS appl ication fi le extension. 

track One of the c ircular sections of a disk that can store data. Each track is made 
up of smaller sections called sectors. ( See sector .)  

trash can GEM Desktop icon used to permanently delete fi les or folders from the 
desktop . 

. TIP The TOS-takes parameters file  extension. 
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Accelerator CPX 4-45 - 4-46 
Active menu options 4- 1 
Advanced Setup Options 4-3 1 

CPX I nfo 4-33 - 4-34 
Min imum number of slots 4-32 
Open CPX 4-33 
Unload CPX 4-34 

Alphanumeric keys 2-5 
Applications 

arguments 4- 1 7  - 4- 1 8  
assigning boot status 4-2 1 - 4-22 
assigning to function key 4-2 1 
foreground/background 6-3 
launching (multiTOS) 6-4 
l inking a document 

type 4- 1 8  - 4- 1 9  
selecting defaul t  directory 4-20 
selecting parameter 4-20 

Application file 5- 1 
Arguments 4- 1 7  - 4- 1 8  
Arrow keys 3-7 - 3-8 
Assigning an appl ication to 

a function key 4-2 1 
Assigning boot status to an 

appl ication 4-2 1 - 4-22 
Atari SLM laser printer 4-39 

Audio feedback 4-35 
Autoboot 4-2 1 - 4-22 

B 

Baud rate 4-37 
B IT 2- 1 
B its per character4-38 
Boot status 4-2 1 - 4-22 
Booting 

from floppy disk 1 -8 
from hard disk 1 -7 

Border color 4-43 
Bottom to Top command 4-7 
Byte 2- 1 
Bytes used/available 4-4 

c 

Cache 4-35 
Calendar 4-29 
CD-ROM disc 2-3 
Changing an icon identifier 

and label 4- 1 6  
Close button 3-8 
Close Directory command 4-7 
Close Top Window command 4-7 

Index 
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video display A dev ice conta in ing a v ideo screen that you and your computer 
use to communicate. 

warmstart (warm-boot) Rebooting the computer by pressing the Reset button on 
the back of the computer or pressing [ Control ] [Alt ] [Delete] .  A warmstart only 
partial ly i n it ial izes the system. (Compare Coldstart . )  

wildcard A question mark (? )  or  asterisk (* )  character used i n  a fi le specification 
to specify the search criterion. ? 'feplaces one character; * 'replaces al l  characters to 
the end of the first name or extension. 

wi ndow The work area that the computer uses to d i splay fi les and folders or to 
run programs. Multiple windows can be open on the desktop at one t ime. 

write-protect To mechan ical ly prevent a d i sk from be ing formatted, erased, or 
written to. To write-protect a disk, move the write-protect tab so you can see 
through the notch. 
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Color display 4-4 1 - 4-42 
true color 4-42 

Color printing 4-39 
Color set 

custom 4-44 
preassigned 4-44 

Color setup 4-39, 4-4 1 - 4-42 
true color 4-42 

Colors 
window 4-43 - 4-44 

Configuring CPXs 4-44 
Control panel 4-2, 4-29 

About 4-29 
Advanced Setup 

Options 4-3 1 - 4-32 
CPX Mover 4-30 - 4-3 1 
date 4-29 - 4-30 
M inimum number of slots 4-32 
Reload CPXs 4-30 - 4-3 1 
Setup 4-29 
t ime 4-29 - 4-30 

Control panel extensions 
Accelerator 4-45 
Color Setup 4-4 1 - 4-42 
Configure CPXs 4-44 
General Setup 4-34 - 4-36 
Modem Setup 4-37 - 4-38 
Printer Setup 4-39 - 4-4 1 
Sound Setup 4-42 
Window Colors 4-42 - 4-44 

Copy/Format dialog box 2-8 
Copying 

name confl ict 5- 1 3  
Copying disks 5- 1 2  
Copying fi les 5- 1 1  - 5- 1 2  
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Copying folders 5- 1 1  - 5- 1 2  
CPX 4-28, 4-34 

Accelerator 4-45 - 4-46 
Color Setup 4-4 1 - 4-42 
Configure CPXs 4-44 
General Setup 4-34 - 4-36 
Modem Setup 4-36 - 4-38 
Printer Setup 4-39 - 4-4 1 
reloading 4-30 - 4-3 1 
Sound Setup 4-42 
unloading 4-34 
Window Colors 4-42 - 4-44 

CPX Directory Path 4-32 
Creating a Folder 4-6 
Cursor speed 4-45 

D 

Data fi le 5- 1 
opening 5- 1 0  - 5- 1 1  

Date 4-29 - 4-30 
Delete command 4-6 
Deleting fi les 5- 1 4  - 5- 1 5  
Deleting folders 5- 1 4  - 5- 1 5  
Desk Accessories 4-27 

Control Panel 4-27 - 4-34 
Desk menu 4-2 

Control Panel option 4-2 
Desktop Info option 4-2 

Desktop 2-4 
arranging 4-25 
expanded (mult iTOS) 6-3 - 6-4 
savi ng 4-23 - 4-26 - 4-27 



Desktop Configuration 
command 4-25 - 4-26 

Desktop Info 4-2 
Directories 5- 1 - 5-2, 5-5 - 5-6 

root 5- 1 
selecting 5-8 
updating 5- 1 5  

Disk drives 
selecting 5-9 

Disks 
CD-ROM disc 2-3 
copying 5- 1 2  
floppy 2-3, 2- 1 0  
floppy, write-protecting 2- 1 2  
floppy, formatting 2-7 
hard disk 2-2 

Double-click response 4-36 
Double-c l icking 3-3, 3- 1 0  
Dragging 3-3 - 3-4 
Drive icons 2-5 
Drive identifier 3- 1 0  

E 

Extensions 5-3 - 5-4 
.ACC 5-4 
.APP 5-4 
.PRO 5-4 
.TOS 5-4 
.TTP 5-4 

F 

Features I - I  - 1 -2 
File management 5- 1 1  
Fi le mask 3-8, 5- 1 
File menu 4-3 

Bottom to Top option 4-7 
Close Directory option 4-7 
Close Top Window option 4-7 
Create Folder option 4-6 
Delete option 4-6 
Format Floppy Disk option 4-9 
Open option 4-3 
Search option 4-5 
Select All I tems option 4-8 
Set File Mask option 4-8 - 4-9 
Show Info option 4-4 - 4-6 

File Selector 5-7 - 5-8 
File Selector dialog box 5-7 
File Specification 5-9 - 5- 1 0  
Filename extensions 5-3 - 5-4 
Filenames 5-2 - 5-4 
Files 5- 1 - 5-4, 5-7 - 5- 1 5  

copying 5- 1 1  - 5- 1 2  
de leting 5- 1 4  - 5- 1 5  
moving 5- 1 3  - 5- 1 4  
opening 5-6 - 5-7 
renaming 5- 1 4  
selecting 5-8 
types 5-2 

Fill color 4-43 
Fill  patterns 4-43 
Floppy disk 2-3, 2-7 

capacity 2-9 
formatting 2-7 

Index 
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write protecting 2-9 
Flow control 4-38 
Folder management 5- 1 1  
Folders 5- 1 - 5-2, 5- 1 I - 5- 1 5  

copying 5- 1 I - 5- 1 2  
creating 4-6 
deleting 5 - 1 4  - 5- 1 5  
extending l imit  8 - 1 3  
moving 5- 1 3  - 5 - 1 4  
renaming 5 - 1 4  

Format Floppy Disk command 4-9 
Foreground/Background (mult iTOS) 6-3, 
6-5 
Formatting 

floppy disk 2-7 
hard diSK 8-5 - 8-7 

Front panel 1 - 1 1 
Function keys 2-6, 4-25 

assigning appl ication 4-2 1 
Fundamentals 2- 1 

G 

GEM 2-4 

bad sectors 8- 1 3  - 8 - 1 6  
extended partition schemes 8- 1 7  -

8- 1 9  
formatting 8-5 - B-7 
icons 2-3 
optimizing 8- 1 7  
organizing 8- 1 6  - 8- 1 7  
partit ioning 8-8 - 8- 1 2  
part i t ions 2-3 

Hard disk icons 3-2 
Hard disk uti l i ties 

8-2 

bypassing hard disk driver 8-5 
erasing logical drive 8 - 1 2  
extendi ng folder l imit  8 - 1 3  
insta l l ing hard disk driver8-3 - 8 -4 
marking bad sectors 8- 1 3  - 8 - 1 6  
opt imizer programs 8- 1 7  
parking drive heads 8-2 - B-3 
parking Read/Write heads 8 - 1 -

8-2 
removing hard disk drive 8-4 
unparking drive heads B-2 - 8-3 
unparking Read/Write heads 8 - 1 -

GEM Desktop 2-4 
General Setup window 4-34 I 
Graphics Envi ronment Manager 2-4 

H 

Hard disk 2-2 
advanced util ities B - 1  - B- 1 9  
backing u p  8 - 1 7  
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Icon 
disk 2-5 
dragging 3-6 
removing 4-23 
selecting mult iple 3-6 

Inactive menu options 4- 1 
I nformation l ine 3-8 



I nstall Appl ication command 4- 1 7  
I nstall Dev ices command 4-22 - 4-23 
Install Icon command 4- 1 3  - 4- 1 6  

K 

changing icon identifier 
and label 4- 1 6  

Desktop icon 4- 1 3  
Printer icon 4- 1 6  
Window icon 4- 1 4  - 4- 1 5  

Keyboard 2-5 
alphanumeric keys 2-5 
arrow keys 3-7 - 3-8 
function keys 2-6, 4-2 1 , 4-25 
numeric keypad 2-7 
response 4-35 
selecti ng mult iple icons 3-4 

Keystroke combinations 2-6 
dragging with 3-8 
selecting with 3-7 

Ki  lobyte 2- 1 

L 

Laser printer 4-39 
Launch ing appl ications (multiTOS) 6-4 
Left panel 1 - 1 4 
Linking a document type to an 
appl ication 4- 1 8  - 4- 1 9  
Logical drive, erasing B- 1 2  

M 

Megabyte 2- 1 
Memory 2- 1 

RAM 2-2, 4-32 
ROM 2- 1 - 2-3 
storage 2-2 
system 2-2 

Menu bar 4- 1 
act ive options 4- 1 
Desk menu 4-2 
File menu 4-3 
inactive options 4- 1 
Options menu 4- 1 2  
View menu 4-9 

Modem 
flow control 4-38 
parity 4-37 
selecting serial port 4-37 
setting baud rate 4-37 
sett ing bits per character 4-38 
stop bits 4-38 

Modem setup 4-36 - 4-39 
Monitor 

adapter block 1 -8 
connecting 1 -8 

Mouse 2-5 
care and maintenance C- 1 3  
connecting 1 -7 
double-cl icking 2-6 
dragging wi th 2-6 
selecting with 2-5 - 2-6 
s ingle-cl icking 2-6 
speed 4-45 

Move bar 5- 1 
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Moving a CPX 4-30 - 4-3 1 
Moving a window 3- 1 2  
Moving files 5- 1 3  - 5- 1 4  
Moving folders 5- 1 3  - 5- 1 4  
MS- DOS computers 

Install Application option 4- 1 7  
Install Devices option 4-22 - 4-23 
Install Icon option 4- 1 3  - 4- 1 5  
Read . lNF File option 4-24 
Save Desktop option 4-26 - 4-27 
Set Preferences option 4-23 - 4-24 floppy drives 2-7 

format compatible 2-7 
Mult itaski ng 6- 1 
MultiTOS P 

N 

advantages 6- 1 
foreground/background 6-3, 6-5 
new features 6-2 

arne confl ict during copying 5- 1 3  
Naming files 5- 1 4  
Naming folders 5- 1 4  

umeric keypad 2-8 

o 

Open command 4-3 
cartridge icon or fi le 4-3 
data file 4-3 
disk icon or folder 4-3 
printer icon 4-3 

Opening a data file 5- 1 0  - 5- 1 1  
Opening a fi le 5-6 - 5-7 
Operat ing system (TOS) 2-4 
Options menu 4- 1 2  
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Desktop Configuration 
option 4-25 - 4-26 

Paper 4-40 
Parallel printer 4-40 
Parity 4-37 
Parking 

drive heads B-2 - B-3 
Read/Write heads 8 - 1 - 8-2 

Partition ing hard disk 8-8 - 8 - 1 2  
extended parti tion 

schemes 8- 1 7  - 8 - 1 9  
Pathnames 5-5 - 5-6 
Peripherals, connecting I - I  I - 1 - 1 2  
Pixels 2-9 
Pixels per l ine 4-40 
Power cable 1 -6 
Print Screen command 4-39 
Printer 

color 4-39 
parallel 4-40 
port 4-40 
serial 4-40 

Printer setup 4-39 
color 4-39 
paper 4-40 
pixels per l ine 4-40 
port 4-40 



printer type 4-40 
quality 4-40 

Program fi le 5- 1 

Q 
Qual ity of print 4-40 
Quick Reference A- I 

R 

RAM 2-2, 4-32 
Read .INF File command 4-24 
Rear panel 1 - 1 3  
Reloading a CPX 4-30 - 4-3 1 
Remove Desktop Icon command 4-23 
Right panel 1 - 1 2  
ROM 2- 1 - 2-3 
Root directory 5 - 1  
Rubber band box 3-5 - 3-6 

s 

Save Desktop command 4-23, 4-26 - 4-27 
Screen display 2-4 
Screen saver 4-45 

modem recognition 4-45 
Scrol l  bars 3-8 - 3 - 1 0  
Scroll ing a window 3- L O  - 3- 1 1  
SCSI device, connecting 1 -9 - 1 - 1 0  
Search command 4-5 
Select Al l  Items command 4-8 

Selecting 
default directory 4-20 
directory 5-8 
disk drive 5-9 
file 5-8 
icon 3-3 
items wi th shift-cl ick 3-5 
multiple icons 3 -4 
parameter 4-20 
with rubber band box 3-5 
with rubber band box 

and shift-clicking 3 -6 
Serial port 4-37 
Serial printer 4-4 1 
Set Color and Style 
command 4- 1 1  - 4- 1 2  

Set File Mask command 4-8 
Set Preferences command 4-23 - 4-24 

colors 4-24 
columns 4-24 
compatibi l i ty mode 4-24 
double l ines 4-24 

Set Preferences dialog box 4-24 
Setting color 4-4 1 - 4-42 
Setting modem 4-36 - 4-39 
Setting printer 4-39 - 4-4 1 
Setting sound 4-42 
Setting up the system 1 -5 
Setting window colors 4-42 - 4-44 
Shift-c l icking 3-5 
Show as Icons command 4- 1 0  
Show as Text command 4- 1 0  
Show Info command 4-4 - 4-6 

Bytes available 4-4 
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Bytes used 4-4 
Disk Label 4-4 
Drive I D  4-4 
Number of Fi les 4-4, 4-5 
Number of Folders 4-4, 4-5 

Show/print dialog box 5- 1 0  - 5- 1 1 
S ingle-cl icking 3-3 
Size to Fit command 4- 1 1  
S izing a window 3- 1 1  
SLM laser printer 4-39 
S lots 

minimum number 4-3 1 
Sorting commands 4- 1 0  - 4- 1 1 

No Sort 4- 1 1  
Sort by Date 4- 1 I 

Sort by Type 4- 1 I 
Sound 4-35, 4-42 
Sound setup 4-42 
Sound Setup window 4-43 
Starting your system 1 -7 
Stop bits 4-38 
Storage memory 2-2 
System memory 2-2 
System orientation I - I  I 

T 

Text color 4-43 
Time 4-29 - 4-30 
Trash Can Icon 4-26 
True color 4-42 
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U pdating a directory 5- 1 5  
Using a printer icon 4- 1 6  

v 

View menu 4-9 

w 

Set Color and Style 4- 1 1 - 4- 1 2  
Show a s  Icons option 4- 1 0  
Show as Text option 4- 1 0  
S ize to Fit option 4- 1 1 
Sorting options 4- 1 0  

Wi ldcards 5-9 - 5- 1 0  
Window Colors setup 4-42 - 4-44 
Windows 

c lose button 3-8 
closing 3-9, 3- 1 0  
drive identifier 3-8 
fi le mask 3-8 
information l ine 3-8 
moving 3- 1 2  
opening 3-9 
scrol l ing 3- 1 0 - 3- 1 1  
sizing 3- 1 I 

top window 3- 1 I 

Workspace, preparing 1 -5 
Write-protecting floppy disks 2-9 

Write-protect tab 2-9 
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